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Preface

SPSS 15.0

SPSS 15.0 is a comprehensive system for analyzing data. SPSS can take data from
almost any type of file and use them to generate tabulated reports, charts and plots of
distributions and trends, descriptive statistics, and complex statistical analyses.

This manual, the SPSS Base 15.0 Users Guide, documents the graphical user
interface of SPSS for Windows. Examples using the statistical procedures found
in SPSS Base 15.0 are provided in the Help system, installed with the software.
Algorithms used in the statistical procedures are provided in PDF form and are
available from the Help menu.

In addition, beneath the menus and dialog boxes, SPSS uses a command language.
Some extended features of the system can be accessed only via command syntax.
(Those features are not available in the Student Version.) Detailed command syntax
reference information is available in two forms: integrated into the overall Help
system and as a separate document in PDF form in the SPSS 15.0 Command Syntax
Reference, also available from the Help menu.

SPSS Options

The following options are available as add-on enhancements to the full (not Student
Version) SPSS Base system:

SPSS Regression Models™ provides techniques for analyzing data that do not fit
traditional linear statistical models. It includes procedures for probit analysis,
logistic regression, weight estimation, two-stage least-squares regression, and general
nonlinear regression.

SPSS Advanced Models™ focuses on techniques often used in sophisticated
experimental and biomedical research. It includes procedures for general linear
models (GLM), linear mixed models, generalized linear models (GZLM), generalized



estimating equations (GEE), variance components analysis, loglinear analysis, actuarial
life tables, Kaplan-Meier survival analysis, and basic and extended Cox regression.

SPSS Tables™ creates a variety of presentation-quality tabular reports, including
complex stub-and-banner tables and displays of multiple-response data.

SPSS Trends™ performs comprehensive forecasting and time series analyses with
multiple curve-fitting models, smoothing models, and methods for estimating
autoregressive functions.

SPSS Categories® performs optimal scaling procedures, including correspondence
analysis.

SPSS Conjoint™ provides a realistic way to measure how individual product attributes
affect consumer and citizen preferences. With SPSS Conjoint, you can easily measure
the trade-off effect of each product attribute in the context of a set of product
attributes—as consumers do when making purchasing decisions.

SPSS Exact Tests™ calculates exact p values for statistical tests when small or very
unevenly distributed samples could make the usual tests inaccurate.

SPSS Missing Value Analysis™ describes patterns of missing data, estimates means and
other statistics, and imputes values for missing observations.

SPSS Maps™ turns your geographically distributed data into high-quality maps with
symbols, colors, bar charts, pie charts, and combinations of themes to present not only
what is happening but where it is happening.

SPSS Complex Samples™ allows survey, market, health, and public opinion researchers,
as well as social scientists who use sample survey methodology, to incorporate their
complex sample designs into data analysis.

SPSS Classification Trees™ creates a tree-based classification model. It classifies
cases into groups or predicts values of a dependent (target) variable based on values
of independent (predictor) variables. The procedure provides validation tools for
exploratory and confirmatory classification analysis.

SPSS Data Preparation™ provides a quick visual snapshot of your data. It provides
the ability to apply validation rules that identify invalid data values. You can create
rules that flag out-of-range values, missing values, or blank values. You can also save
variables that record individual rule violations and the total number of rule violations
per case. A limited set of predefined rules that you can copy or modify is provided.
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Amos™ (analysis of moment structures) uses structural equation modeling to confirm
and explain conceptual models that involve attitudes, perceptions, and other factors
that drive behavior.

The SPSS family of products also includes applications for data entry, text analysis,
classification, neural networks, and predictive enterprise services.

Installation

To install the SPSS Base system, run the License Authorization Wizard using the
authorization code that you received from SPSS Inc. For more information, see the
installation instructions supplied with the SPSS Base system.

Compatibility

SPSS is designed to run on many computer systems. See the installation instructions
that came with your system for specific information on minimum and recommended
requirements.

Serial Numbers

Your serial number is your identification number with SPSS Inc. You will need this
serial number when you contact SPSS Inc. for information regarding support, payment,
or an upgraded system. The serial number was provided with your Base system.

Customer Service

If you have any questions concerning your shipment or account, contact your local
office, listed on the SPSS Web site at http.://www.spss.com/worldwide. Please have
your serial number ready for identification.

Training Seminars

SPSS Inc. provides both public and onsite training seminars. All seminars feature
hands-on workshops. Seminars will be offered in major cities on a regular basis. For
more information on these seminars, contact your local office, listed on the SPSS Web
site at http://www.spss.com/worldwide.
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Technical Support

The services of SPSS Technical Support are available to maintenance customers.
Customers may contact Technical Support for assistance in using SPSS or for
installation help for one of the supported hardware environments. To reach Technical
Support, see the SPSS Web site at Attp.//www.spss.com, or contact your local office,
listed on the SPSS Web site at http://www.spss.com/worldwide. Be prepared to identify
yourself, your organization, and the serial number of your system.

Additional Publications

Additional copies of SPSS product manuals may be purchased directly from SPSS Inc.
Visit the SPSS Web Store at http.//www.spss.com/estore, or contact your local SPSS
office, listed on the SPSS Web site at http://www.spss.com/worldwide. For telephone
orders in the United States and Canada, call SPSS Inc. at 800-543-2185. For telephone
orders outside of North America, contact your local office, listed on the SPSS Web site.
The SPSS Statistical Procedures Companion, by Marija Norusis, has been published
by Prentice Hall. A new version of this book, updated for SPSS 15.0, is planned.
The SPSS Advanced Statistical Procedures Companion, also based on SPSS 15.0, is
forthcoming. The SPSS Guide to Data Analysis for SPSS 15.0 is also in development.
Announcements of publications available exclusively through Prentice Hall will be
available on the SPSS Web site at http.//www.spss.com/estore (select your home
country, and then click Books).

Tell Us Your Thoughts

Your comments are important. Please let us know about your experiences with SPSS
products. We especially like to hear about new and interesting applications using the
SPSS Base system. Please send e-mail to suggest@spss.com or write to SPSS Inc.,
Attn.: Director of Product Planning, 233 South Wacker Drive, 11th Floor, Chicago, IL
60606-6412.

About This Manual

This manual documents the graphical user interface for the procedures included in the
SPSS Base system. Illustrations of dialog boxes are taken from SPSS for Windows.
Dialog boxes in other operating systems are similar. Detailed information about the
command syntax for features in the SPSS Base system is available in two forms:
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integrated into the overall Help system and as a separate document in PDF form in the
SPSS 15.0 Command Syntax Reference, available from the Help menu.

Contacting SPSS

If you would like to be on our mailing list, contact one of our offices, listed on our Web
site at http://www.spss.com/worldwide.
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Chapter

Overview

SPSS for Windows provides a powerful statistical-analysis and data-management
system in a graphical environment, using descriptive menus and simple dialog boxes
to do most of the work for you. Most tasks can be accomplished simply by pointing
and clicking the mouse.

In addition to the simple point-and-click interface for statistical analysis, SPSS for
Windows provides:

Data Editor. The Data Editor is a versatile spreadsheet-like system for defining,
entering, editing, and displaying data.

Viewer. The Viewer makes it easy to browse your results, selectively show and hide
output, change the display order results, and move presentation-quality tables and
charts between SPSS and other applications.

Multidimensional pivot tables. Your results come alive with multidimensional pivot
tables. Explore your tables by rearranging rows, columns, and layers. Uncover
important findings that can get lost in standard reports. Compare groups easily by
splitting your table so that only one group is displayed at a time.

High-resolution graphics. High-resolution, full-color pie charts, bar charts, histograms,
scatterplots, 3-D graphics, and more are included as standard features in SPSS.

Database access. Retrieve information from databases by using the Database Wizard
instead of complicated SQL queries.

Data transformations. Transformation features help get your data ready for analysis.
You can easily subset data; combine categories; add, aggregate, merge, split, and
transpose files; and more.

Electronic distribution. Send e-mail reports to other people with the click of a button, or
export tables and charts in HTML format for Internet and intranet distribution.
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Online Help. Detailed tutorials provide a comprehensive overview; context-sensitive
Help topics in dialog boxes guide you through specific tasks; pop-up definitions in
pivot table results explain statistical terms; the Statistics Coach helps you find the
procedures that you need; Case Studies provide hands-on examples of how to use
statistical procedures and interpret the results.

Command language. Although most tasks can be accomplished with simple
point-and-click gestures, SPSS also provides a powerful command language that
allows you to save and automate many common tasks. The command language also
provides some functionality that is not found in the menus and dialog boxes.

Complete command syntax documentation is integrated into the overall Help system
and is available as a separate PDF document, SPSS Command Syntax Reference, which
is also available from the Help menu.

What's New in SPSS 15.0?

Data Management

Custom variable attributes. In addition to the standard variable attributes (for example,
value labels, missing values, measurement level), you can create your own custom
variable attributes. You can display and edit these attributes directly in Variable View
of the Data Editor. Like standard variable attributes, these custom attributes are saved
with SPSS-format data files. For more information, see Custom Variable Attributes
in Chapter 5 on p. 115.

Variable sets. You can now use variable sets to control which variables are displayed in
the Data Editor as well as in dialog box variable lists. (In previous releases, variable
sets affected only dialog box variable lists.) Variable sets make it easier to work with
data files that contain a large number of variables. For more information, see Define
Variable Sets in Chapter 44 on p. 615.

Export to Database Wizard. Create new database tables, replace values for selected
fields, and add new fields to an existing table, all without having to write a single
line of SQL code yourself. For more information, see Exporting to a Database in
Chapter 3 on p. 68.

Export to Dimensions. Export to Dimensions creates an SPSS data file and a Dimensions
metadata file that you can use to read the data into Dimensions applications, such

as mrinterview and mrTables. This is particularly useful when “roundtripping”

data between SPSS and Dimensions applications. For example, you can read an
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mrinterview data source into SPSS, calculate some new variables, and then save the
data in a form that can be read by mrTables without loss of any of the original metadata
attributes. For more information, see Exporting to Dimensions in Chapter 3 on p. 84.

Save data in CSV format. Save data in CSV (comma-separated values) format. CSV is
a common data format recognized by many applications. For more information, see
Saving Data Files in External Formats in Chapter 3 on p. 59.

Reporting

Export results in PDF format. Export output in PDF format, including Viewer outline
headings as bookmarks in the PDF file. For more information, see Export Output in
Chapter 10 on p. 275.

Control chart enhancements. You can now define rules for control charts to help you
quickly identify points that are out of control.

More chart types in Chart Builder. The Chart Builder has been expanded to include
histograms, boxplots, scatterplot matrices, overlay scatterplots, population pyramids,
error bar charts, high-low-close charts, difference area charts, range bar charts, dot
plots, charts of separate variables, and paneled charts. You can also create charts that
were not previously available in SPSS, such as charts with dual, independent y axes.

Chart Editor enhancements. The Chart Editor now offers more control over your charts.
Major features include an updated Variables tab for changing chart types easily,
automatic control of white space, additional distribution curves for histograms, a tool
for quickly rescaling axes, and the ability to use custom equations to create reference
lines.

Programmatic control of output documents. You can now create, open, activate, save,
and close Viewer and Draft Viewer documents with command syntax using OUTPUT
NEW, OUTPUT NAME, OUTPUT ACTIVATE, OUTPUT OPEN, OUTPUT SAVE, and
OUTPUT CLOSE.

Statistical Enhancements

Ordinal Regression. This procedure, previously available as part of the Advanced
Models add-on option, is now available in the SPSS Base system. For more
information, see Ordinal Regression in Chapter 28 on p. 461.
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PMML model files with transformations. You can now include transformations in PMML
model files and merge information from model files using the TMS BEGIN-TMS END
and TMS MERGE commands.

Generalized Linear Models. The Generalized Linear Models procedure expands the
general linear model so that the dependent variable is linearly related to the factors
and covariates via a specified link function. Moreover, the model allows for the
dependent variable to have a non-normal distribution. This procedure is available in
the Advanced Models option.

Generalized Estimating Equations. The Generalized Estimating Equations procedure
extends the generalized linear model to allow for analysis of repeated measurements.
This procedure is available in the Advanced Models option.

Complex Samples Ordinal Regression. The Complex Samples Ordinal Regression
procedure performs regression analysis on a binary or ordinal dependent variable for
samples drawn by complex sampling methods. Optionally, you can request analyses
for a subpopulation. This procedure is available in the Complex Samples option.

Optimal Binning. The Optimal Binning procedure discretizes one or more scale
variables by distributing the values of each variable into bins. Bin formation is optimal
with respect to a categorical guide variable that “supervises” the binning process. Bins
can then be used instead of the original data values for further analysis. This procedure
is available in the Data Preparation option.

Programmability Extension

The Programmability Extension now allows you to write to the active dataset and
create custom pivot tables and custom procedures. For more information go to
http://www.spss.com/devcentral

Windows

There are a number of different types of windows in SPSS:

Data Editor. The Data Editor displays the contents of the data file. You can create new
data files or modify existing data files with the Data Editor. If you have more than one
data file open, there is a separate Data Editor window for each data file.
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Viewer. All statistical results, tables, and charts are displayed in the Viewer. You can
edit the output and save it for later use. A Viewer window opens automatically the first
time you run a procedure that generates output.

Draft Viewer. In the Draft Viewer, you can display output as simple text (instead of
interactive pivot tables).

Pivot Table Editor. Output that is displayed in pivot tables can be modified in many
ways with the Pivot Table Editor. You can edit text, swap data in rows and columns,
add color, create multidimensional tables, and selectively hide and show results.

Chart Editor. You can modify high-resolution charts and plots in chart windows. You
can change the colors, select different type fonts or sizes, switch the horizontal and
vertical axes, rotate 3-D scatterplots, and even change the chart type.

Text Output Editor. Text output that is not displayed in pivot tables can be modified
with the Text Output Editor. You can edit the output and change font characteristics
(type, style, color, size).

Syntax Editor. You can paste your dialog box choices into a syntax window, where your
selections appear in the form of command syntax. You can then edit the command
syntax to use special features of SPSS that are not available through dialog boxes. You
can save these commands in a file for use in subsequent SPSS sessions.

Script Editor. Scripting and OLE automation allow you to customize and automate
many tasks in SPSS. Use the Script Editor to create and modify basic scripts.



6

Chapter 1

Figure 1-1
Data Editor and Viewer
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£ ¥ ¥

Designated Window versus Active Window

If you have more than one open Viewer window, output is routed to the designated
Viewer window. If you have more than one open Syntax Editor window, command
syntax is pasted into the designated Syntax Editor window. The designated windows
are indicated by a plus sign in the icon in the title bar. You can change the designated

windows at any time.

The designated window should not be confused with the active window, which is
the currently selected window. If you have overlapping windows, the active window
appears in the foreground. If you open a window, that window automatically becomes

the active window and the designated window.
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Changing the Designated Window

» Make the window that you want to designate the active window (click anywhere in
the window).

» Click the Designate Window button on the toolbar (the plus sign icon).

or

» From the menus choose:
Utilities
Designate Window

Note: For Data Editor windows, the active Data Editor window determines the dataset
that is used in subsequent calculations or analyses. There is no “designated” Data
Editor window. For more information, see Basic Handling of Multiple Data Sources
in Chapter 6 on p. 130.

Menus

Many of the tasks that you want to perform with SPSS are available through menu
selections. Each window in SPSS has its own menu bar with menu selections that are
appropriate for that window type.

The Analyze and Graphs menus are available in all windows, making it easy to
generate new output without having to switch windows.

Status Bar

The status bar at the bottom of each SPSS window provides the following information:

Command status. For each procedure or command that you run, a case counter indicates
the number of cases processed so far. For statistical procedures that require iterative
processing, the number of iterations is displayed.

Filter status. If you have selected a random sample or a subset of cases for analysis, the
message Filter on indicates that some type of case filtering is currently in effect and
not all cases in the data file are included in the analysis.

Weight status. The message Weight on indicates that a weight variable is being used to
weight cases for analysis.
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Split File status. The message Split File on indicates that the data file has been split into
separate groups for analysis, based on the values of one or more grouping variables.

Showing and Hiding the Status Bar

» From the menus choose:
View
Status Bar

Dialog Boxes

Most menu selections open dialog boxes. You use dialog boxes to select variables
and options for analysis.

Dialog boxes for statistical procedures and charts typically have two basic components:

Source variable list. A list of variables in the active dataset. Only variable types that
are allowed by the selected procedure are displayed in the source list. Use of short
string and long string variables is restricted in many procedures.

Target variable list(s). One or more lists indicating the variables that you have chosen
for the analysis, such as dependent and independent variable lists.

Variable Names and Variable Labels in Dialog Box Lists

You can display either variable names or variable labels in dialog box lists.

®  To control the display of variable names or labels, choose Options from the Edit
menu in any window.

®  To define or modify variable labels, use Variable View in the Data Editor.

m  For data that are imported from database sources, field names are used as variable
labels.

m  For long labels, position the mouse pointer over the label in the list to view the
entire label.

m [f no variable label is defined, the variable name is displayed.
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Figure 1-2
Variable labels displayed in a dialog box
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Dialog Box Controls

There are five standard controls in most dialog boxes:

OK. Runs the procedure. After you select your variables and choose any additional
specifications, click OK to run the procedure and close the dialog box.

Paste. Generates command syntax from the dialog box selections and pastes the syntax
into a syntax window. You can then customize the commands with additional features
that are not available from dialog boxes.

Reset. Deselects any variables in the selected variable list(s) and resets all specifications
in the dialog box and any subdialog boxes to the default state.

Cancel. Cancels any changes that were made in the dialog box settings since the last
time it was opened and closes the dialog box. Within a session, dialog box settings are
persistent. A dialog box retains your last set of specifications until you override them.

Help. Provides context-sensitive Help. This control takes you to a Help window that
contains information about the current dialog box. You can also get help on individual
dialog box controls by right-clicking the control.
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Subdialog Boxes

Because most procedures provide a great deal of flexibility, not all of the possible
choices can be contained in a single dialog box. The main dialog box usually contains
the minimum information that is required to run a procedure. Additional specifications
are made in subdialog boxes.

In the main dialog box, controls with an ellipsis (...) after the name indicate that a
subdialog box will be displayed.

Selecting Variables

To select a single variable, simply highlight it on the source variable list and click the
right arrow button next to the target variable list. If there is only one target variable
list, you can double-click individual variables to move them from the source list to
the target list.

You can also select multiple variables:

m  To select multiple variables that are grouped together on the variable list, click the
first variable and then Shift-click the last variable in the group.

m  To select multiple variables that are not grouped together on the variable list, click
the first variable, then Ctrl-click the next variable, and so on.

Variable List Icons

The icons that are displayed next to variables in dialog box lists provide information
about the variable type and measurement level.

Measurement Data Type
Level

Numeric String Date

n/a

e
N
® |& &

Scale

Nominal
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Getting Information about Variables in Dialog Boxes

» Right-click a variable in the source or target variable list.

» Choose Variable Information.

Figure 1-3
Variable information
O
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Basic Steps in Data Analysis

Analyzing data with SPSS is easy. All you have to do is:

Get your data into SPSS. You can open a previously saved SPSS data file, you can
read a spreadsheet, database, or text data file, or you can enter your data directly in
the Data Editor.

Select a procedure. Select a procedure from the menus to calculate statistics or to
create a chart.

Select the variables for the analysis. The variables in the data file are displayed in
a dialog box for the procedure.

Run the procedure and look at the results. Results are displayed in the Viewer.
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Statistics Coach

If you are unfamiliar with SPSS or with the statistical procedures that are available
in SPSS, the Statistics Coach can help you get started by prompting you with simple
questions, nontechnical language, and visual examples that help you select the basic
statistical and charting features that are best suited for your data.

To use the Statistics Coach, from the menus in any SPSS window choose:

Help
Statistics Coach

The Statistics Coach covers only a selected subset of procedures in the SPSS Base

system. It is designed to provide general assistance for many of the basic, commonly
used statistical techniques.

Finding Out More about SPSS

For a comprehensive overview of SPSS basics, see the online tutorial. From any
SPSS menu choose:

Help
Tutorial
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Help is provided in many different forms:

Help menu. The Help menu in most SPSS windows provides access to the main Help
system, plus tutorials and technical reference material.

Topics. Provides access to the Contents, Index, and Search tabs, which you can
use to find specific Help topics.

Tutorial. Illustrated, step-by-step instructions on how to use many of the basic
features in SPSS. You don’t have to view the whole tutorial from start to finish.
You can choose the topics you want to view, skip around and view topics in any
order, and use the index or table of contents to find specific topics.

Case Studies. Hands-on examples of how to create various types of statistical
analyses and how to interpret the results. The sample data files used in the
examples are also provided so that you can work through the examples to see
exactly how the results were produced. You can choose the specific procedure(s)
that you want to learn about from the table of contents or search for relevant topics
in the index.

Statistics Coach. A wizard-like approach to guide you through the process of
finding the procedure that you want to use. After you make a series of selections,
the Statistics Coach opens the dialog box for the statistical, reporting, or charting
procedure that meets your selected criteria. The Statistics Coach provides access
to most statistical and reporting procedures in the Base system and many charting
procedures.

13
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Command Syntax Reference. Detailed command syntax reference information is
available in two forms: integrated into the overall Help system and as a separate
document in PDF form in the SPSS Command Syntax Reference, available from
the Help menu.

Statistical Algorithms. The algorithms used for most statistical procedures are
available in two forms: integrated into the overall Help system and as a separate
document in PDF form in SPSS Algorithms, available on the manuals CD. For
links to specific algorithms in the Help system, select Algorithms on the Help menu.

Context-sensitive Help. In many places in the user interface, you can get
context-sensitive Help.

Dialog box Help buttons. Most dialog boxes have a Help button that takes you
directly to a Help topic for that dialog box. The Help topic provides general
information and links to related topics.

Dialog box context menu Help. Many dialog boxes provide context-sensitive Help
for individual controls and features. Right-click on any control in a dialog box and
select What's This? from the context menu to display a description of the control
and directions for its use. (If What's This? does not appear on the context menu,
then this form of Help is not available for that dialog box.)

Pivot table context menu Help. Right-click on terms in an activated pivot table in
the Viewer and select What's This? from the context menu to display definitions
of the terms.

Case Studies. Right-click on a pivot table and select Case Studies from the context
menu to go directly to a detailed example for the procedure that produced that
table. (If Case Studies does not appear on the context menu, then this form of
Help is not available for that procedure.)

Command syntax. In a command syntax window, position the cursor anywhere
within a syntax block for a command and press F1 on the keyboard. A complete
command syntax chart for that command will be displayed. Complete command
syntax documentation is available from the links in the list of related topics and
from the Help Contents tab.

Scripting and OLE automation. In a script window (File menu, New or Open, Script),
the Help menu provides access to information on the scripting language and SPSS
OLE automation objects, methods, and properties. Context-sensitive Help in a
script window is available with F1 or F2 (object browser).
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Microsoft Internet Explorer Settings

Most Help features in this application use technology based on Microsoft Internet
Explorer. Some versions of Internet Explorer (including the version provided with
Microsoft Windows XP, Service Pack 2) will by default block what it considers to be
“active content” in Internet Explorer windows on your local computer. This default
setting may result in some blocked content in Help features. To see all Help content,
you can change the default behavior of Internet Explorer.

From the Internet Explorer menus choose:

Tools
Internet Options...

Click the Advanced tab.
Scroll down to the Security section.

Select (check) Allow active content to run in files on My Computer.

Other Resources

If you can’t find the information you want in the Help system, these other resources
may have the answers you need:

m  SPSS for Windows Developer’s Guide. Provides information and examples for the
developer’s tools included with SPSS for Windows, including OLE automation,
third-party API, input/output DLL, Production Facility, and Scripting Facility.
The Developer’s Guide is available in PDF form in the SPSS\developer directory
on the installation CD.

m  Technical Support Web site. Answers to many common problems can be found at
http://support.spss.com. (The Technical Support Web site requires a login ID
and password. Information on how to obtain an ID and password is provided at
the URL listed above.)

Using the Help Table of Contents

>

>

In any window, from the menus choose:

Help
Topics

Click the Contents tab.
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» Double-click items with a book icon to expand or collapse the contents.

» Click an item to go to that Help topic.

Figure 2-1
Help window with Contents tab displayed
[% Base System B[] |
& ) sipg
Hide  Back Stop  Refiesh Options
-
Content L 3 . ]
Lontents | Index | SearcH # 1 * | Frequen(:|es
&3 Overview -~
5 @ Getting Help The Frequencies procedure provides statistics and
7 @ DataFiles graphical displays that are useful for describing
# @ Distibuted Analysi many types of variables, For a first look at your
7 @ Data Editcr data, the Frequencies procedure is a good place
£3 Q D ata Preparation to start.,
= @ Data Transfomati
% @ File Handing and For a frequency repart and bar chart, you can
@ Working with Dute arrange the distinct wvalues in ascending or
# @ D_'aftv'ewaf descending order or order the categories by their
= @ Pivot Tables frequencies. The frequencies report can be
+ Q!}Morkmg it Com suppressed when a variable has many distinct
= i values. You can label charts with frequencies (the
default) or percentages.
IE Frequencies ! F E
7
ra F[equenc'e.s:v Example. What is the distribution of a company's
1= 4 customers by industry type? From the output, v

Using the Help Index

» In any window, from the menus choose:

Help
Topics

» Click the Index tab.
» Enter a term to search for in the index.

» Double-click the topic that you want.

The Help index uses incremental search to find the text that you enter and selects
the closest match in the index.
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Figure 2-2
Index tab and incremental search
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Getting Help

Help is provided in many different forms:

Help menu. The Help menu in most SPS5
windows provides access to the main Help
system, plus tutorials and technical
reference material.

Topics. Provides access to the
Contents, Index, and Search tabs,
which you can use to find specific Help
topics.

Tutorial. Illustrated, step-by-step

instructions on how to use many of the
basic features in SPSS. You don't have
to view the whaole tutorial from start to
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Using Help Search

Getting Help

The Search tab provides full-text search that includes topic titles, topic text, and
index text. Topics are ranked based on how many times the search term(s) appear in
the topic and/or its index.
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Figure 2-3
Help Search tab
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m  Full-text search is most effective if you can refine your search criteria to limit the
number of topics in the list. For example, if you know you want to find a function
for truncating numeric values, “truncate function” will produce a better list of
potential topics than simply “truncate.”

m  Topics with a command name in parentheses indicate that the Help topic is for
command syntax. Topics without a command name in parentheses are generally
Help topics for the dialog boxes and other graphical user interface topics.

Getting Help on Dialog Box Controls
» Right-click on the dialog box control that you want information about.

» Choose What's This? from the pop-up context menu.

A description of the control and how to use it is displayed in a pop-up window. General
information about a dialog box is available from the Help button in the dialog box.
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Figure 2-4
Dialog box control Help with right mouse button
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Getting Help on Output Terms
» Double-click the pivot table to activate it.
» Right-click on the term that you want explained.

» Choose What's This? from the context menu.

A definition of the term is displayed in a pop-up window.
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Figure 2-5
Activated pivot table glossary Help with right mouse button
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Using Case Studies

» Right-click on a pivot table in the Viewer window.

» Choose Case Studies from the pop-up context menu.

Copying Help Text from a Pop-Up Window

» Right-click anywhere in the pop-up window.

» Choose Copy from the context menu.

The entire text of the pop-up window is copied.
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Data files come in a wide variety of formats, and this software is designed to handle
many of them, including:

B Spreadsheets created with Excel and Lotus

m Database tables from many database sources, including Oracle, SQLServer,
Access, dBASE, and others

Tab-delimited and other types of simple text files

Data files in SPSS format created on other operating systems
SYSTAT data files

SAS data files

Stata data files

Opening Data Files

In addition to files saved in SPSS format, you can open Excel, SAS, Stata, tab-delimited
and other files without converting the files to an intermediate format or entering data
definition information.

Opening a data file makes it the active dataset. If you already have one or more open
data files, they remain open and available for subsequent use in the session. Clicking
anywhere in the Data Editor window for an open data file will make it the active dataset.

In distributed analysis, mode using a remote server to process commands and run
procedures, the available data files, folders, and drives are dependent on what is
available on or from the remote server. The current server name is indicated at the
top of the dialog box. You will not have access to data files on your local computer
unless you specify the drive as a shared device and the folders containing your data
files as shared folders. For more information, see Distributed Analysis Mode in
Chapter 4 on p. 91.

21
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To Open Data Files

» From the menus choose:
File
Open
Data...

» In the Open Data dialog box, select the file that you want to open.

» Click Open.

Optionally, you can:
B Read variable names from the first row for spreadsheet files.
m  Specify a range of cells to read for spreadsheet files.

m  Specify a sheet within an Excel file to read (Excel 5 or later).

For information on reading data from databases, see Reading Database Files on p. 25.
For information on reading data from text data files, see Text Wizard on p. 43.

Data File Types
SPSS. Opens data files saved in SPSS format, including SPSS for Windows, Macintosh,
UNIX, and also the DOS product SPSS/PC+.
SPSS/PC+. Opens SPSS/PC+ data files.
SYSTAT. Opens SYSTAT data files.

SPSS Portable. Opens data files saved in SPSS portable format. Saving a file in
portable format takes considerably longer than saving the file in SPSS format.

Excel. Opens Excel files.
Lotus 1-2-3. Opens data files saved in 1-2-3 format for release 3.0, 2.0, or 1A of Lotus.

SYLK. Opens data files saved in SYLK (symbolic link) format, a format used by some
spreadsheet applications.

dBASE. Opens dBASE-format files for either dBASE IV, dBASE III or III PLUS,
or dBASE II. Each case is a record. Variable and value labels and missing-value
specifications are lost when you save a file in this format.

SAS Long File Name. SAS versions 7-9 for Windows, long extension.
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SAS Short File Name. SAS versions 7-9 for Windows, short extension.
SAS v6 for Windows. SAS version 6.08 for Windows and OS2.

SAS v6 for UNIX. SAS version 6 for UNIX (Sun, HP, IBM).

SAS Transport. SAS transport file.

Stata. Stata versions 4-8.

Text. ASCII text file.

Opening File Options

Read variable names. For spreadsheets, you can read variable names from the first row
of the file or the first row of the defined range. The values are converted as necessary
to create valid variable names, including converting spaces to underscores.

Worksheet. Excel 5 or later files can contain multiple worksheets. By default, the Data
Editor reads the first worksheet. To read a different worksheet, select the worksheet
from the drop-down list.

Range. For spreadsheet data files, you can also read a range of cells. Use the same
method for specifying cell ranges as you would with the spreadsheet application.

Reading Excel 5 or Later Files

The following rules apply to reading Excel 5 or later files:

Data type and width. Each column is a variable. The data type and width for each
variable are determined by the data type and width in the Excel file. If the column
contains more than one data type (for example, date and numeric), the data type is set
to string, and all values are read as valid string values.

Blank cells. For numeric variables, blank cells are converted to the system-missing
value, indicated by a period. For string variables, a blank is a valid string value, and
blank cells are treated as valid string values.

Variable names. If you read the first row of the Excel file (or the first row of the
specified range) as variable names, values that don’t conform to variable naming rules
are converted to valid variable names, and the original names are used as variable
labels. If you do not read variable names from the Excel file, default variable names
are assigned.
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Reading Older Excel Files and Other Spreadsheets

The following rules apply to reading Excel files prior to version 5 and other spreadsheet
data:

Data type and width. The data type and width for each variable are determined by the
column width and data type of the first data cell in the column. Values of other types
are converted to the system-missing value. If the first data cell in the column is blank,
the global default data type for the spreadsheet (usually numeric) is used.

Blank cells. For numeric variables, blank cells are converted to the system-missing
value, indicated by a period. For string variables, a blank is a valid string value, and
blank cells are treated as valid string values.

Variable names. If you do not read variable names from the spreadsheet, the column
letters (4, B, C, ...) are used for variable names for Excel and Lotus files. For SYLK
files and Excel files saved in R1C1 display format, the software uses the column
number preceded by the letter C for variable names (C/, C2, C3, ...).

Reading dBASE Files

Database files are logically very similar to SPSS-format data files. The following
general rules apply to dBASE files:

® Field names are converted to valid variable names.
m  Colons used in dBASE field names are translated to underscores.

m  Records marked for deletion but not actually purged are included. The software
creates a new string variable, D R, which contains an asterisk for cases marked
for deletion.

Reading Stata Files

The following general rules apply to Stata data files:

m Variable names. Stata variable names are converted to SPSS variable names
in case-sensitive form. Stata variable names that are identical except for case
are converted to valid SPSS variable names by appending an underscore and a
sequential letter ( 4, B, C, .., Z, AA, AB, ..., etc.).

m Variable labels. Stata variable labels are converted to SPSS variable labels.
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m  Value labels. Stata value labels are converted to SPSS value labels, except for Stata
value labels assigned to “extended” missing values.

m  Missing values. Stata “extended” missing values are converted to system-missing
values.

m Date conversion. Stata date format values are converted to SPSS DATE format
(d-m-y) values. Stata “time-series” date format values (weeks, months, quarters,
etc.) are converted to simple numeric (F) format, preserving the original, internal
integer value, which is the number of weeks, months, quarters, etc., since the
start of 1960.

Reading Database Files

You can read data from any database format for which you have a database driver. In
local analysis mode, the necessary drivers must be installed on your local computer. In
distributed analysis mode (available with SPSS Server), the drivers must be installed
on the remote server. For more information, see Distributed Analysis Mode in Chapter
4 onp. 91.

To Read Database Files
» From the menus choose:
File
Open Database
New Query...

» Select the data source.

» Ifnecessary (depending on the data source), select the database file and/or enter a login
name, password, and other information.

» Select the table(s) and fields. (For OLE DB data sources, you can only select one table.)
» Specify any relationships between your tables.

» Optionally:
m  Specify any selection criteria for your data.
®  Add a prompt for user input to create a parameter query.

m  Save your constructed query before running it.
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To Edit Saved Database Queries
» From the menus choose:
File

Open Database
Edit Query...

» Select the query file (*.spq) that you want to edit.

» Follow the instructions for creating a new query.

To Read Database Files with Saved Queries
» From the menus choose:
File

Open Database
Run Query...

» Select the query file (*.spq) that you want to run.
» If necessary (depending on the database file), enter a login name and password.

» If the query has an embedded prompt, enter other information if necessary (for
example, the quarter for which you want to retrieve sales figures).

Selecting a Data Source

Use the first screen of the Database Wizard to select the type of data source to read.

ODBC Data Sources

If you do not have any ODBC data sources configured, or if you want to add a new
data source, click Add ODBC Data Source. In distributed analysis mode (available with
SPSS Server), this button is not available. To add data sources in distributed analysis
mode, see your system administrator.
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An ODBC data source consists of two essential pieces of information: the driver
that will be used to access the data and the location of the database you want to access.
To specify data sources, you must have the appropriate drivers installed. For local
analysis mode, you can install drivers from the CD-ROM for this product:

m  SPSS Data Access Pack. Installs drivers for a variety of database formats. This
feature is available on the AutoPlay menu.

®  Microsoft Data Access Pack. Installs drivers for Microsoft products, including
Microsoft Access. To install the Microsoft Data Access Pack, double-click
Microsoft Data Access Pack in the Microsoft Data Access Pack folder on the
CD-ROM.

Figure 3-1
Database Wizard dialog box

Database Wizard

Welcome to the Database Wizard!

Thig vaizard will belp you get data from a non-SPSS data source.

You cat choose the data source, specify which cazes are retieved. aggregate and sort the data before retriewal,
and specify variable names and properties here. Same features are available only when connected ta SPSS Server.

Select Data Source:

Fram which data source(z) would you like to retrieve data? % dBASE Files
% Excel Filez
o © o T3 M Aecess Database
- =
o 0

3 2

Add Data Source. .

[omer ) [
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OLE DB Data Sources

To access OLE DB data sources, you must have the following items installed on the
computer that is running SPSS:

m . NET framework
B Dimensions Data Model and OLE DB Access

Versions of these components that are compatible with this release of SPSS can be
installed from the SPSS installation CD and are available on the AutoPlay menu.

m  Table joins are not available for OLE DB data sources. You can read only one
table at a time.

B You can add OLE DB data sources only in local analysis mode. To add OLE
DB data sources in distributed analysis mode on a Windows server, consult your
system administrator.

B In distributed analysis mode (available with SPSS Server), OLE DB data sources
are available only on Windows servers, and both .NET and the Dimensions Data
Model and OLE DB Access must be installed on the server.
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Figure 3-2
Database Wizard with access to OLE DB data sources
Database Wizard

Welcome to the Database Wizard!
This wizard will help vou get data fram a non-5PSS data source.

“ou can choose the data source, specify which cazes are retieved, aggregate and sort the data before retrieval,
and zpecify varable names and properties here, Some features are available only when connected to SPSS Server.

From which data source(s) would you like to retrieve data?

OLE DB Drata Sources ODEC Data Sources
Dema Access databasze E{i dB&SE Files
SOL surven data % Eucel Files
Bmais
E{i M5 Access Databasze
Add OLE DE Data Source... Add DDBC Data Source. . ]

I Cancel l [ Help

To add an OLE DB data source:
Click Add OLE DB Data Source.

In the Data Link Properties dialog box, click the Provider tab and select the OLE DB
provider.

Click Next or click the Connection tab.

Select the database by entering the directory location and database name or by clicking
the button to browse to a database. (A user name and password may also be required.)

Click OK after entering all necessary information. (You can make sure the specified
database is available by clicking the Test Connection button.)

Enter a name for the database connection information. (This name will be displayed in
the list of available OLE DB data sources.)
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Figure 3-3
Save OLE DB Connection Information As dialog box
Save OLE DB Connection Information As
Mame SOL survey data : :
» Click OK.

This takes you back to the first screen of the Database Wizard, where you can select
the saved name from the list of OLE DB data sources and continue to the next step
of the wizard.

Deleting OLE DB Data Sources
To delete data source names from the list of OLE DB data sources, delete the UDL
file with the name of the data source in:

[drive] :\Documents and Settings\[user login]\Local Settings\Application
Data\SPSS\UDL

Database Login

If your ODBC database requires a password, the Database Wizard will prompt you
for your password before it can open the data source.

Figure 3-4
Login dialog box

Login E3
—Data Source
M5 Access 7.0 Database
Cancel |
r— Authorization
Login name: I.t'-\dmin Database... |
Pazsword: I*m’1 Help |
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The Select Data dialog box controls which tables and fields are read. Database fields

(columns) are read as variables.

If a table has any field(s) selected, all of its fields will be visible in the following
Database Wizard windows, but only fields that are selected in this dialog box will be
imported as variables. This enables you to create table joins and to specify criteria by

using fields that you are not importing.

Figure 3-5
Database Wizard, selecting data

Database Wizard

Select Data

preszed, drag it over to the 'Retriewve Fields' list.
Tip: Dragaging a table selects all of its fields.

Aeeailable Tables:

Select the figlds you wish to work with. To select an item, click on it in the 'available’ list athd. with the mouse buttan

Betiieve Fields In This Qrder:

= & dems! A ZdemoilD a

87D & demo: AGE
B AGE A 2 dema: MARITAL =
B MARITAL T 2 dema: ADDRESS
2 ADDRESS 2 demo: INCOME
2. INCOME B dema: INCCAT
% INCCAT l%,-:hemo: CAR
% SED’-\T 8 demo: CARCAT
% ED %demo: ED
& EwrLov 2 dema; EMPLOY P |
£ ReTiRe i | & demo: RETIRE |
E EMPCAT 6 R 8 i )

[ Sart field names Shiows Tables [ Wiews [ Svnanyms [] System tables

[ < Back ” Mest >

] [ Finish ] [ Cancel ] [ Help

)

Displaying field names. To list the fields in a table, click the plus sign (+) to the left of a
table name. To hide the fields, click the minus sign (—) to the left of a table name.

To add a field. Double-click any field in the Available Tables list, or drag it to the
Retrieve Fields In This Order list. Fields can be reordered by dragging and dropping

them within the fields list.
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To remove a field. Double-click any field in the Retrieve Fields In This Order list, or
drag it to the Available Tables list.

Sort field names. If this check box is selected, the Database Wizard will display your
available fields in alphabetical order.

By default, the list of available tables displays only standard database tables. You can
control the type of items that are displayed in the list:

m Tables. Standard database tables.

m Views. Views are virtual or dynamic “tables” defined by queries. These can

include joins of multiple tables and/or fields derived from calculations based on
the values of other fields.

®  Synonyms. A synonym is an alias for a table or view, typically defined in a query.

m  System tables. System tables define database properties. In some cases, standard
database tables may be classified as system tables and will only be displayed if

you select this option. Access to real system tables is often restricted to database
administrators.

Note: For OLE DB data sources, you can select fields only from a single table.
Multiple table joins are not supported for OLE DB data sources.

Creating a Relationship between Tables

The Specify Relationships dialog box allows you to define the relationships between
the tables for ODBC data sources. If fields from more than one table are selected,
you must define at least one join.
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Figure 3-6
Database Wizard, specifying relationships
Database Wizard
Specify Relationships
It order bo retrieve data from multiple tables, relationships between the tables have to be specified. You can relate items
by dragging a field from one table to its coresponding field in another.
Demographiclnformation &
Age DoUELE A SurveyResponses
Lar DOLIBLE Call Walting DOUBLE ~
Car Cakegory DOUBLE CallerD DOLUBLE
Education DOLBLE o COUNTER
Empest DOLIBLE Internet INTEGER
Employ DOLBLE Multline INTEGER
Gender YARCHAR Mews DOLEBLE
I COUNTER Own CD Flayer  DOUBLE
Income DOLIBLE Own Fax DOLBLE
Incame Cateqory DOUBLE O P DOLELE
Marital Status DOLUBLE own PO& DOUBLE
Reside DOLBLE [, O TV DOLUBLE  [a
i, i 101 ey s
< > < »
[
< >
Asto Join Tables
[ < Back, ]| Mext> [ Firizh ] [ Cancel ] [ Help ]

Establishing relationships. To create a relationship, drag a field from any table onto the
field to which you want to join it. The Database Wizard will draw a join line between
the two fields, indicating their relationship. These fields must be of the same data type.

Auto Join Tables. Attempts to automatically join tables based on primary/foreign keys
or matching field names and data type.

Specifying join types. If outer joins are supported by your driver, you can specify inner
joins, left outer joins, or right outer joins. To select the type of join, double-click the
join line between the fields, and the wizard will display the Relationship Properties

dialog box.

Relationship Properties

This dialog box allows you to specify which type of relationship joins your tables.
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Figure 3-7
Relationship Properties dialog box

rRelatiunship Properties

— e Only include rows where the related fields are equal.

=== | Include all records from "SurveyR esponses’ and only those
records from 'Demographicinformation’ where the related
fields are equal.

= | Include all records from ‘Demographiclnformation’ atd only
thoze records from *SurveyR esponzes’ where the related
fields are equal.

[ ok | ’ Cancel ]

Inner joins. An inner join includes only rows where the related fields are equal. In this
example, all rows with matching ID values in the two tables will be included.

Outer joins. In addition to one-to-one matching with inner joins, you can also use
outer joins to merge tables with a one-to-many matching scheme. For example, you
could match a table in which there are only a few records representing data values and
associated descriptive labels with values in a table containing hundreds or thousands of
records representing survey respondents. A left outer join includes all records from the
table on the left and, from the table on the right, includes only those records in which
the related fields are equal. In a right outer join, the join imports all records from the
table on the right and, from the table on the left, imports only those records in which
the related fields are equal.

Limiting Retrieved Cases

The Limit Retrieved Cases dialog box allows you to specify the criteria to select
subsets of cases (rows). Limiting cases generally consists of filling the criteria grid
with criteria. Criteria consist of two expressions and some relation between them. The
expressions return a value of true, false, or missing for each case.

m [f the result is true, the case is selected.

m  [f the result is false or missing, the case is not selected.
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®  Most criteria use one or more of the six relational operators (<, >, <=, >=, = and

<>).

m  Expressions can include field names, constants, arithmetic operators, numeric and
other functions, and logical variables. You can use fields that you do not plan
to import as variables.

Figure 3-8

Database Wizard, limiting retrieved cases

Database Wizard

Limit Retrieved Cases

Limnit the: cases that are retrieved by specifiing selection criteria.
Tip: Fields and Functions can be added to an expression by dragging and dropping into a cell.
See help for how to express date and time values.

Fields: Criteria:

= & glmc' “ Connector Expression 1 Relation Expression 2
D )
8 asE
% MARITAL
8 ADDRESE
8 INCOME [
Functions
éailllq[[s;r:;f:r']: de) el Use Random Sampling
EEET%:EE:S?;EE?J}E:‘D (=) SP55 random sampling

LT R [stre=pr) . (3 &pprosimately (10 2] % of all cases
LENG TH[strexpr] bd] —

() Exactly a0 cases from the fist (1000 | cases
Prompt For Yalue ..

G N

[ < Back, ]| Hext > |[ Firizh ][ Cancel ] [ Help ]

To build your criteria, you need at least two expressions and a relation to connect
the expressions.
» To build an expression, choose one of the following methods:

® In an Expression cell, type field names, constants, arithmetic operators, numeric
and other functions, or logical variables.

®  Double-click the field in the Fields list.
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>

®m  Drag the field from the Fields list to an Expression cell.

m  Choose a field from the drop-down menu in any active Expression cell.

To choose the relational operator (such as = or >), put your cursor in the Relation cell
and either type the operator or choose it from the drop-down menu.

If the SQL contains WHERE clauses with expressions for case selection, dates and
times in expressions need to be specified in a special manner (including the curly
braces shown in the examples):

m  Date literals should be specified using the general form {d 'yyyy-mm-dd'}.
®  Time literals should be specified using the general form {t 'hh:mm:ss'}.

m Date/time literals (timestamps) should be specified using the general form {ts
'vyyy-mm-dd hh:mm:ss'}.

m  The entire date and/or time value must be enclosed in single quotes. Years must
be expressed in four-digit form, and dates and times must contain two digits for
each portion of the value. For example January 1, 2005, 1:05 AM would be
expressed as:

{ts '2005-01-01 01:05:00"'}

Functions. A selection of built-in arithmetic, logical, string, date, and time SQL
functions is provided. You can drag a function from the list into the expression, or you
can enter any valid SQL function. See your database documentation for valid SQL
functions. A list of standard functions is available at:

http://msdn.microsoft.com/library/en-us/odbc/htm/odbcscalar_functions.asp

Use Random Sampling. This option selects a random sample of cases from the data
source. For large data sources, you may want to limit the number of cases to a small,
representative sample, which can significantly reduce the time that it takes to run
procedures. Native random sampling, if available for the data source, is faster than
SPSS random sampling, because SPSS random sampling must still read the entire
data source to extract a random sample.

m  Approximately. Generates a random sample of approximately the specified
percentage of cases. Since this routine makes an independent pseudorandom
decision for each case, the percentage of cases selected can only approximate


http://msdn.microsoft.com/library/en-us/odbc/htm/odbcscalar_functions.asp
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the specified percentage. The more cases there are in the data file, the closer the
percentage of cases selected is to the specified percentage.

m  Exactly. Selects a random sample of the specified number of cases from the
specified total number of cases. If the total number of cases specified exceeds
the total number of cases in the data file, the sample will contain proportionally
fewer cases than the requested number.

Note: If you use random sampling, aggregation (available in distributed mode with
SPSS Server) is not available.

Prompt For Value. You can embed a prompt in your query to create a parameter query.
When users run the query, they will be asked to enter information (based on what is
specified here). You might want to do this if you need to see different views of the
same data. For example, you may want to run the same query to see sales figures for
different fiscal quarters.

» Place your cursor in any Expression cell, and click Prompt For Value to create a prompt.

Creating a Parameter Query

Use the Prompt for Value dialog box to create a dialog box that solicits information
from users each time someone runs your query. This feature is useful if you want to
query the same data source by using different criteria.

Figure 3-9
Prompt for Value dialog box

rPrumpt for Yalue

Frompt String: | Income category [1=low, 2=medium, 3=high]

|nformation about data to be entered
Default value: 1

Sllowe uger to select value from list

1
2
3

Data type: | Murnber hd
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To build a prompt, enter a prompt string and a default value. The prompt string is
displayed each time a user runs your query. The string should specify the kind of
information to enter. If the user is not selecting from a list, the string should give
hints about how the input should be formatted. An example is as follows: Enter a
Quarter (Q1, Q2, Q83, ...).
Allow user to select value from list. If this check box is selected, you can limit the user
to the values that you place here. Ensure that your values are separated by returns.
Data type. Choose the data type here (Number, String, or Date).
The final result looks like this:
Figure 3-10
Userdefined prompt dialog box
Select Yalue for Query
Income categomy [1=low, 2=medium, 3=high] 0K
Aggregating Data

If you are in distributed mode, connected to a remote server (available with SPSS
Server), you can aggregate the data before reading it into SPSS.
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Figure 3-1
Database Wizard, aggregating data
Database Wizard - Distributed Mode

Aggregate Data

“'ou can aggregate your data before retrieving it according to groups defined by break wariables or press Next to
retrieve the orginal cazez. The output variables can be renamed on the next panel.

Break Yariable(s)

% deme: 1D i

8 deme: AGE

& demno: MARITAL »
& demo: ADDRESS
& dema: INCOME - o
% demo: INCCAT < | il (2]
% dema: CAR L

% demo: CARCAT Aggregated Yanables

% derno: ED Summarnes of Yanable(s)

& dema: EMPLOY Hame | Function
2 demo: RETIRE

8 derno; EMPCAT »
& demo: GENDER
2 demo: RESIDE
B .

(T Mot

£ il ) i :‘:"" ’

[ Mumber of cazes
Agaregation iz available only when connected to SPSS Server

< Back | Mext > | Firizh | Catcel | Help |

You can also aggregate data after reading it into SPSS, but preaggregating may save
time for large data sources.

To create aggregated data, select one or more break variables that define how cases
are grouped.

Select one or more aggregated variables.
Select an aggregate function for each aggregate variable.

Optionally, create a variable that contains the number of cases in each break group.

Note: If you use SPSS random sampling, aggregation is not available.
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Defining Variables

Variable names and labels. The complete database field (column) name is used as the
variable label. Unless you modify the variable name, the Database Wizard assigns
variable names to each column from the database in one of two ways:

m  [f the name of the database field forms a valid, unique variable name, the name
is used as the variable name.

m [f the name of the database field does not form a valid, unique variable name, a
new, unique name is automatically generated.

Click any cell to edit the variable name.

Converting strings to numeric values. Select the Recode to Numeric box for a string
variable if you want to automatically convert it to a numeric variable. String values
are converted to consecutive integer values based on alphabetical order of the original
values. The original values are retained as value labels for the new variables.

Width for variable-width string fields. This option controls the width of variable-width
string values. By default, the width is 255 bytes, and only the first 255 bytes (typically
255 characters in single-byte languages) will be read. The width can be up to 32,767
bytes. Although you probably don’t want to truncate string values, you also don’t
want to specify an unnecessarily large value, which will cause SPSS processing to

be inefficient.



41

Figure 3-12
Database Wizard, defining variables

Data Files

rDatahase Wizard

Define Variables

Edit SPS5 variable hames and properties.

Mames will be automatically generated if left blank.

To canwert a string wariable to numeric using the ariginal values as walue labels, check Recode to Murmeric.

Result Yariable Hame ‘ Data Type [EEEE _tn &
Humeric
demo: MARITAL MARITAL Mumeric:
demo: ADDRESS ADDRESS Mumeric:
cemo: INCOME IRCOME Mumeric:
demo: INCCAT INCCAT Mumeric:
demo: CAR CAR Mumeric:
demo: CARCAT CARCAT Mumeric:
demo: ED ED Mumeric:
demo: EMPLOY ERMPLOY Mumeric:
demo: RETIRE RETIRE Mumeric:
demo: EMPCAT EMPCAT Mumeric:
demo: GEMDER GEMDER String -
domn RESINE RFEZIME b wmarie
Width for wariable-width string figlds: 255
< Back, ]| Mext> [ Firizh ] [ Cancel ] [ Help

Sorting Cases

If you are in distributed mode, connected to a remote server (available with SPSS
Server), you can sort the data before reading it into SPSS.
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Figure 3-13
Database Wizard, sorting cases

Database Wizard - Distributed Mode

Sort Cases

“ou can sort the data before it iz read into SPSS or press Mest to get the data without sorting.

% AGE ad Sort before retriewal by

B MaRITAL
Er 4DDRESS

Variable

Direction

By INCOME [

Ascending

B inCCaT
BmraR 2
B caRCAT
EnED

Er EMPLOY
ErRETIRE
EmEMPCAT
Er GEMDER
B RESIDE
B WIRELESS
o

[TRTIE R TL

a B

appear in thiz wariable ligt but will hawve names generated automatically.

< Back | Mext > |

Sorting iz available only when connected to SPSS Server. Any vanables not given names on the previous panel do not

Firizh | Catcel | Help

You can also sort data after reading it into SPSS, but presorting may save time for

large data sources.

Results

The Results dialog box displays the SQL Select statement for your query.

B You can edit the SQL Select statement before you run the query, but if you click
the Back button to make changes in previous steps, the changes to the Select

statement will be lost.

® To save the query for future use, use the Save query to file section.

m  To paste complete GET DATA syntax into a syntax window, select Paste it into the
syntax editor for further modification. Copying and pasting the Select statement from
the Results window will not paste the necessary command syntax.
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Note: The pasted syntax contains a blank space before the closing quote on each line
of SQL that is generated by the wizard. These blanks are not superfluous. When the
command is processed, all lines of the SQL statement are merged together in a very
literal fashion. Without the space, there would be no space between the last character
on one line and first character on the next line.

Figure 3-14
Database Wizard, results panel

'Database Wizard

Results

Your selection has resulted in the fallowing SAL queny:

SELECT ID, AGE, MARITAL, ADDRESS, IMCOME, INCCAT, CAR, CARCAT, ED, EMPLOY, RETIRE,
EMPCAT, GENDER, RESIDE, WIRELESS, MULTLINE, WVOICE, PAGER, INTERMET, CALLID,

CaLlwalT, DwNTY, OwHYCR, OWNCD, OWHPDA, OWNPC, OWwWNFax, NEWS, RESPONSE FROM
demo

Wwihat wauld you like ta do with thiz quen?

(%) Betrizve the data | have selected.

() Paste it inko the syntax editor for further modification

Save guem ko file

Browse

| Firizh | [ Cancel ] [ Help ]

Text Wizard

The Text Wizard can read text data files formatted in a variety of ways:
m  Tab-delimited files

B Space-delimited files

m  Comma-delimited files

m  Fixed-field format files
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For delimited files, you can also specify other characters as delimiters between values,
and you can specify multiple delimiters.

To Read Text Data Files
» From the menus choose:
File
Read Text Data...
» Select the text file in the Open File dialog box.
» Follow the steps in the Text Wizard to define how to read the data file.

Text Wizard: Step 1

Figure 3-15
Text Wizard: Step 1

Text Import Wizard - Step 1 of 6

528 840 1 81 185 i ‘Wwelcome ta the test impart wizard!
G300 2400 G T 40033

Thig wizard will help you read data from pour test file and

o zpecify information about the variables.
> 7
L, PR ) Doez wour ket file match a predefined format ?
1 O ¥es
: (& Ho
3
i
|

*

Tt file; Z:pubs'udatatdelimit. bt

? 1 1ID 1 2ID 1 3ID 1 qID 1 5ID

ID, Jobh_category,Region, Division, Travel, Current_sales, ry
1,2,3,2,2,570000,270000, 3 E
z,1,3,2,2,402000,25300,3 i |
B,1, ,1,2,257400,144000,1 v
4|

Catcel ] [ Help
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The text file is displayed in a preview window. You can apply a predefined format
(previously saved from the Text Wizard) or follow the steps in the Text Wizard to
specify how the data should be read.

Text Wizard: Step 2

Figure 3-16
Text Wizard: Step 2

Text Import Wizard - Step 2 of 4

Hawy are pour variables aranged™
() Delimited - Wariables are delimited by a specific character (i.e.. comma, tabl].

() Fired width - Variables are aligned in fied width columns.

Aire waniable names included at the top of wour file?
@ es
ONa

Teut file: Z:%pubszhdata’delimit bt

u] 10 20 30 40 30

,2,570000, 270000, 3 ~
,2,402000,25300, 3

,2,257400, 144000, 1
,2,2626800, 158400, 1 »

[ <Back |f Mewt> § [ Cancel ] [ Help ]

This step provides information about variables. A variable is similar to a field in a
database. For example, each item in a questionnaire is a variable.

How are your variables arranged? To read your data properly, the Text Wizard needs to
know how to determine where the data value for one variable ends and the data value
for the next variable begins. The arrangement of variables defines the method used to
differentiate one variable from the next.
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m Delimited. Spaces, commas, tabs, or other characters are used to separate variables.
The variables are recorded in the same order for each case but not necessarily

in the same column locations.

m  Fixed width. Each variable is recorded in the same column location on the same
record (line) for each case in the data file. No delimiter is required between
variables. In fact, in many text data files generated by computer programs, data
values may appear to run together without even spaces separating them. The
column location determines which variable is being read.

Are variable names included at the top of your file? If the first row of the data file contains
descriptive labels for each variable, you can use these labels as variable names. Values
that don’t conform to variable naming rules are converted to valid variable names.

Text Wizard: Step 3 (Delimited Files)

Figure 3-17
Text Wizard: Step 3 (for delimited files)

Text Import Wizard - Delimited Step 3 of 6

The first caze of data begine on which line number? 2

¢

How are pour cazes represented?
(%) Each line reprezents a case

() & specific number of variables represents a case: 1

[l

How mary cases do wou want ta import ™

(@) Al of the cases

() Thefirst 1000 cages.
) & random percentage of the cases (approximate): |10 ::: 4
Data preview
u} 10 20 30 40 50
L 1 1 1 1 1 1 1 1 1
570000, 270000, 3
40z000,25300,3
257400, 144000, 1
Z6B2500,155400, 1 |
[ <Back || Mest> | Cancel ] [ Help
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This step provides information about cases. A case is similar to a record in a database.
For example, each respondent to a questionnaire is a case.

The first case of data begins on which line number? Indicates the first line of the data file
that contains data values. If the top line(s) of the data file contain descriptive labels or
other text that does not represent data values, this will not be line 1.

How are your cases represented? Controls how the Text Wizard determines where
each case ends and the next one begins.

m  Each line represents a case. Each line contains only one case. It is fairly common
for each case to be contained on a single line (row), even though this can be a very
long line for data files with a large number of variables. If not all lines contain the
same number of data values, the number of variables for each case is determined
by the line with the greatest number of data values. Cases with fewer data values
are assigned missing values for the additional variables.

m A specific number of variables represents a case. The specified number of variables
for each case tells the Text Wizard where to stop reading one case and start reading
the next. Multiple cases can be contained on the same line, and cases can start
in the middle of one line and be continued on the next line. The Text Wizard
determines the end of each case based on the number of values read, regardless
of the number of lines. Each case must contain data values (or missing values
indicated by delimiters) for all variables, or the data file will be read incorrectly.

How many cases do you want to import? You can import all cases in the data file, the
first n cases (n is a number you specify), or a random sample of a specified percentage.
Since the random sampling routine makes an independent pseudo-random decision
for each case, the percentage of cases selected can only approximate the specified
percentage. The more cases there are in the data file, the closer the percentage of cases
selected is to the specified percentage.
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Text Wizard: Step 3 (Fixed-Width Files)

Figure 3-18
Text Wizard: Step 3 (for fixed-width files)
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[ <Back |f Mewt> § [ Cancel ] [ Help ]

This step provides information about cases. A case is similar to a record in a database.
For example, each respondent to questionnaire is a case.

The first case of data begins on which line number? Indicates the first line of the data file
that contains data values. If the top line(s) of the data file contain descriptive labels or
other text that does not represent data values, this will not be line 1.

How many lines represent a case? Controls how the Text Wizard determines where
each case ends and the next one begins. Each variable is defined by its line number
within the case and its column location. You need to specify the number of lines
for each case to read the data correctly.

How many cases do you want to import? You can import all cases in the data file, the
first n cases (n is a number you specify), or a random sample of a specified percentage.
Since the random sampling routine makes an independent pseudo-random decision
for each case, the percentage of cases selected can only approximate the specified
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percentage. The more cases there are in the data file, the closer the percentage of cases
selected is to the specified percentage.

Text Wizard: Step 4 (Delimited Files)

Figure 3-19
Text Wizard: Step 4 (for delimited files)

Text Import Wizard - Delimited Step 4 of 6
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v (=] all |
1 2 3 2 2 70000 Zrooo
2 1 3 2 2 402000 25300
3 1 1 2 25740,
P 4 = A A Acmenn Accan
[ cBack || Mest> | [ Cancel ] [ Help ]

This step displays the Text Wizard’s best guess on how to read the data file and allows
you to modify how the Text Wizard will read variables from the data file.

Which delimiters appear between variables? Indicates the characters or symbols that
separate data values. You can select any combination of spaces, commas, semicolons,
tabs, or other characters. Multiple, consecutive delimiters without intervening data
values are treated as missing values.

What is the text qualifier? Characters used to enclose values that contain delimiter
characters. For example, if a comma is the delimiter, values that contain commas will
be read incorrectly unless there is a text qualifier enclosing the value, preventing the
commas in the value from being interpreted as delimiters between values. CSV-format
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data files exported from Excel use a double quotation mark () as a text qualifier.
The text qualifier appears at both the beginning and the end of the value, enclosing
the entire value.

Text Wizard: Step 4 (Fixed-Width Files)

Figure 3-20
Text Wizard: Step 4 (for fixed-width files)
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This step displays the Text Wizard’s best guess on how to read the data file and allows
you to modify how the Text Wizard will read variables from the data file. Vertical lines
in the preview window indicate where the Text Wizard currently thinks each variable
begins in the file.

Insert, move, and delete variable break lines as necessary to separate variables. If
multiple lines are used for each case, select each line from the drop-down list and
modify the variable break lines as necessary.
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Notes:

For computer-generated data files that produce a continuous stream of data values with
no intervening spaces or other distinguishing characteristics, it may be difficult to
determine where each variable begins. Such data files usually rely on a data definition
file or some other written description that specifies the line and column location for
each variable.

The Text Wizard is designed for use with a monospaced (fixed-pitch) font to display
the file contents. With nonmonospaced (proportional) fonts, the file content will not
align properly. This font setting is controlled by the Text Output Font setting on the
Viewer tab of the Options dialog box (Edit menu).

Text Wizard: Step 5

Figure 3-21
Text Wizard: Step 5
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This steps controls the variable name and the data format that the Text Wizard will use
to read each variable and which variables will be included in the final data file.
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Variable name. You can overwrite the default variable names with your own
variable names. If you read variable names from the data file, the Text Wizard will
automatically modify variable names that don’t conform to variable naming rules.
Select a variable in the preview window and then enter a variable name.

Data format. Select a variable in the preview window and then select a format from
the drop-down list. Shift-click to select multiple contiguous variables or Ctrl-click to
select multiple noncontiguous variables.

Text Wizard Formatting Options

Formatting options for reading variables with the Text Wizard include:
Do not import. Omit the selected variable(s) from the imported data file.

Numeric. Valid values include numbers, a leading plus or minus sign, and a decimal
indicator.

String. Valid values include virtually any keyboard characters and embedded blanks.
For delimited files, you can specify the number of characters in the value, up to a
maximum of 32,767. By default, the Text Wizard sets the number of characters to the
longest string value encountered for the selected variable(s). For fixed-width files, the
number of characters in string values is defined by the placement of variable break
lines in step 4.

Date/Time. Valid values include dates of the general format dd-mm-yyyy, mm/dd/yyyy,
dd.mm.yyyy, yyyy/mm/dd, hh:mm:ss, and a variety of other date and time formats.
Months can be represented in digits, Roman numerals, or three-letter abbreviations, or
they can be fully spelled out. Select a date format from the list.

Dollar. Valid values are numbers with an optional leading dollar sign and optional
commas as thousands separators.

Comma. Valid values include numbers that use a period as a decimal indicator and
commas as thousands separators.

Dot. Valid values include numbers that use a comma as a decimal indicator and periods
as thousands separators.

Note: Values that contain invalid characters for the selected format will be treated as
missing. Values that contain any of the specified delimiters will be treated as multiple
values.
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Figure 3-22
Text Wizard: Step 6

Data Files
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This is the final step of the Text Wizard. You can save your specifications in a file for
use when importing similar text data files. You can also paste the syntax generated by
the Text Wizard into a syntax window. You can then customize and/or save the syntax
for use in other sessions or in production jobs.

Cache data locally. A data cache is a complete copy of the data file, stored in temporary
disk space. Caching the data file can improve performance.

Reading Dimensions Data

You can read data from SPSS Dimensions products, including Quanvert, Quancept,

and mrinterview.



54

Chapter 3

To read Dimensions data sources, you must have the following items installed on the
computer that is running SPSS:

®m . NET framework
B Dimensions Data Model and OLE DB Access

Versions of these components that are compatible with this release of SPSS can be
installed from the SPSS installation CD and are available on the AutoPlay menu. You
can read Dimensions data sources only in local analysis mode. This feature is not
available in distributed analysis mode using SPSS Server.

To read data from a Dimensions data source:

In any open SPSS window, from the menus choose:
File
Open Dimensions Data

On the Connection tab of Data Link Properties, specify the metadata file, the case
data type, and the case data file.

» Click OK.

>

In the Dimensions Data Import dialog box, select the variables that you want to include
and select any case selection criteria.

Click OK to read the data.

Data Link Properties Connection Tab

To read a Dimensions data source, you need to specify:

Metadata Location. The metadata document file (./mdd) that contains questionnaire
definition information.

Case Data Type. The format of the case data file. Available formats include:
B Quancept Data File (DRS). Case data in a Quancept .drs, .drz, or .dru file.
®  Quanvert Database. Case data in a Quanvert database.

®  Dimensions Database (MS SQL Server). Case data in an SPSS MR relational
database in SQL Server. This option can be used to read data that are collected
by using mrinterview.

m  Dimensions XML Data File. Case data in an XML file.
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Case Data Location. The file that contains the case data. The format of this file must be
consistent with the selected case data type.

Figure 3-23
Data Link Properties: Connection tab

Data Link Properties

Provider | Connection | Advanced | Al

Metadata
Metadata Type:

Dimengions Metadata Document v|

Metadata Location:

C:hdatahmuseunn. mdd
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Case Data
Lase Data Type:

Dimengions <kL Data File [read-write) w

Caze Data Location:

C:hdatabmuseum. sml

Case Data Project:

Test Connection

ok |[ Cancel H Help ]

Note: The extent to which other settings on the Connection tab or any settings on the
other Data Link Properties tabs may or may not affect reading Dimensions data into
SPSS is not known, so we recommend that you do not change any of them.

Select Variables Tab

You can select a subset of variables to read. By default, all standard variables in the
data source are displayed and selected.

m  Show System variables. Displays any “system” variables, including variables
that indicate interview status (in progress, completed, finish date, etc.). You can
then select any system variables that you want to include. By default, all system
variables are excluded.
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m  Show Codes variables. Displays any variables that represent codes that are used
for open-ended “Other” responses for categorical variables. You can then select
any Codes variables that you want to include. By default, all Codes variables
are excluded.

m  Show SourceFile variables. Displays any variables that contain filenames of images
of scanned responses. You can then select any SourceFile variables that you want
to include. By default, all SourceFile variables are excluded.

Figure 3-24
Dimensions Data Import: Select Variables tab
Dimensions Data lmport
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Irnpart | 1 ame Tupe “
[A] address Text =
[2] adults Long
age Categorical
[2] agebalance Daouble
before Categorical
hiology Categoarical
|§| certificat Categorical
desc_enter Categorical
desc_leave Cateqgarical
2] dinosaurs Long
distance Categorical
education Categorical
entrance Categorical
expect Cateqarical | |
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] Show System vaniables
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I k. ] [ Faste ] [ Cancel ] [ Help

Case Selection Tab

For Dimensions data sources that contain system variables, you can select cases based
on a number of system variable criteria. You do not need to include the corresponding
system variables in the list of variables to read, but the necessary system variables must
exist in the source data to apply the selection criteria. If the necessary system variables
do not exist in the source data, the corresponding selection criteria are ignored.
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Data collection status. You can select respondent data, test data, or both. You can also
select cases based on any combination of the following interview status parameters:

Completed successfully
Active/in progress

Timed out

Stopped by script

Stopped by respondent
Interview system shutdown

Signal (terminated by a signal statement in the script)

Data collection finish date. You can select cases based on the data collection finish date.

Start Date. Cases for which data collection finished on or after the specified date
are included.

End Date. Cases for which data collection finished before the specified date are
included. This does not include cases for which data collection finished on the
end date.

If you specify both a start date and end date, this defines a range of finish dates
from the start date to (but not including) the end date.
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Figure 3-25
Dimensions Data Import: Case Selection tab
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File Information

A data file contains much more than raw data. It also contains any variable definition
information, including:

B Variable names

B Variable formats

m  Descriptive variable and value labels

This information is stored in the dictionary portion of the data file. The Data Editor

provides one way to view the variable definition information. You can also display
complete dictionary information for the active dataset or any other data file.
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To Display Data File Information

» From the menus in the Data Editor window choose:
File
Display Data File Information

» For the currently open data file, choose Working File.

» For other data files, choose External File, and then select the data file.

The data file information is displayed in the Viewer.

Saving Data Files

In addition to saving data files in SPSS format, you can save data from SPSS in a wide
variety of external formats, including:

m  Excel and other spreadsheet formats
Tab-delimited and CSV text files
SAS

Stata

Database tables

To Save Modified Data Files

» Make the Data Editor the active window (click anywhere in the window to make
it active).

» From the menus choose:

File
Save

The modified data file is saved, overwriting the previous version of the file.

Saving Data Files in External Formats

» Make the Data Editor the active window (click anywhere in the window to make
it active).
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» From the menus choose:
File
Save As...

» Select a file type from the drop-down list.

» Enter a filename for the new data file.

To write variable names to the first row of a spreadsheet or tab-delimited data file:

» Click Write variable names to spreadsheet in the Save Data As dialog box.

To save value labels instead of data values in Excel 97 format:

» Click Save value labels where defined instead of data values in the Save Data As dialog
box.

To save value labels to a SAS syntax file (active only when a SAS file type is selected):

» Click Save value labels into a .sas file in the Save Data As dialog box.

For information on exporting data to database tables, see Exporting to a Database
on p. 68.

For information on exporting data for use in Dimensions applications, see Exporting
to Dimensions on p. 84.

Saving Data: Data File Types
You can save data in the following formats:
SPSS (*.sav). SPSS format.

m Data files saved in SPSS format cannot be read by versions of the software prior
to version 7.5.
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B When using data files with variable names longer than eight bytes in SPSS 10.x
or 11.x, unique, eight-byte versions of variable names are used—but the original
variable names are preserved for use in release 12.0 or later. In releases prior to
SPSS 10.0, the original long variable names are lost if you save the data file.

®  When using data files with string variables longer than 255 bytes in versions of
SPSS prior to release 13.0, those string variables are broken up into multiple
255-byte string variables.

SPSS 7.0 (*.sav). SPSS 7.0 for Windows format. Data files saved in SPSS 7.0 format
can be read by SPSS 7.0 and earlier versions of SPSS for Windows but do not include
defined multiple response sets or Data Entry for Windows information.

SPSS/PC+ (*.sys). SPSS/PC+ format. If the data file contains more than 500 variables,
only the first 500 will be saved. For variables with more than one defined user-missing
value, additional user-missing values will be recoded into the first defined user-missing
value.

SPSS Portable (*.por). SPSS portable format that can be read by other versions of
SPSS and versions on other operating systems (for example, Macintosh or UNIX).
Variable names are limited to eight bytes and are automatically converted to unique
eight-byte names if necessary.

Tab-delimited (*.dat). Text files with values separated by tabs. (Note: Tab characters
embedded in string values are preserved as tab characters in the tab-delimited file. No
distinction is made between tab characters embedded in values and tab characters
that separate values.)

Comma-delimited (*.csv). Text files with values separated by commas or semicolons. If
the current SPSS decimal indicator is a period, values are separated by commas. If the
current SPSS decimal indicator is a comma, values are separated by semicolons.

Fixed ASCII (*.dat). Text file in fixed format, using the default write formats for all
variables. There are no tabs or spaces between variable fields.

Excel 97 and later (*.xIs). Microsoft Excel 97/2000/XP spreadsheet file. The maximum
number of variables is 256, and the maximum number of rows is 65,536.

Excel 2.1 (*.xIs). Microsoft Excel 2.1 spreadsheet file. The maximum number of
variables is 256, and the maximum number of rows is 16,384.

1-2-3 Release 3.0 (*.wk3). Lotus 1-2-3 spreadsheet file, release 3.0. The maximum
number of variables that you can save is 256.
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1-2-3 Release 2.0 (*.wk1). Lotus 1-2-3 spreadsheet file, release 2.0. The maximum
number of variables that you can save is 256.

1-2-3 Release 1.0 (*.wks). Lotus 1-2-3 spreadsheet file, release 1A. The maximum
number of variables that you can save is 256.

SYLK (*.slk). Symbolic link format for Microsoft Excel and Multiplan spreadsheet files.
The maximum number of variables that you can save is 256.

dBASE IV (*.dbf). dBASE IV format.
dBASE Ill (*.dbf). dBASE III format.
dBASE Il (*.dbf). dBASE II format.

SAS v7+ Windows short extension (*.sd7). SAS versions 7-8 for Windows short
filename format.

SAS v7+ Windows long extension (*.sas7bdat). SAS versions 7-8 for Windows long
filename format.

SAS v7+ for UNIX (*.ssd01). SAS v8 for UNIX.

SAS v6 for Windows (*.sd2). SAS v6 file format for Windows/OS2.

SAS v6 for UNIX (*.ssd01). SAS v6 file format for UNIX (Sun, HP, IBM).

SAS v6 for Alpha/OSF (*.ssd04). SAS v6 file format for Alpha/OSF (DEC UNIX).
SAS Transport (*.xpt). SAS transport file.

Stata Version 8 Intercooled (*.dta).

Stata Version 8 SE (*.dta).

Stata Version 7 Intercooled (*.dta).

Stata Version 7 SE (*.dta).

Stata Version 6 (*.dta).

Stata Versions 4-5 (*.dta).

Saving File Options

For spreadsheet, tab-delimited files, and comma-delimited files, you can write variable
names to the first row of the file.
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Saving Data Files in Excel Format

You can save your data in one of three Microsoft Excel file formats. The choice of
format depends on the version of Excel that will be used to open the data. The Excel
application cannot open an Excel file from a newer version of the application. For
example, Excel 5.0 cannot open an Excel 2000 document. However, Excel 2000
can easily read an Excel 5.0 document.

There are a few limitations to the Excel file format that don’t exist in SPSS. These

limitations include:

Variable information, such as missing values and variable labels, is not included
in exported Excel files.

When exporting to Excel 97 and later, an option is provided to include value labels
instead of values.

Because all Excel files are limited to 256 columns of data, only the first 256
variables are included in the exported file.

Excel 4.0 and Excel 5.0/95 files are limited to 16,384 records, or rows of data.
Excel 97-2000 files allow 65,536 records. If your data exceed these limits, a
warning message is displayed and the data are truncated to the maximum size
allowed by Excel.

Variable Types

The following table shows the variable type matching between the original data in
SPSS and the exported data in Excel.

SPSS Variable Type Excel Data Format
Numeric 0.00; #,##0.00; ...
Comma 0.00; #,##0.00; ...
Dollar $#.##0 ); ...

Date d-mmm-yyyy

Time hh:mm:ss

String General
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Saving Data Files in SAS Format

Special handling is given to various aspects of your data when saved as a SAS file.
These cases include:

m  Certain characters that are allowed in SPSS variable names are not valid in SAS,
such as @, #, and $. These illegal characters are replaced with an underscore when
the data are exported.

m  SPSS variable names that contain multibyte characters (for example, Japanese or
Chinese characters) are converted to variables names of the general form Vnnn,
where nnn is an integer value.

m  SPSS variable labels containing more than 40 characters are truncated when
exported to a SAS vo6 file.

m  Where they exist, SPSS variable labels are mapped to the SAS variable labels.
If no variable label exists in the SPSS data, the variable name is mapped to the
SAS variable label.

m  SAS allows only one value for system-missing, whereas SPSS allows numerous
system-missing values. As a result, all system-missing values in SPSS are mapped
to a single system-missing value in the SAS file.

Save Value Labels

You have the option of saving the values and value labels associated with your data file
to a SAS syntax file. For example, when the value labels for the cars.sav data file are
exported, the generated syntax file contains:

libname library 'd:\spss\' ;

proc format library = library ;

value ORIGIN /* Country of Origin */

1 = 'American'
2 = 'European'
3 = 'Japanese’' ;

value CYLINDER /* Number of Cylinders */
3 = '3 Cylinders'

4 = '4 Cylinders'
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5 '5 Cylinders'

6 = '6 Cylinders'
8 = '8 Cylinders' ;

value FILTER__ /* cylrec = 1 | cylrec = 2 (FILTER) */
0 = 'Not Selected'

1 = 'Selected' ;

proc datasets library = library ;
modify cars;
format ORIGIN ORIGIN. ;
format CYLINDER CYLINDER. ;
format FILTER__ FILTER__.;

quit;
This feature is not supported for the SAS transport file.

Variable Types

The following table shows the variable type matching between the original data in
SPSS and the exported data in SAS.

SPSS Variable Type SAS Variable Type SAS Data Format

Numeric Numeric 12

Comma Numeric 12

Dot Numeric 12

Scientific Notation Numeric 12

Date Numeric (Date) for example,
MMDDYY10, ...

Date (Time) Numeric Timel8

Dollar Numeric 12

Custom Currency Numeric 12

String Character $8
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Saving Data Files in Stata Format

® Data can be written in Stata 5-8 format and in both Intercooled and SE format
(versions 7 and 8 only).

Data files that are saved in Stata 5 format can be read by Stata 4.
The first 80 bytes of variable labels are saved as Stata variable labels.

For numeric variables, the first 80 bytes of value labels are saved as Stata value
labels. For string variables, value labels are dropped.

m  For versions 7 and 8, the first 32 bytes of variable names in case-sensitive form
are saved as Stata variable names. For earlier versions, the first eight bytes of
variable names are saved as Stata variable names. Any characters other than
letters, numbers, and underscores are converted to underscores.

m  SPSS variable names that contain multibyte characters (for example, Japanese or
Chinese characters) are converted to variable names of the general form Vann,
where nnn is an integer value.

m  For versions 5-6 and Intercooled versions 7-38, the first 80 bytes of string values
are saved. For Stata SE 7-8, the first 244 bytes of string values are saved.

m  For versions 5-6 and Intercooled versions 7-8, only the first 2,047 variables are
saved. For Stata SE 7-8, only the first 32,767 variables are saved.

SPSS Variable Type Stata Variable Type Stata Data Format
Numeric Numeric g

Comma Numeric g

Dot Numeric g

Scientific Notation Numeric g

Date*, Datetime Numeric DmY

Time, DTime Numeic g (number of seconds)
Wkday Numeric g (1-7)

Month Numeric g (1-12)

Dollar Numeric g

Custom Currency Numeric g

String String S

*Date, Adate, Edate, SDate, Jdate, Qyr, Moyr, Wkyr
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Saving Subsets of Variables

Figure 3-26
Save Data As Variables dialog box

Save Data As: Variables
Only variables marked with an # will be saved to the specified data file.
K. Marne Label Or.. [|#
] age Age in years 1
@ rarital Warital status 2 |2
@ address Wears at curent address 3
@ income Househaold income in thousands 4
@ inczat |ncome categorny in thousandz 5
@ car Price of primary vehicle E
@ carcat Prirary vehicle price categary 7
@ ed Lewel of education g
@ employ “Yearg with curent emploper 3
@ retire Retired mwmo
[E  empeat ‘ears with current employer 11 v Help
Selected: 29 of 29 varniables.

The Save Data As Variables dialog box allows you to select the variables that you
want saved in the new data file. By default, all variables will be saved. Deselect the
variables that you don’t want to save, or click Drop All and then select the variables that
you want to save.

Visible Only. Selects only variables in variable sets currently in use. For more
information, see Use Variable Sets in Chapter 44 on p. 616.

To Save a Subset of Variables

» Make the Data Editor the active window (click anywhere in the window to make
it active).

» From the menus choose:
File
Save As...

» Click Variables.

» Select the variables that you want to save.
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Exporting to a Database

You can use the Export to Database Wizard to:

m Replace values in existing database table fields (columns) or add new fields to a
table.

B Append new records (rows) to a database table.

m  Completely replace a database table or create a new table.

To export data to a database:

» From the menus in the Data Editor window for the dataset that contains the data you

>

>

want to export, choose:

File
Export to Database

Select the database source.

Follow the instructions in the export wizard to export the data.

Creating Database Fields from SPSS Variables

When creating new fields (adding fields to an existing database table, creating a new
table, replacing a table), you can specify field names, data type, and width (where
applicable).

Field name. The default field names are the same as the SPSS variable names. You can
change the field names to any names allowed by the database format. For example,
many databases allow characters in field names that aren’t allowed in SPSS variable
names, including spaces. Therefore, an SPSS variable name like CallWaiting could be
changed to the field name Call Waiting.

Type. The export wizard makes initial data type assignments based on the standard
ODBC data types or data types allowed by the selected database format that most
closely matches the defined SPSS data format—but databases can make type
distinctions that have no direct equivalent in SPSS, and vice versa. For example, most
numeric values in SPSS are stored as double-precision floating-point values, whereas
database numeric data types include float (double), integer, real, etc. In addition, many
databases don’t have equivalents to SPSS time formats. You can change the data type
to any type available in the drop-down list.
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As a general rule, the basic data type (string or numeric) for the SPSS variable
should match the basic data type of the database field. If there is a data type mismatch
that cannot be resolved by the database, an error results and no data are exported to
the database. For example, if you export an SPSS string variable to a database field
with a numeric data type, an error will result if any values of the string variable contain
non-numeric characters.

Width. You can change the defined width for string (char, varchar) field types. Numeric
field widths are defined by the data type.

By default, SPSS variable formats are mapped to database field types based on the
following general scheme. Actual database field types may vary, depending on the
database.

SPSS Variable Format Database Field Type

Numeric Float or Double

Comma Float or Double

Dot Float or Double

Scientific Notation Float or Double

Date Date or Datetime or Timestamp
Datetime Datetime or Timestamp

Time, DTime Float or Double (number of seconds)
Wkday Integer (1-7)

Month Integer (1-12)

Dollar Float or Double

Custom Currency Float or Double

String Char or Varchar

User-Missing Values

There are two options for the treatment of user-missing values when data from SPSS
variables are exported to database fields:

Export as valid values. User-missing values are treated as regular, valid, nonmissing
values.
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Export numeric user-missing as nulls and export string user-missing values as blank
spaces. Numeric user-missing values are treated the same as system-missing

values. String user-missing values are converted to blank spaces (strings cannot be
system-missing).

Selecting a Data Source

In the first panel of the Export to Database Wizard, you select the data source to which
you want to export data.

Figure 3-27

Export to Database Wizard, selecting a data source

Export to Database Wizard

Welcome to the Export to Database Wizard!

The Export ko Database Wizard helps you export data from the active SPSS dataset to a database, To start, select a data source

DDBC Daka Sources

&8 dBASE Files

Qﬁ Excel Files

‘33 M3 Access Database

Add ODEC Data Source. ..

You can export data to any database source for which you have the appropriate ODBC
driver. (Note: Exporting data to OLE DB data sources is not supported.)



71

Data Files

If you do not have any ODBC data sources configured, or if you want to add a new
data source, click Add ODBC Data Source. In distributed analysis mode (available with
SPSS Server), this button is not available. To add data sources in distributed analysis
mode, see your system administrator.

An ODBC data source consists of two essential pieces of information: the driver
that will be used to access the data and the location of the database you want to access.
To specify data sources, you must have the appropriate drivers installed. For local
analysis mode, you can install drivers from the CD-ROM for this product:

m  SPSS Data Access Pack. Installs drivers for a variety of database formats. This
feature is available on the AutoPlay menu.

®  Microsoft Data Access Pack. Installs drivers for Microsoft products, including
Microsoft Access. To install the Microsoft Data Access Pack, double-click
Microsoft Data Access Pack in the Microsoft Data Access Pack folder on the
CD-ROM.

Some data sources may require a login ID and password before you can proceed to
the next step.

Choosing How to Export the Data

After you select the data source, you indicate the manner in which you want to export
the data.
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Figure 3-28
Export to Database Wizard, choosing how to export

Export to Database Wizard

Choose how to export the data

Connected to Database; z:pubs|spss|datajobsidm_demo.mdb

Export Methods

+ (%) Replace values in existing Fields

ﬂ To use this option, you may need ko know which variables are the primary keys.

() Add new Fields to an existing table

-% To use this option, you may need ta know which variables are the primary keys.
_ (7 Append new records to an existing table

-’&I () Drop an existing table and create a new table of the same name
> % (O Create a new table

l < Back ” et = ” Finish “ Cancel “ Help

The following choices are available for exporting data to a database:

Replace values in existing fields. Replaces values of selected fields in an existing
table with values from the selected variables in the active dataset. For more
information, see Replacing Values in Existing Fields on p. 77.

Add new fields to an existing table. Creates new fields in an existing table that
contain the values of selected variables in the active dataset. For more information,
see Adding New Fields on p. 78. This option is not available for Excel files.

Append new records to an existing table. Adds new records (rows) to an existing
table containing the values from cases in the active dataset. For more information,
see Appending New Records (Cases) on p. 79.

Drop an existing table and create a new table of the same name. Deletes the specified
table and creates a new table of the same name that contains selected variables
from the active dataset. All information from the original table, including
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definitions of field properties (for example, primary keys, data types) is lost. For
more information, see Creating a New Table or Replacing a Table on p. 81.

m  Create a new table. Creates a new table in the database containing data from
selected variables in the active dataset. The name can be any value that is allowed
as a table name by the data source. The name cannot duplicate the name of an
existing table or view in the database. For more information, see Creating a New
Table or Replacing a Table on p. 81.

Selecting a Table

When modifying or replacing a table in the database, you need to select the table to
modify or replace. This panel in the Export to Database Wizard displays a list of
tables and views in the selected database.

Figure 3-29
Export to Database Wizard, selecting a table or view

Export to Database Wizard

Select a table or view ﬂ

Connected to Database: dm_demo.mdb

Tables and Yigws:
Combinedsubset
CombinedTable
DemographicInformation

SurveyResponses
Walue Labels

Show: [¥] Tables [ views [¥] synonyms [ 5ystem rables

< Back ” Mext = ” Finish “ Cancel “ Help
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By default, the list displays only standard database tables. You can control the type of
items that are displayed in the list:

m Tables. Standard database tables.

m  Views. Views are virtual or dynamic “tables” defined by queries. These can
include joins of multiple tables and/or fields derived from calculations based on
the values of other fields. You can append records or replace values of existing
fields in views, but the fields that you can modify may be restricted, depending
on how the view is structured. For example, you cannot modify a derived field,
add fields to a view, or replace a view.

B Synonyms. A synonym is an alias for a table or view, typically defined in a query.

m  System tables. System tables define database properties. In some cases, standard
database tables may be classified as system tables and will be displayed only if
you select this option. Access to real system tables is often restricted to database
administrators.

Selecting Cases to Export

Case selection in the Export to Database Wizard is limited either to all cases or to cases
selected using a previously defined filter condition. If no case filtering is in effect, this
panel will not appear, and all cases in the active dataset will be exported.
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Figure 3-30
Export to Database Wizard, selecting cases to export
Export to Database Wizard
Select cases to export B
P Bd====

Expart all cases or use an existing filker condition to export a subset of cases,

Which cases do you want ko expart?

(®) ol cases

434443
43444l

() Filtered cases

+
p
I}

For information on defining a filter condition for case selection, see Select Cases
on p. 232.

Matching Cases to Records

When adding fields (columns) to an existing table or replacing the values of existing
fields, you need to make sure that each case (row) in the active dataset is correctly
matched to the corresponding record in the database.

In the database, the field or set of fields that uniquely identifies each record is
often designated as the primary key.

You need to identify which SPSS variable(s) correspond to the primary key field(s)
or other fields that uniquely identify each record.

The fields don’t have to be the primary key in the database, but the field value or
combination of field values must be unique for each case.
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To match SPSS variables with fields in the database that uniquely identify each record:
» Drag and drop the SPSS variable(s) onto the corresponding database fields.
or

» Select a variable from the list of SPSS variables, select the corresponding field in the
database table, and click Connect.

To delete a connection line:

» Select the connection line and press the Delete key.

Figure 3-31
Export to Database Wizard, matching cases to records

Export to Database Wizard

Match cases to records 4
===(EE

wWhich variables and fields should be used to match cases in the dataset with records in the table or view? Only the records that
match will be changed.

Toindicate that & variable in the dataset corresponds to a field in the table o view, select the variable and the field and then
click the Connect bukton. 4 line will be drawn to connect the variable to the field. Alkernatively, you may drag the variable to the
field and drop it.

To remaove a line, select it and press the Delete key,

SPSS: [SurveySubset] Table: Surveysubset
le [o] | —aD counter
é’W\re\ess [wireless] V\ﬂre.less .double
fMuIthne [Multline] MUFUII‘IE !rrteger
&Voice [Woice] :DICE !meger
é)Pager [Pager] II_:S::a ::ioi?az
& Internet [Internet] CallerD integer
& CallerID [CallerID] SurveyDate detetime
Q‘fgsurvey'Date [SurveyDate] Comments varchar
&a Comments [Comments] P
~
Right-click on a wariable for mare
information

Note: The SPSS variable names and database field names may not be identical (since
database field names may contain characters not allowed in SPSS variable names), but
if the active dataset was created from the database table you are modifying, either the
variable names or the variable labels will usually be at least similar to the database
field names.
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Replacing Values in Existing Fields

To replace values of existing fields in a database:

» In the Choose how to export the data panel of the Export to Database Wizard, select
Replace values in existing fields.

» In the Select a table or view panel, select the database table.

» In the Match cases to records panel, match the SPSS variables that uniquely identify
each case to the corresponding database field names.

» For each field for which you want to replace values, drag and drop the SPSS variable
that contains the new values into the Source of values column, next to the corresponding
database field name.

Figure 3-32

Export to Database Wizard, replacing values of existing fields

Export to Database Wizard
Select variables to store in existing fields ﬂ%

To replace the walues in a table field with the values of a dataset variable, place the wariable in the cell next to the Field name.
Use the arrow buttons or drag and drop.

Match cases ta records: ID=SurveySubset. 1D

5P55: [SurveySubset] Table: SurveySubset
§Wireless [wireless] | Source of values |Tal1le fields Type |Wi(lth |
Multline [Mulkline] [Is] courter
& vaice [Voice] g Wireless double
yPager [Pager] W uttline integer
& Trksrmet [Internet] (»_ Woice integer
yCaIIerID [CallerIl] W Pagsr integer
o SurveyDate [SurveyDate] [ » Internet dolble
%Comments [Cammments] [T CalleriD \nlegx.ar
[T SurveyDate datetime
[T Comments varchar 233

Right-click on a variable for mare
infarmation
User-Missing Yalues

(&) Export as valid values

() Expart numetic user-missing values as nulls and expart string user-missing values as blank spaces

< Back ” Mext = “ Finish “ Cancel “ Help
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B As a general rule, the basic data type (string or numeric) for the SPSS variable
should match the basic data type of the database field. If there is a data type
mismatch that cannot be resolved by the database, an error results and no data is
exported to the database. For example, if you export an SPSS string variable to
a database field with a numeric data type (for example, double, real, integer), an
error will result if any values of the string variable contain non-numeric characters.
The letter a in the icon next to an SPSS variable denotes a string variable.

B You cannot modify the field name, type, or width. The original database field
attributes are preserved; only the values are replaced.

Adding New Fields

To add new fields to an existing database table:

» In the Choose how to export the data panel of the Export to Database Wizard, select
Add new fields to an existing table.

» In the Select a table or view panel, select the database table.

» In the Match cases to records panel, match the SPSS variables that uniquely identify
each case to the corresponding database field names.

» Drag and drop the SPSS variables that you want to add as new fields to the Source
of values column.
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Figure 3-33
Export to Database Wizard, adding new fields to an existing table
Export to Database Wizard
Select variables to store in new fields %
To store a wariable in a new field, place it in the Source of walues column in the grid. Use the arrow keys or drag and drop. Click.
on the new field name, type, or width to edit it.
Match cases ta records: ID=SurveySubset. 1D
5PSS: [SurveySubset] Table: Surveysubset .
fWireless [wireless] Source of values Table fields Type Width |
&Mu\t\ine [Multline]
Woice [Yaoice]
&Pager [Pager]
flntarnet [Internet]
&CallerID [CallerID]
g@surveyDate [SurveyDate]
Comments [Comments:
da . ! 4 Recoded Wireless double o
~
< 2|
Right-click on a variable for mare Shaw existing fields
infarmation
User-Missing Yalues
(%) Export as valid values
() Expart numetic user-missing values as nulls and expart string user-missing values as blank spaces
I < Back ” Mext = “ Finish “ Cancel “ Help ]

For information on field names and data types, see the section on creating database
fields from SPSS variables in Exporting to a Database on p. 68.

Show existing fields. Select this option to display a list of existing fields. You cannot
use this panel in the Export to Database Wizard to replace existing fields, but it may be
helpful to know what fields are already present in the table. If you want to replace the
values of existing fields, see Replacing Values in Existing Fields on p. 77.

Appending New Records (Cases)

To append new records (cases) to a database table:

» In the Choose how to export the data panel of the Export to Database Wizard, select
Append new records to an existing table.

» In the Select a table or view panel, select the database table.
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» Match variables in the active dataset to table fields by dragging and dropping SPSS
variables to the Source of values column.

Figure 3-34
Export to Database Wizard, adding records (cases) to a table
Export to Database Wizard
Select variables to store in new records ==
EREE

To stare the values of a variable in new records, place the variable in the cell next ko the field name. Use the arrow butkans or
drag and drop.

P35 [SurveySubset] Table: Surveysubset
e&Wireless Recoded [Recodedwireless] |Suurce of values Table fields Type |Wi(|th |
[4 o 5] aunter 10
[T Wireless Wireless double 15
[4 [Muttine Muttine integer 10
[T Yoice Woice integer 10
[T Pager Pager integer 10
[4 |rternet Internet double 15
[4 [CalleriD CalleriD integer 10
[T SurveyDate SurveyDate datetime 19
W Comments Comments varchar 253

Right-click on a wariable For more
infarmation

User-Missing Yalues
() Export as valid values

() Export numeric user-missing values as nulls and export string user-missing values as blank spaces

< Back ” Mext = H Finish ” Cancel “ Help

The Export to Database Wizard will automatically select all variables that match
existing fields, based on information about the original database table stored in the
active dataset (if available) and/or variable names that are the same as field names.
This initial automatic matching is intended only as a guide and does not prevent you
from changing the way in which SPSS variables are matched with database fields.

When adding new records to an existing table, the following basic rules/limitations

apply:

m  All cases (or all selected cases) in the active dataset are added to the table. If any
of these cases duplicate existing records in the database, an error may result if a

duplicate key value is encountered. For information on exporting only selected
cases, see Selecting Cases to Export on p. 74.
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B You can use the values of new variables created in the session as the values for
existing fields, but you cannot add new fields or change the names of existing
fields. To add new fields to a database table, see Adding New Fields on p. 78.

B Any excluded database fields or fields not matched to an SPSS variable will have
no values for the added records in the database table. (If the Source of values cell is
empty, there is no SPSS variable matched to the field.)

Creating a New Table or Replacing a Table

To create a new database table or replace an existing database table:

» In the Choose how to export the data panel of the export wizard, select Drop an existing
table and create a new table of the same name or select Create a new table and enter a
name for the new table.

» If you are replacing an existing table, in the Select a table or view panel, select the
database table.

» Drag and drop SPSS variables into the Variables to save column.

» Optionally, you can designate variables/fields that define the primary key, change
field names, and change the data type.
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Figure 3-35

Export to Database Wizard, selecting variables for a new table

Export to Database Wizard
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Primary key. To designate variables as the primary key in the database table, select the
box in the column identified with the key icon.

®  All values of the primary key must be unique or an error will result.

m Ifyou select a single variable as the primary key, every record (case) must have a
unique value for that variable.

m If you select multiple variables as the primary key, this defines a composite
primary key, and the combination of values for the selected variables must be

unique for each case.

For information on field names and data types, see the section on creating database
fields from SPSS variables in Exporting to a Database on p. 68.
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Completing the Database Export Wizard

The last panel of the Export to Database Wizard provides a summary that indicates what
data will be exported and how it will be exported. It also gives you the option of either
exporting the data or pasting the underlying command syntax to a syntax window.

Figure 3-36
Export to Database Wizard, Finish panel

Export to Database Wizard

Finish S E=EEE

‘our specifications are summarized below, You are ready to export the data or paste the syntax.

SUrmaty

Dataset: [SurveyResponses]
Table: UpdateTable

Cages to Export: Filtered

Action: Create new table
User-Missing Yalues: Export as valid values

wihat would you like to do?
(8) Export the data

() Paste the syntax

[ Finish ” Cancel “ Help

Summary Information

m Dataset. The SPSS session name for the dataset that will be used to export data.
This information is primarily useful if you have multiple open data sources. Data
sources opened using the graphical user interface (for example, the Database
Wizard) are automatically assigned names such as DataSet!, DataSet2, etc. A
data source opened using command syntax will have a dataset name only if one
is explicitly assigned.

m Table. The name of the table to be modified or created.
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m Cases to Export. Either all cases are exported or cases selected by a previously
defined filter condition are exported. For more information, see Selecting Cases to
Export on p. 74.

®m  Action. Indicates how the database will be modified (for example, create a new
table, add fields or records to an existing table).

m  User-Missing Values. User-missing values can be exported as valid values or
treated the same as system-missing for numeric variables and converted to blank
spaces for string variables. This setting is controlled in the panel in which you
select the variables to export.

Exporting to Dimensions

The Export to Dimensions dialog box creates an SPSS data file and a Dimensions
metadata file that you can use to read the data into Dimensions applications such as
mrinterview and mrTables. This is particularly useful when “roundtripping” data
between SPSS and Dimensions applications. For example, you can read an mrinterview
data source into SPSS, calculate some new variables, and then save the data in a form
that can be read by mrTables, without loss of any of the original metadata attributes.

To export data for use in Dimensions applications:

» From the menus in the Data Editor window that contains the data you want to export,
choose:
File
Export to Dimensions

» Click Data File to specify the name and location of the SPSS data file.

» Click Metadata File to specify the name and location of the Dimensions metadata file.
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Figure 3-37
Export to Dimensions dialog box

Export to Dimensions

Exporting to Dimensions saves the ackive dataset as an SPSS data file and creates a Dimensions
metadata file,

Data File.., c:kempiDimensionsData, sav
Metadata File, ., CitemptDimensionsata, mdd

If walue labels have been defined For any non-missing values of a wariable, they must be
@ defined for all non-missing walues of that wariable. Otherwise, the unlabeled walues will be
dropped when the data are read by Dimensions.

[ QF ][ Paste ][ Rieset ][ Cancel ][ Help ]

For new variables and datasets not created from Dimensions data sources, SPSS

variable attributes are mapped to Dimensions metadata attributes in the metadata

file according to the methods described in the SPSS SAV DSC documentation in the

Dimensions Development Library.

If the active dataset was created from a Dimensions data source:

The new metadata file is created by merging the original metadata attributes with
metadata attributes for any new variables, plus any changes to original variables
that might effect their metadata attributes (for example, addition of, or changes
to, value labels).

For original variables read from the Dimensions data source, any metadata
attributes not recognized by SPSS are preserved in their original state. For
example, SPSS converts grid variables to regular SPSS variables, but the metadata
that defines these grid variables is preserved when you save the new metadata file.

If any Dimensions variables were automatically renamed to conform to SPSS
variable naming rules, the metadata file maps the converted names back to the
original Dimensions variable names.

The presence or absence of value labels can affect the metadata attributes of variables
and consequently the way those variables are read by Dimensions applications. If
value labels have been defined for any nonmissing values of a variable, they should be
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defined for all nonmissing values of that variable; otherwise, the unlabeled values will
be dropped when the data file is read by Dimensions.

Protecting Original Data

>

To prevent the accidental modification or deletion of your original data, you can mark
the file as read-only.

From the Data Editor menus choose:
File
Mark File Read Only
If you make subsequent modifications to the data and then try to save the data file, you
can save the data only with a different filename, so the original data are not affected.
You can change the file permissions back to read-write by selecting Mark File Read
Write from the File menu.

Virtual Active File

The virtual active file enables you to work with large data files without requiring
equally large (or larger) amounts of temporary disk space. For most analysis and
charting procedures, the original data source is reread each time you run a different
procedure. Procedures that modify the data require a certain amount of temporary disk
space to keep track of the changes, and some actions always require enough disk space
for at least one entire copy of the data file.
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Figure 3-38
Temporary disk space requirements
COMPUTE v6 = ...
RECODE v4... SORT CASES BY...
Action GET FILE = 'vi-5.sav". REGRESSION... or
FREQUENCIES... /SAVE ZPRED. CACHE
vi|v2 | v3]vd|vs vi | v2 | v3 ]| vd | v5 ] v6 |zpre vi | v2 | v3 | vd | v5] v6 |zpre
11]12]13] 14 15 111213 14]15)16] 1 11 ) 1213141516 ] 1
Virtual 21 | 22| 23] 24|25 21 | 22| 23|24 |25])26]) 2 21 | 22| 23|24 f25])26] 2
Active 31 [32|33]34]35 31 [32|33]34]35]36] 3 31[32|33[34]35]36] 3
File 41| 42| 43| 44 | 45 41| 42| 43| 44 | 45 46| 4 41 | 42| 43 [ 44| 45] 46| 4
51| 52| 53] 54|55 51| 52|53]54]|55]56]5 51 |52|53[54]55]56]5
61|62 63| 64|65 61|62 |63]|64]|65]|66] 6 61 |62|63[64]65]|66] 6
Data v4  v6 |zpre vi | v2 | v3 | v4 | v5 | v6 |zpre
Stored 14| 16 | 1 111213 | 14| 15| 16| 1
in 24 | 26 | 2 21 22| 23|24 25]| 26| 2
Temporary None 34| 36| 3 31(32|33[34|35]|36/ 3
Disk 44 | 46 | 4 41 [ 42| 43 44| 45| 46| 4
Space 54 | 56| 5 51 (52|53 [54|55]|56|5
64 | 66 | 6 61|62 |63[64/65)|66| 6

Actions that don't require any temporary disk space include:
m  Reading SPSS data files

Merging two or more SPSS data files

Reading database tables with the Database Wizard
Merging an SPSS data file with a database table

Running procedures that read data (for example, Frequencies, Crosstabs, Explore)

Actions that create one or more columns of data in temporary disk space include:
m  Computing new variables
®  Recoding existing variables

®  Running procedures that create or modify variables (for example, saving predicted
values in Linear Regression)

Actions that create an entire copy of the data file in temporary disk space include:
m Reading Excel files

B Running procedures that sort data (for example, Sort Cases, Split File)
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Reading data with GET TRANSLATE or DATA LIST commands
Using the Cache Data facility or the CACHE command

®  Launching other applications from SPSS that read the data file (for example,
AnswerTree, DecisionTime)

Note: The GET DATA command provides functionality comparable to DATA LIST
without creating an entire copy of the data file in temporary disk space. The SPLIT
FILE command in command syntax does not sort the data file and therefore does
not create a copy of the data file. This command, however, requires sorted data for
proper operation, and the dialog box interface for this procedure will automatically
sort the data file, resulting in a complete copy of the data file. (Command syntax is
not available with the Student Version.)

Actions that create an entire copy of the data file by default:

m Reading databases with the Database Wizard

m Reading text files with the Text Wizard

The Text Wizard provides an optional setting to automatically cache the data. By
default, this option is selected. You can turn it off by deselecting Cache data locally.

For the Database Wizard you can paste the generated command syntax and delete the
CACHE command.

Creating a Data Cache

Although the virtual active file can vastly reduce the amount of temporary disk space
required, the absence of a temporary copy of the “active” file means that the original
data source has to be reread for each procedure. For large data files read from an
external source, creating a temporary copy of the data may improve performance. For
example, for data tables read from a database source, the SQL query that reads the
information from the database must be reexecuted for any command or procedure that
needs to read the data. Since virtually all statistical analysis procedures and charting
procedures need to read the data, the SQL query is reexecuted for each procedure you
run, which can result in a significant increase in processing time if you run a large
number of procedures.
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If you have sufficient disk space on the computer performing the analysis (either
your local computer or a remote server), you can eliminate multiple SQL queries and
improve processing time by creating a data cache of the active file. The data cache is
a temporary copy of the complete data.

Note: By default, the Database Wizard automatically creates a data cache, but if you
use the GET DATA command in command syntax to read a database, a data cache is not
automatically created. (Command syntax is not available with the Student Version.)

To Create a Data Cache

>

>

From the menus choose:
File
Cache Data...

Click OK or Cache Now.

OK creates a data cache the next time the program reads the data (for example, the
next time you run a statistical procedure), which is usually what you want because it
doesn’t require an extra data pass. Cache Now creates a data cache immediately, which
shouldn’t be necessary under most circumstances. Cache Now is useful primarily for
two reasons:

m A data source is “locked” and can’t be updated by anyone until you end your
session, open a different data source, or cache the data.

m  For large data sources, scrolling through the contents of the Data View tab in the
Data Editor will be much faster if you cache the data.

To Cache Data Automatically

>

>

You can use the SET command to automatically create a data cache after a specified
number of changes in the active data file. By default, the active data file is
automatically cached after 20 changes in the active data file.

From the menus choose:
File
New
Syntax

In the syntax window, type SET CACHE n (where n represents the number of changes
in the active data file before the data file is cached).
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» From the menus in the syntax window choose:

Run
All

Note: The cache setting is not persistent across sessions. Each time you start a new
session, the value is reset to the default of 20.
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Distributed Analysis Mode

Distributed analysis mode allows you to use a computer other than your local (or
desktop) computer for memory-intensive work. Because remote servers that are
used for distributed analysis are typically more powerful and faster than your local
computer, distributed analysis mode can significantly reduce computer processing
time. Distributed analysis with a remote server can be useful if your work involves:

m Large data files, particularly data read from database sources.

B Memory-intensive tasks. Any task that takes a long time in local analysis mode
may be a good candidate for distributed analysis.

Distributed analysis affects only data-related tasks, such as reading data, transforming
data, computing new variables, and calculating statistics. Distributed analysis has

no effect on tasks related to editing output, such as manipulating pivot tables or
modifying charts.

Note: Distributed analysis is available only if you have both a local version and access
to a licensed server version of the software that is installed on a remote server.

Distributed Analysis versus Local Analysis

Following are some guidelines for choosing distributed analysis or local analysis mode:

Database access. Jobs that perform database queries may run faster in distributed mode
if the server has superior access to the database or if the server is running on the same

machine as the database engine. Additionally, if the necessary database-access software
is available only on the server, or if your network administrator does not permit you to
download large data tables, you can access the database only in distributed mode.

Ratio of computation to output. Commands that have the most to gain from running in
distributed mode are commands that perform a lot of computation and produce small
output results (for example, few and small pivot tables, brief text results, or few and
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simple charts). The degree of improvement largely depends on the computing power
of the remote server.

Small jobs. Jobs that run quickly in local mode will almost always run slower in
distributed mode because of inherent client/server overhead.

Charts. Case-oriented charts, such as scatterplots, regression residual plots, and
sequence charts, require raw data on your local computer. For large data files or
database tables, this process can result in slower performance in distributed mode
because the data have to be sent from the remote server to your local computer. Other
charts are based on summarized or aggregated data and should perform adequately
because the aggregation is performed on the server.

Interactive graphics. If raw data are saved with interactive graphics (an optional
setting), large amounts of data may be transferred from the remote server to your local
computer, significantly increasing the time that it takes to save your results.

Pivot tables. Large pivot tables may take longer to create in distributed mode. This
situation is particularly true for the OLAP Cubes procedure and for tables that contain
individual case data, such as the tables that are available in the Summarize procedure.

Text output. The more text that is produced, the slower the output will be in distributed
mode because the text is produced on the remote server and copied to your local
computer for display. Text results have low overhead, however, and tend to transmit
quickly.

Server Login

The Server Login dialog box allows you to select the computer that processes
commands and runs procedures. You can select your local computer or a remote server.
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Figure 4-1
Server Login dialog box

Server Login: Local Computer

Server Mame D ezcription Pt

Local Compter

[ MetwarkServer MHetwork Server 303

Add...

Checkmark indicates start-up connection

User ID:

Password:

[ Remember this password

Damain

[ oK d ’ Cancel ] ’ Help ]

You can add, modify, or delete remote servers in the list. Remote servers usually
require a user ID and password, and a domain name may also be necessary. Contact
your system administrator for information about available servers, a user ID and

password, domain names, and other connection information.
You can select a default server and save the user ID, domain name, and password
that are associated with any server. You are automatically connected to the default

server when you start a new session.
Adding and Editing Server Login Settings

Use the Server Login Settings dialog box to add or edit connection information for
remote servers for use in distributed analysis mode.
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Figure 4-2
Server Login Settings dialog box

Server Login Settings

Server Name: | MetworkServer

Part Mumber, 3013
Description; Metwork, Server

Advanced Connection Settings

: ok [ Cancel ] [ Help ]

Contact your system administrator for a list of available servers, port numbers for the
servers, and additional connection information. Do not use the Secure Socket Layer
unless instructed to do so by your administrator.

Server Name. A server “name” can be an alphanumeric name that is assigned to a
computer (for example, NetworkServer) or a unique IP address that is assigned to a
computer (for example, 202.123.456.78).

Port Number. The port number is the port that the server software uses for
communications.

Description. You can enter an optional description to display in the servers list.

Connect with Secure Socket Layer. Secure Socket Layer (SSL) encrypts requests for
distributed analysis when they are sent to the remote SPSS server. Before you use SSL,
check with your administrator. For this option to be enabled, SSL must be configured
on your desktop computer and the server.

To Select, Switch, or Add Servers
» From the menus choose:

File
Switch Server...

To select a default server:

» In the server list, select the box next to the server that you want to use.
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Enter the user ID, domain name, and password that were provided by your
administrator.

Note: You are automatically connected to the default server when you start a new
session.

To switch to another server:
Select the server from the list.

Enter your user ID, domain name, and password (if necessary).

Note: When you switch servers during a session, all open windows are closed. You
will be prompted to save changes before the windows are closed.

To add a server:
Get the server connection information from your administrator.
Click Add to open the Server Login Settings dialog box.

Enter the connection information and optional settings, and then click OK.

To edit a server:
Get the revised connection information from your administrator.
Click Edit to open the Server Login Settings dialog box.

Enter the changes and click OK.
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Opening Data Files from a Remote Server

Figure 4-3
Open Remote File dialog box

Open Remote File m

Remote Server; hqdew002
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remotefile]. sav
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remotefiled. zav
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Files of type: I LI Paste |

Cancel |

In distributed analysis mode, the Open Remote File dialog box replaces the standard

Open File dialog box.

m  The contents of the list of available files, folders, and drives depends on what is
available on or from the remote server. The current server name is indicated at the
top of the dialog box.

m In distributed analysis mode, you will not have access to files on your local
computer unless you specify the drive as a shared device or specify the folders
containing your data files as shared folders.

m  [f the server is running a different operating system (for example, you are running

Windows and the server is running UNIX), you probably won’t have access to
local data files in distributed analysis mode even if they are in shared folders.

To Open Data Files from a Remote Server
» Ifyou aren’t already connected to the remote server, log in to the remote server.
» Depending on the type of data file that you want to open, from the menus choose:
File

Open
Data...
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or

File
Open Database

or
File
Read Text Data...

Saving Data Files from a Remote Server

Figure 4-4
Save Remote File dialog box
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In distributed analysis mode, the Save Remote File dialog box replaces the standard
Save File dialog box.

The contents of the list of available folders and drives depends on what is available
on or from the remote server. The current server name is indicated at the top of the
dialog box. You will not have access to folders on your local computer unless you
specify the drive as a shared device and specify the folders as shared folders. If the
server is running a different operating system (for example, you are running Windows
and the server is running UNIX), you probably will not have access to local data files
in distributed analysis mode even if they are in shared folders. If you want to save
data files in a local folder, permissions for shared folders must include the ability to
write to the folder.
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To Save Data Files from a Remote Server

>

>

Make the Data Editor the active window.

From the menus choose:
File
Save (or Save As...)

Data File Access in Local and Distributed Analysis Mode

The view of data files, folders (directories), and drives for both your local computer
and the network is based on the computer that you are currently using to process
commands and run procedures—which is not necessarily the computer in front of you.

Local analysis mode. When you use your local computer as your “server,” the view
of data files, folders, and drives in the file access dialog box (for opening data files)
is similar to what you see in other applications or in Windows Explorer. You can
see all of the data files and folders on your computer and any files and folders on
mounted network drives.

Distributed analysis mode. When you use another computer as a “remote server” to run
commands and procedures, the view of data files, folders, and drives represents the
view from the remote server computer. Although you may see familiar folder names
(such as Program Files) and drives (such as C), these items are not the folders and
drives on your computer; they are the folders and drives on the remote server.
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Figure 4-5
Local and remote views
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In distributed analysis mode, you will not have access to data files on your local
computer unless you specify the drive as a shared device or specify the folders
containing your data files as shared folders. If the server is running a different
operating system (for example, you are running Windows and the server is running
UNIX), you probably won’t have access to local data files in distributed analysis
mode even if they are in shared folders.

Distributed analysis mode is not the same as accessing data files that reside on
another computer on your network. You can access data files on other network devices
in local analysis mode or in distributed analysis mode. In local mode, you access other
devices from your local computer. In distributed mode, you access other network
devices from the remote server.

If you’re not sure if you’re using local analysis mode or distributed analysis mode,
look at the title bar in the dialog box for accessing data files. If the title of the dialog box
contains the word Remote (as in Open Remote File), or if the text Remote Server: [server
name] appears at the top of the dialog box, you’re using distributed analysis mode.
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Note: This situation affects only dialog boxes for accessing data files (for example,
Open Data, Save Data, Open Database, and Apply Data Dictionary). For all other

file types (for example, Viewer files, syntax files, and script files), the local view is
always used.

To Set Sharing Permissions for a Drive or Folder
» In My Computer, click the folder (directory) or drive that you want to share.
» From the File menu, choose Properties.

» Click the Sharing tab, and then click Shared As.

For more information about sharing drives and folders, see the Help for your operating
system.

Availability of Procedures in Distributed Analysis Mode

In distributed analysis mode, procedures are available for use only if they are installed
on both your local version and the version on the remote server.

If you have optional components installed locally that are not available on the
remote server and you switch from your local computer to a remote server, the affected
procedures will be removed from the menus and the corresponding command syntax
will result in errors. Switching back to local mode will restore all affected procedures.

Using UNC Path Specifications

With the Windows NT server version of SPSS, relative path specifications for data files
are relative to the current server in distributed analysis mode, not relative to your
local computer. A path specification (such as c:\mydocs\mydata.sav) does not point

to a directory and file on your C drive; it points to a directory and file on the remote
server’s hard drive. If the directory and/or file do not exist on the remote server, an
error results in command syntax, as in the following example:

GET FILE='c:\mydocs\mydata.sav'.
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If you are using the Windows NT server version of SPSS, you can use universal
naming convention (UNC) specifications when accessing data files with command
syntax. The general form of a UNC specification is:
\\servername\sharename\path\filename

B Servername is the name of the computer that contains the data file.

B Sharename is the folder (directory) on that computer that is designated as a shared
folder.

B Path is any additional folder (subdirectory) path below the shared folder.
B Filename is the name of the data file.

An example is as follows:

GET FILE='\\hgdev00l\public\july\sales.sav'.

If the computer does not have a name assigned to it, you can use its IP address, as in:
GET FILE='\\204.125.125.53\public\july\sales.sav'.

Even with UNC path specifications, you can access data files only from devices and
folders that are designated as shared. When you use distributed analysis mode, this
situation includes data files on your local computer.

UNIX servers. On UNIX platforms, there is no equivalent to the UNC path, and all
directory paths must be absolute paths that start at the root of the server; relative
paths are not allowed. For example, if the data file is located in /bin/spss/data and
the current directory is also /bin/spss/data, GET FILE='sales.sav' is not valid,
you must specify the entire path, as in:

GET FILE='/bin/spss/data/sales.sav'.



Chapter

Data Editor

The Data Editor provides a convenient, spreadsheet-like method for creating and
editing data files. The Data Editor window opens automatically when you start a
session.

The Data Editor provides two views of your data:
m Data View. This view displays the actual data values or defined value labels.

m Variable View. This view displays variable definition information, including
defined variable and value labels, data type (for example, string, date, or numeric),
measurement level (nominal, ordinal, or scale), and user-defined missing values.

In both views, you can add, change, and delete information that is contained in the
data file.

102
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Data View
Figure 5-1
Data View
demo.sav - SPSS Data Editor =/ojed
File Edit Wiew Data Transform  Analvee Graphs  Utilities Add-ons  window Help
20 age 40
age | marital | address | income | inccat | car a
1 jata) Married 12 7200 %40- §74 36—
2 a6 Unmarried 29 153.00 575+ 76.
3 28 Married 9 2600 $25- 549 13
4 24 Married 4 26.00| $25- §49 12.
& 25| Unmarried 2 23.00| Under §25 11.
5} 45 Married 9 76.00 575+ av.
7 42 Unmarried 19 40,00 $25- §49 19.
&} 35| Unmarried 15 57.00| %40 - §74 28.
9 46| Unmarried 26 24.00| Under §25 12.
10 34 Married 0 89.00 575+ 46.
11 a Married 17 72000 %480 - §74 J5
4/ v \Data View £ Variable View / ||< »]]

Many of the features of Data View are similar to the features that are found in
spreadsheet applications. There are, however, several important distinctions:

Rows are cases. Each row represents a case or an observation. For example, each
individual respondent to a questionnaire is a case.

Columns are variables. Each column represents a variable or characteristic that is
being measured. For example, each item on a questionnaire is a variable.

Cells contain values. Each cell contains a single value of a variable for a case. The
cell is where the case and the variable intersect. Cells contain only data values.
Unlike spreadsheet programs, cells in the Data Editor cannot contain formulas.

The data file is rectangular. The dimensions of the data file are determined by the
number of cases and variables. You can enter data in any cell. If you enter data in a
cell outside the boundaries of the defined data file, the data rectangle is extended to
include any rows and/or columns between that cell and the file boundaries. There
are no “empty” cells within the boundaries of the data file. For numeric variables,
blank cells are converted to the system-missing value. For string variables, a
blank is considered a valid value.
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Variable View

Figure 5-2
Variable View
demo.sav - SPSS Data Editor (==
File Edit Wiew Data Transform  Analyze Graphs Utilities Add-ons  wWindow Help
Mame | Type | Width | Decimals Label | “alue )
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11| empcat Mumeric 4 0 Years with cur{1, Less t
12|jobsat Mumeric 4 0 Job satisfactio {1, Highly
13| gender String 2 0 Gender {f, Female
14|reside MNumeric 4 0 Mumber of pea |Mone
15| wireless MNumeric 4 0 Wireless servi {0, Mo}
16| multline MNumeric 4 0 Multiple lines {0, Mo}...
« » \ Dala View ) Variable View / B el 2l
SPS5S Processor is ready

Variable View contains descriptions of the attributes of each variable in the data file.
In Variable View:

B Rows are variables.

®  Columns are variable attributes.

You can add or delete variables and modify attributes of variables, including the
following attributes:

Variable name

Data type

Number of digits or characters
Number of decimal places

Descriptive variable and value labels

User-defined missing values
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®  Column width

B Measurement level

All of these attributes are saved when you save the data file.

In addition to defining variable properties in Variable View, there are two other
methods for defining variable properties:

m  The Copy Data Properties Wizard provides the ability to use an external SPSS
data file or another dataset that is available in the current session as a template
for defining file and variable properties in the active dataset. You can also use
variables in the active dataset as templates for other variables in the active dataset.
Copy Data Properties is available on the Data menu in the Data Editor window.

m Define Variable Properties (also available on the Data menu in the Data Editor
window) scans your data and lists all unique data values for any selected variables,
identifies unlabeled values, and provides an auto-label feature. This method is
particularly useful for categorical variables that use numeric codes to represent
categories—for example, 0 = Male, 1 = Female.

To Display or Define Variable Attributes

» Make the Data Editor the active window.

» Double-click a variable name at the top of the column in Data View, or click the
Variable View tab.

» To define new variables, enter a variable name in any blank row.

» Select the attribute(s) that you want to define or modify.

Variable Names

The following rules apply to variable names:
m  Each variable name must be unique; duplication is not allowed.

B Variable names can be up to 64 bytes long, and the first character must be a letter
or one of the characters @, #, or $. Subsequent characters can be any combination
of letters, numbers, a period (.), and nonpunctuation characters. Sixty-four bytes
typically means 64 characters in single-byte languages (e.g., English, French,
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German, Spanish, Italian, Hebrew, Russian, Greek, Arabic, and Thai) and 32
characters in double-byte languages (e.g., Japanese, Chinese, and Korean).

(Note: Letters include any nonpunctuation characters used in writing ordinary
words in the languages supported in the character set of the platform on which
SPSS is running.)

Variable names cannot contain spaces.

A # character in the first position of a variable name defines a scratch variable. You
can only create scratch variables with command syntax. You cannot specify a # as
the first character of a variable in dialog boxes that create new variables.

B A $ sign in the first position indicates that the variable is a system variable. The $
sign is not allowed as the initial character of a user-defined variable.

m  The period, underscore, and the characters $, #, and @ can be used within variable
names. For example, 4. $@#I is a valid variable name.

B Variable names ending with a period should be avoided, since the period may be
interpreted as a command terminator. You can only create variables that end with a
period in command syntax. You cannot create variables that end with a period in
dialog boxes that create new variables.

B Variable names ending in underscores should be avoided, since such names
may conflict with names of variables automatically created by commands and
procedures.

B Reserved keywords cannot be used as variable names. Reserved keywords are:
ALL, AND, BY, EQ, GE, GT, LE, LT, NE, NOT, OR, TO, and WITH.

B Variable names can be defined with any mixture of uppercase and lowercase
characters, and case is preserved for display purposes.

®  When long variable names need to wrap onto multiple lines in output, SPSS
attempts to break the lines at underscores, periods, and where content changes
from lower case to upper case.

Variable Measurement Level

You can specify the level of measurement as scale (numeric data on an interval
or ratio scale), ordinal, or nominal. Nominal and ordinal data can be either string
(alphanumeric) or numeric.
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®  Nominal. A variable can be treated as nominal when its values represent categories
with no intrinsic ranking (for example, the department of the company in which
an employee works). Examples of nominal variables include region, zip code,
and religious affiliation.

m  Ordinal. A variable can be treated as ordinal when its values represent categories
with some intrinsic ranking (for example, levels of service satisfaction from
highly dissatisfied to highly satisfied). Examples of ordinal variables include
attitude scores representing degree of satisfaction or confidence and preference
rating scores.

B Scale. A variable can be treated as scale when its values represent ordered
categories with a meaningful metric, so that distance comparisons between values
are appropriate. Examples of scale variables include age in years and income
in thousands of dollars.

Note: For ordinal string variables, the alphabetic order of string values is assumed to
reflect the true order of the categories. For example, for a string variable with the
values of low, medium, high, the order of the categories is interpreted as high, low,
medium—which is not the correct order. In general, it is more reliable to use numeric
codes to represent ordinal data.

For new variables created during a session, data read from external file formats,
and SPSS data files that were created prior to version 8.0, default assignment of
measurement level is based on the following rules:

B Numeric variables with fewer than 24 unique values and string variables are set to
nominal.

®  Numeric variables with 24 or more unique values are set to scale.

You can change the scale/nominal cutoff value for numeric variables in the Options
dialog box. For more information, see Interactive Chart Options in Chapter 45 on p.
631.

The Define Variable Properties dialog box, available from the Data menu, can help
you assign the correct measurement level. For more information, see Assigning the
Measurement Level in Chapter 7 on p. 138.
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Variable Type

Variable Type specifies the data type for each variable. By default, all new variables
are assumed to be numeric. You can use Variable Type to change the data type. The
contents of the Variable Type dialog box depend on the selected data type. For some
data types, there are text boxes for width and number of decimals; for other data types,
you can simply select a format from a scrollable list of examples.

Figure 5-3
Variable Type dialog box
Yariable Type B |
Otumetc [sysm S
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() Scientific notation | ]
() Date
© Dolar Width: 12
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The available data types are as follows:

Numeric. A variable whose values are numbers. Values are displayed in standard
numeric format. The Data Editor accepts numeric values in standard format or in
scientific notation.

Comma. A numeric variable whose values are displayed with commas delimiting every
three places and displayed with the period as a decimal delimiter. The Data Editor
accepts numeric values for comma variables with or without commas or in scientific
notation. Values cannot contain commas to the right of the decimal indicator.

Dot. A numeric variable whose values are displayed with periods delimiting every
three places and with the comma as a decimal delimiter. The Data Editor accepts
numeric values for dot variables with or without periods or in scientific notation.
Values cannot contain periods to the right of the decimal indicator.

Scientific notation. A numeric variable whose values are displayed with an embedded
E and a signed power-of-10 exponent. The Data Editor accepts numeric values for
such variables with or without an exponent. The exponent can be preceded by E or
D with an optional sign or by the sign alone—for example, 123, 1.23E2, 1.23D2,
1.23E+2, and 1.23+2.
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Date. A numeric variable whose values are displayed in one of several calendar-date or
clock-time formats. Select a format from the list. You can enter dates with slashes,
hyphens, periods, commas, or blank spaces as delimiters. The century range for
two-digit year values is determined by your Options settings (from the Edit menu,
choose Options, and then click the Data tab).

Dollar. A numeric variable displayed with a leading dollar sign ($), commas delimiting
every three places, and a period as the decimal delimiter. You can enter data values
with or without the leading dollar sign.

Custom currency. A numeric variable whose values are displayed in one of the custom
currency formats that you have defined in the Currency tab of the Options dialog box.
Defined custom currency characters cannot be used in data entry but are displayed

in the Data Editor.

String. A variable whose values are not numeric and therefore are not used in
calculations. The values can contain any characters up to the defined length.
Uppercase and lowercase letters are considered distinct. This type is also known as an
alphanumeric variable.

To Define Variable Type
» Click the button in the 7ype cell for the variable that you want to define.
» Select the data type in the Variable Type dialog box.

» Click OK.

Input versus Display Formats

Depending on the format, the display of values in Data View may differ from the actual
value as entered and stored internally. Following are some general guidelines:

®  For numeric, comma, and dot formats, you can enter values with any number of
decimal positions (up to 16), and the entire value is stored internally. The Data
View displays only the defined number of decimal places and rounds values with
more decimals. However, the complete value is used in all computations.

m  For string variables, all values are right-padded to the maximum width. For a
string variable with a maximum width of three, a value of No is stored internally
as 'No ' and is not equivalentto ' No'.
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m  For date formats, you can use slashes, dashes, spaces, commas, or periods as
delimiters between day, month, and year values, and you can enter numbers,
three-letter abbreviations, or complete names for month values. Dates of the
general format dd-mmm-yy are displayed with dashes as delimiters and three-letter
abbreviations for the month. Dates of the general format dd/mm/yy and mm/dd/yy
are displayed with slashes for delimiters and numbers for the month. Internally,
dates are stored as the number of seconds from October 14, 1582. The century
range for dates with two-digit years is determined by your Options settings (from
the Edit menu, choose Options, and then click the Data tab).

m  For time formats, you can use colons, periods, or spaces as delimiters between
hours, minutes, and seconds. Times are displayed with colons as delimiters.
Internally, times are stored as a number of seconds that represents a time interval.
For example, 10:00:00 is stored internally as 36000, which is 60 (seconds per
minute) x 60 (minutes per hour) x 10 (hours).

Variable Labels

You can assign descriptive variable labels up to 256 characters (128 characters in
double-byte languages). Variable labels can contain spaces and reserved characters
that are not allowed in variable names.

To Specify Variable Labels
» Make the Data Editor the active window.

» Double-click a variable name at the top of the column in Data View, or click the
Variable View tab.

» In the Label cell for the variable, enter the descriptive variable label.

Value Labels

You can assign descriptive value labels for each value of a variable. This process
is particularly useful if your data file uses numeric codes to represent non-numeric
categories (for example, codes of 1 and 2 for male and female).
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B Value labels can be up to 120 bytes.

®  Value labels are not available for long string variables (string variables longer
than eight characters).

Figure 5-4
Value Labels dialog box
¥alue Labels BR[|
alue Labels
WValue:
e
Label:
Hel
F ="Female"
M = "Male"
To Specify Value Labels

» Click the button in the Values cell for the variable that you want to define.
» For each value, enter the value and a label.
» Click Add to enter the value label.

» Click OK.

Inserting Line Breaks in Labels

Variable labels and value labels automatically wrap to multiple lines in pivot tables
and charts if the cell or area isn’t wide enough to display the entire label on one line,
and you can edit results to insert manual line breaks if you want the label to wrap at a
different point. You can also create variable labels and value labels that will always
wrap at specified points and be displayed on multiple lines.
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» For variable labels, select the Label cell for the variable in Variable View in the Data
Editor.

» For value labels, select the Values cell for the variable in Variable View in the Data
Editor, click the button in the cell, and in the Value Labels dialog box, select the label
that you want to modify.

» At the place in the label where you want the label to wrap, type \n.

The \n is not displayed in pivot tables or charts; it is interpreted as a line break character.

Missing Values

Missing Values defines specified data values as user-missing. For example, you might
want to distinguish between data that are missing because a respondent refused to
answer and data that are missing because the question didn’t apply to that respondent.
Data values that are specified as user-missing are flagged for special treatment and are
excluded from most calculations.

Figure 5-5
Missing Values dialog box
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B You can enter up to three discrete (individual) missing values, a range of missing
values, or a range plus one discrete value.

m  Ranges can be specified only for numeric variables.

B You cannot define missing values for long string variables (string variables that are
longer than eight characters).
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Missing values for string variables. All string values, including null or blank values, are
considered to be valid unless you explicitly define them as missing. To define null or
blank values as missing for a string variable, enter a single space in one of the fields
under the Discrete missing values selection.

To Define Missing Values
» Click the button in the Missing cell for the variable that you want to define.

» Enter the values or range of values that represent missing data.

Column Width

You can specify a number of characters for the column width. Column widths can also
be changed in Data View by clicking and dragging the column borders.

Column formats affect only the display of values in the Data Editor. Changing the
column width does not change the defined width of a variable. If the defined and actual
width of a value are wider than the column, asterisks (*) are displayed in Data View.

Variable Alignment

Alignment controls the display of data values and/or value labels in Data View. The
default alignment is right for numeric variables and left for string variables. This
setting affects only the display in Data View.

Applying Variable Definition Attributes to Multiple Variables

After you have defined variable definition attributes for a variable, you can copy one or
more attributes and apply them to one or more variables.

Basic copy and paste operations are used to apply variable definition attributes. You
can:

m  Copy a single attribute (for example, value labels) and paste it to the same attribute
cell(s) for one or more variables.

m  Copy all attributes from one variable and paste them to one or more other variables.

m  Create multiple new variables with all the attributes of a copied variable.
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Applying Variable Definition Attributes to Other Variables

To Apply Individual Attributes from a Defined Variable
» In Variable View, select the attribute cell that you want to apply to other variables.

» From the menus choose:
Edit
Copy

» Select the attribute cell(s) to which you want to apply the attribute. (You can select
multiple target variables.)

» From the menus choose:
Edit
Paste

If you paste the attribute to blank rows, new variables are created with default attributes
for all attributes except the selected attribute.

To Apply All Attributes from a Defined Variable

» In Variable View, select the row number for the variable with the attributes that you
want to use. (The entire row is highlighted.)

» From the menus choose:
Edit
Copy

» Select the row number(s) for the variable(s) to which you want to apply the attributes.
(You can select multiple target variables.)

» From the menus choose:
Edit
Paste

Generating Multiple New Variables with the Same Attributes

» In Variable View, click the row number for the variable that has the attributes that you
want to use for the new variable. (The entire row is highlighted.)
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From the menus choose:
Edit
Copy

Click the empty row number beneath the last defined variable in the data file.
From the menus choose:
Edit
Paste Variables...
In the Paste Variables dialog box, enter the number of variables that you want to create.

Enter a prefix and starting number for the new variables.

Click OK.

The new variable names will consist of the specified prefix plus a sequential number
starting with the specified number.

Custom Variable Attributes

In addition to the standard variable attributes (for example, value labels, missing values,
measurement level), you can create your own custom variable attributes. Like standard
variable attributes, these custom attributes are saved with SPSS-format data files.

Creating Custom Variable Attributes

>

>

>

>

To create new custom attributes:

In Variable View of the Data Editor, from the menus choose:

Data
New Custom Attribute...

Drag and drop the variables to which you want to assign the new attribute to the
Selected Variables list.

Enter a name for the attribute. Attribute names must follow the same rules as variable
names. For more information, see Variable Names on p. 105.

Enter an optional value for the attribute. If you select multiple variables, the value is
assigned to all selected variables. You can leave this blank and then enter values for
each variable in Variable View.
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Figure 5-6
New Custom Attribute dialog box

Mew Custom Attribute

Select variable(s) For the new custom attribuke.

flncomel [Income1]
@&IncomeZ [Incomez]
gﬁlncomeS [Income3] 4
&)OwnHome [OwnHome]
&)MortgageType [Martq. ..
MaxIncome [MaxIncome]

Watiables! Selected variables:
& bae [Age] & pwalncome [Avglncome]
&b Gender [Gender]

Use Ctrl-a ko select all variables in the list,

Attribute name! Farmula

Attribute value: Mean(Incomel, Incomez, Incomes)

Display attribute in the Data Editor

’ Display Defined List of Attributes == ]

[ ok |[ Cancel ” Help

l

Display attribute in the Data Editor. Displays the attribute in Variable View of the Data
Editor. For information on controlling the display of custom attributes, see Displaying

and Editing Custom Variable Attributes below.

Display Defined List of Attributes. Displays a list of custom attributes already defined for
the dataset. Attribute names that begin with a dollar sign ($) are reserved attributes

that cannot be modified.

Displaying and Editing Custom Variable Attributes

Custom variable attributes can be displayed and edited in the Data Editor in Variable

View.



17

Data Editor

Figure 5-7
Custom variable attributes displayed in Variable View
& *Untitled3 [] - SPSS Data Editor =0
File Edit Wiew Data Transform  Analyze Graphs  Utilities Add-ons  Window Help
[AnswerFormat] | [DerivedFram) | [Formula] | [Motes]
1|Fill-in Empty L
2[Single select Empty 1
3[Fill-in Empty
4[Fill-in Empty
a[Fill-in Ermpty
6| Single select Empty
7 [Single select Empty
8| Computed value  |Aray.. mean(incomel, Income, Incomed) | Empty
A Computed value  |Aray.. max(incomel, Income2, Incomed) | Empty
10
11
12 v
4+ |\, Data View } Variable View f |<] | [

Custom variable attribute names are enclosed in square brackets.
Attribute names that begin with a dollar sign are reserved and cannot be modified.

A blank cell indicates that the attribute does not exist for that variable; the text
Empty displayed in a cell indicates that the attribute exists for that variable but no
value has been assigned to the attribute for that variable. Once you enter text in the
cell, the attribute exists for that variable with the value you enter.

m  The text Array... displayed in a cell indicates that this is an attribute array: an
attribute that contains multiple values. Click the button in the cell to display the
list of values.

To Display and Edit Custom Variable Attributes
» From the menus in Variable View of the Data Editor, choose:
View
Display Custom Attributes...

» Select (check) the custom variable attributes you want to display.
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Figure 5-8
Display Custom Attributes dialog box

Display Custom Attributes

Select custom attributes to be displaved
AnswerFormat

DerivedFrom

Farmula

Motes

Mew Attribute. .,

[ ok |[ Cancel ][ Help ]

New Attribute. This opens the New Custom Attribute dialog box, which you can use to
create additional custom variable attributes.

Variable Attribute Arrays

The text Array...—displayed in a cell for a custom variable attribute in Variable View or
in the Custom Variable Properties dialog box in Define Variable Properties—indicates

that this is an attribute array, an attribute that contains multiple values. For example,
you could have an attribute array that identifies all of the source variables used to

compute a derived variable. Click the button in the cell to display and edit the list
of values.
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Figure 5-9
Custom Attribute Array dialog box

Custom Attribute: Array

Array: DerivedFrom

1 Incomel Add
Z  Incomed
3 Incomes

OF ][ Cancel ][ Help

Entering Data

In Data View, you can enter data directly in the Data Editor. You can enter data in any
order. You can enter data by case or by variable, for selected areas or for individual
cells.

m  The active cell is highlighted.

®  The variable name and row number of the active cell are displayed in the top
left corner of the Data Editor.

B When you select a cell and enter a data value, the value is displayed in the cell
editor at the top of the Data Editor.

m  Data values are not recorded until you press Enter or select another cell.

m  To enter anything other than simple numeric data, you must define the variable
type first.

If you enter a value in an empty column, the Data Editor automatically creates a new
variable and assigns a variable name.
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Figure 5-10
Active dataset in Data View
Row number

Variable name Cell editor

[z Data Editor

File A£dt/View Data Transform  Analyze Graphs  Utliies  Window Help
|educ: 4 ]
id gender bdate educ jobcat salary ;I

1 1|m 0z/03m2 15 3 %57.000

2 2m 05/23/58 16 1 $40.200

3 3| 0726424 12 1 $21.4R0

4 q|f 0415447 g 1 $21.900

5 Blm 02/09/55 15 1 $45.000

4 Gl 0822458 NS 1 $32.100

7 7m 04/264/56 15 1 $36.000

g g|f 05/06/66 12 1 $21.900

9 q|f 01/23446 15 1 527900 -
4| » [\ Data view £ variable View | | _>|_AI

Active cell

To Enter Numeric Data

>

>

>

Select a cell in Data View.

Enter the data value. (The value is displayed in the cell editor at the top of the Data
Editor.)

To record the value, press Enter or select another cell.

To Enter Non-Numeric Data

>

vV v v Vv

Double-click a variable name at the top of the column in Data View or click the
Variable View tab.

Click the button in the Type cell for the variable.
Select the data type in the Variable Type dialog box.
Click OK.

Double-click the row number or click the Data View tab.
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» Enter the data in the column for the newly defined variable.

To Use Value Labels for Data Entry

» If value labels aren’t currently displayed in Data View, from the menus choose:
View
Value Labels

» Click the cell in which you want to enter the value.

» Choose a value label from the drop-down list.
The value is entered, and the value label is displayed in the cell.

Note: This process works only if you have defined value labels for the variable.

Data Value Restrictions in the Data Editor

The defined variable type and width determine the type of value that can be entered
in the cell in Data View.

m If you type a character that is not allowed by the defined variable type, the Data
Editor beeps and does not enter the character.

m  For string variables, characters beyond the defined width are not allowed.

m  For numeric variables, integer values that exceed the defined width can be entered,
but the Data Editor displays either scientific notation or asterisks in the cell to
indicate that the value is wider than the defined width. To display the value in
the cell, change the defined width of the variable. (Note: Changing the column
width does not affect the variable width.)

Editing Data

With the Data Editor, you can modify data values in Data View in many ways. You can:
m  Change data values.

Cut, copy, and paste data values.

Add and delete cases.

Add and delete variables.

Change the order of variables.
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Replacing or Modifying Data Values

To Delete the Old Value and Enter a New Value
» In Data View, double-click the cell. (The cell value is displayed in the cell editor.)
» Edit the value directly in the cell or in the cell editor.

» Press Enter (or move to another cell) to record the new value.

Cutting, Copying, and Pasting Data Values

You can cut, copy, and paste individual cell values or groups of values in the Data
Editor. You can:

®  Move or copy a single cell value to another cell.
Move or copy a single cell value to a group of cells.
Move or copy the values for a single case (row) to multiple cases.

Move or copy the values for a single variable (column) to multiple variables.

Move or copy a group of cell values to another group of cells.

Data Conversion for Pasted Values in the Data Editor

If the defined variable types of the source and target cells are not the same, the Data
Editor attempts to convert the value. If no conversion is possible, the system-missing
value is inserted in the target cell.

Converting numeric or date into string. Numeric (for example, numeric, dollar, dot,
or comma) and date formats are converted to strings if they are pasted into a string
variable cell. The string value is the numeric value as displayed in the cell. For
example, for a dollar format variable, the displayed dollar sign becomes part of the
string value. Values that exceed the defined string variable width are truncated.

Converting string into numeric or date. String values that contain acceptable characters
for the numeric or date format of the target cell are converted to the equivalent numeric
or date value. For example, a string value of 25/12/91 is converted to a valid date

if the format type of the target cell is one of the day-month-year formats, but the
value is converted to system-missing if the format type of the target cell is one of the
month-day-year formats.
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Converting date into numeric. Date and time values are converted to a number of seconds
if the target cell is one of the numeric formats (for example, numeric, dollar, dot, or
comma). Because dates are stored internally as the number of seconds since October
14, 1582, converting dates to numeric values can yield some extremely large numbers.
For example, the date 10/29/91 is converted to a numeric value of 12,908,073,600.

Converting numeric into date or time. Numeric values are converted to dates or times if
the value represents a number of seconds that can produce a valid date or time. For
dates, numeric values that are less than 86,400 are converted to the system-missing
value.

Inserting New Cases

Entering data in a cell in a blank row automatically creates a new case. The Data
Editor inserts the system-missing value for all other variables for that case. If there are
any blank rows between the new case and the existing cases, the blank rows become
new cases with the system-missing value for all variables. You can also insert new
cases between existing cases.

To Insert New Cases between Existing Cases

» In Data View, select any cell in the case (row) below the position where you want
to insert the new case.

» From the menus choose:
Edit
Insert Cases

A new row is inserted for the case, and all variables receive the system-missing value.

Inserting New Variables

Entering data in an empty column in Data View or in an empty row in Variable View
automatically creates a new variable with a default variable name (the prefix var and a
sequential number) and a default data format type (numeric). The Data Editor inserts
the system-missing value for all cases for the new variable. If there are any empty
columns in Data View or empty rows in Variable View between the new variable

and the existing variables, these rows or columns also become new variables with
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the system-missing value for all cases. You can also insert new variables between
existing variables.

To Insert New Variables between Existing Variables

» Select any cell in the variable to the right of (Data View) or below (Variable View)
the position where you want to insert the new variable.

» From the menus choose:
Edit
Insert Variable

A new variable is inserted with the system-missing value for all cases.

To Move Variables

» To select the variable, click the variable name in Data View or the row number for
the variable in Variable View.

» Drag and drop the variable to the new location.

» If you want to place the variable between two existing variables: In Data View, drop
the variable on the variable column to the right of where you want to place the variable,
or in Variable View, drop the variable on the variable row below where you want to
place the variable.

To Change Data Type

You can change the data type for a variable at any time by using the Variable Type
dialog box in Variable View. The Data Editor will attempt to convert existing values
to the new type. If no conversion is possible, the system-missing value is assigned.
The conversion rules are the same as the rules for pasting data values to a variable
with a different format type. If the change in data format may result in the loss of
missing-value specifications or value labels, the Data Editor displays an alert box and
asks whether you want to proceed with the change or cancel it.
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Go to Case

The Go to Case dialog box allows you to go to the specified case (row) number
in the Data Editor.

Figure 5-1
Go to Case dialog box

i Go to Case

Case Mumber: |3?2

ok |  close | Help |

To Find a Case in the Data Editor
» Make the Data Editor the active window.
» From the menus choose:
Data

Go to Case...

» In the Go to Case dialog box, enter the Data Editor row number for the case.

Case Selection Status in the Data Editor

If you have selected a subset of cases but have not discarded unselected cases,

unselected cases are marked in the Data Editor with a diagonal line (slash) through the
row number.
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Figure 5-12
Filtered cases in the Data Editor
Data Editor !Elm
File Edit “iew Data Transform Analyze Graphs  Utiites  Window Help
|id -1 |‘I1
id gender bdate educ jobcat ;I
Filtered 1 1|m n2/n3m2 15 3
(excluded) 2 2|m 05/23/58 16 1
cases ] 3| 07/26/29 12 1
| 4|t 04115/47 il 1
5 5lm 02/09/m5 15 1
£ Elm Daf22/ma 15 1
7 7lm 04/26/56 15 1
\ g 8|t 05/06/ER 12 1
| 9| 01/23/46 15 1=
4 [ |\Data view { Variable view 7 4] | iLa 7

Data Editor Display Options

The View menu provides several display options for the Data Editor:
Fonts. This option controls the font characteristics of the data display.
Grid Lines. This option toggles the display of grid lines.

Value Labels. This option toggles between the display of actual data values and
user-defined descriptive value labels. This option is available only in Data View.

Using Multiple Views

In Data View, you can create multiple views (panes) by using the splitters that are
located above the horizontal scroll bar and to the right of the vertical scroll bar.
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Figure 5-13
Data View pane splitters
bankZ.sav - SP5S Data Editor |_ (O] x|
File Edit ‘iew Data Transform  Analpze Graphs  Utiliies  Add-ons  WwWindow
Help
Z(=|S| 8| o] =[] @l FlE= BlelE %o
|18 salbegin | 27510
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1 1|m 02/03/1952 15 3 $57 000 p27 [
2l 2im 05231958 16 1 §40,200 EAE
3| 3f 07 /261929 12 1 $21,450 w2l
4| 4|f 04/15/1947 8 1 $21 900 B30 Pane
5 5|m 02091985 15 1] 45000 521 splitiers
Bl G|m 08221958 15 1 $32,100 B3l
7l 7im 04261956 15 1 $36,000 $a.
= (=53 [T e g 17 1 T4 Qi [
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|SPS5 Processor is ready 4

You can also use the Window menu to insert and remove pane splitters. To insert
splitters:

» In Data View, from the menus choose:

Window
Split

Splitters are inserted above and to the left of the selected cell.

m [f the top left cell is selected, splitters are inserted to divide the current view
approximately in half, both horizontally and vertically.

m  [f any cell other than the top cell in the first column is selected, a horizontal pane
splitter is inserted above the selected cell.

m  [f any cell other than the first cell in the top row is selected, a vertical pane splitter
is inserted to the left of the selected cell.

Data Editor Printing

A data file is printed as it appears on the screen.

®  The information in the currently displayed view is printed. In Data View, the data
are printed. In Variable View, data definition information is printed.
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®  Grid lines are printed if they are currently displayed in the selected view.

B Value labels are printed in Data View if they are currently displayed. Otherwise,
the actual data values are printed.

Use the View menu in the Data Editor window to display or hide grid lines and toggle
between the display of data values and value labels.

To Print Data Editor Contents
» Make the Data Editor the active window.
» Click the tab for the view that you want to print.
» From the menus choose:

File
Print...
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Working with Multiple Data
Sources

Starting with SPSS 14.0, SPSS can have multiple data sources open at the same time,
making it easier to:

Switch back and forth between data sources.

Compare the contents of different data sources.

Copy and paste data between data sources.

Create multiple subsets of cases and/or variables for analysis.

Merge multiple data sources from various data formats (for example, spreadsheet,
database, text data) without saving each data source in SPSS format first.

129
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Basic Handling of Multiple Data Sources

Figure 6-1
Two data sources open at same time
DataSet1 [demo.sav] - SPSS Data Editor BE=]
File Edit Wew Data Transform Analvze Graphs  Utilities  Add-ons  wWindow  Help
11 age o)
age | marital | address | income | inccat | car |
1 a5 1 12 72.00 3.00 36.20
2 a6 0 29 153.00 4.00 76.90
__| =l DataSet2 [survey_sample.sav] - SPSS Data Editor =/o/Ed
__|| File Edit “iew Data Transform Analvze Graphs Utillities Add-ons  wWindow  Help
—|12:id 12
] id | wrkstat | marital | childs | age | educ | [a]
— 1 1 1 3 2 B0 12 &2
— 2 2 2 ] 0 27 17
< 3 3 1 1 2 3 12
4 4 1 ] 0 21 13
5 ] 1 ] 0 35 1B
B 3 1 3 1 33 16
7 7 1 4 0 43 12
g g 1 5 0 29 13 o
«|[r \Bata\ﬁew Wariahle View\?,’ <] B o T |

Each data source that you open is displayed in a new Data Editor window.
B Any previously open data sources remain open and available for further use.
B When you first open a data source, it automatically becomes the active dataset.

B You can change the active dataset simply by clicking anywhere in the Data Editor
window of the data source that you want to use or by selecting the Data Editor
window for that data source from the Window menu.
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B Only the variables in the active dataset are available for analysis.

Figure 6-2
Variable list containing variables in the active dataset
DataSet1 [demo.sav] - SPSS Data Editor =/
Ele Edit View Data Transform  Analvee Graphs  Utilities  Add-gns  Window  Help
11 age a5
age | marital | address | income | inccat | car | A
1 55 1 12 72.00 3.00 36.20
2 56 0 29 153.00 4.00 76.80
DataSet2 [survey_sample.sav] - SPSS Data Editor =/
File Edit Wew Data Transform Anakveze Graphs  Utilities  Add-ons  Window Help
12 0 id 12
| id | wrkstat | marital | childs | age | educ | Al
11 1 1 ! ] &0 12| =
|1 Frequencies o7 17
5 S A Y aniahlelz): 3R 12
&)wrkstat § 2 13
&marital £ 16
& chids EE] 16
& aae |I| 43 12
educ 29 13 ol
&paeduc (2] |
ymaeduc —
& d]
Dizplay frequency tables
lﬁtatistics...] [ Charts... ] [ Eorrat... ]

You cannot change the active dataset when any dialog box that accesses the data is

open (including all dialog boxes that display variable lists).

At least one Data Editor window must be open during a session. When you close

the last open Data Editor window, SPSS automatically shuts down, prompting
you to save changes first.

Note: If you use command syntax to open data sources (for example, GET FILE, GET
DATA), you need to name each dataset explicitly in order to have more than one data
source open at the same time.
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Copying and Pasting Information between Datasets

You can copy both data and variable definition attributes from one dataset to another
dataset in basically the same way that you copy and paste information within a single
data file.

m  Copying and pasting selected data cells in Data View pastes only the data values,
with no variable definition attributes.

m  Copying and pasting an entire variable in Data View by selecting the variable name
at the top of the column pastes all of the data and all of the variable definition
attributes for that variable.

m  Copying and pasting variable definition attributes or entire variables in Variable
View pastes the selected attributes (or the entire variable definition) but does not
paste any data values.

Renaming Datasets

When you open a data source through the menus and dialog boxes, each data source
is automatically assigned a dataset name of DataSetn, where n is a sequential integer
value, and when you open a data source using command syntax, no dataset name is
assigned unless you explicitly specify one with DATASET NaAME. To provide more
descriptive dataset names:

» From the menus in the Data Editor window for the dataset whose name you want
to change choose:
File
Rename Dataset...

» Enter a new dataset name that conforms to SPSS variable naming rules. For more
information, see Variable Names in Chapter 5 on p. 105.
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Data Preparation

Once you’ve opened a data file or entered data in the Data Editor, you can start creating
reports, charts, and analyses without any additional preliminary work. However, there

are some additional data preparation features that you may find useful, including the
ability to:

B Assign variable properties that describe the data and determine how certain values
should be treated.

m  Identify cases that may contain duplicate information and exclude those cases from
analyses or delete them from the data file.

m  Create new variables with a few distinct categories that represent ranges of values
from variables with a large number of possible values.

Variable Properties

Data entered in the Data Editor in Data View or read into SPSS from an external file
format (such as an Excel spreadsheet or a text data file) lack certain variable properties
that you may find very useful, including:

m  Definition of descriptive value labels for numeric codes (for example, 0 = Male
and 1 = Female).

m Identification of missing values codes (for example, 99 = Not applicable).

B Assignment of measurement level (nominal, ordinal, or scale).
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All of these variable properties (and others) can be assigned in Variable View in the
Data Editor. There are also several utilities that can assist you in this process:

m  Define Variable Properties can help you define descriptive value labels and missing
values. This is particularly useful for categorical data with numeric codes used for
category values.

m  Copy Data Properties provides the ability to use an existing SPSS-format data
file as a template for file and variable properties in the current data file. This is
particularly useful if you frequently use external-format data files that contain
similar content (such as monthly reports in Excel format).

Defining Variable Properties

Define Variable Properties is designed to assist you in the process of creating

descriptive value labels for categorical (nominal, ordinal) variables. Define Variable
Properties:

m  Scans the actual data values and lists all unique data values for each selected
variable.

®m [dentifies unlabeled values and provides an “auto-label” feature.

®  Provides the ability to copy defined value labels from another variable to the
selected variable or from the selected variable to multiple additional variables.

Note: To use Define Variable Properties without first scanning cases, enter 0 for the
number of cases to scan.

To Define Variable Properties
» From the menus choose:

Data
Define Variable Properties...
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Figure 7-1
Initial dialog box for selecting variables to define

Define Yariable Properties

U ze thiz facility to label variable values and zet other properties after
zcanning the data.

Select the wariables to scan. Thep should be categorical [nominal
or ordinal) for best results. vou can change the measurement level
sefting in the nest panel

Wariables: Wariables to Scan:
&Call waiting [zall... 6 fﬂwns computer [ow...
& Caller 10 [calid] & Dwns fax machine [ .
& Gender [gender] fﬂwns LA [awnpdal
&Household inco... fﬂwns steren/CD pl..
dj Income categor... [ 3 @ﬁ Oz TV [ownby]
flntemet [irkermet] || fﬂwns YR [owhwer]

&Job zatizfaction ...
fLevel of educati...
fh‘larital statuz [m...
&Multiple lines [m...

fNewspaper sub...
A bk kel

[ Limit nurber of cazes scanned to:

[ Limit number of values displayed to:

» Select the numeric or short string variables for which you want to create value labels
or define or change other variable properties, such as missing values or descriptive
variable labels.

Note: Long string variables (string variables with a defined width of more than eight
characters) are not displayed in the variable list. Long string variables cannot have
defined value labels or missing values categories.

» Specify the number of cases to scan to generate the list of unique values. This is
particularly useful for data files with a large number of cases for which a scan of the
complete data file might take a significant amount of time.

» Specify an upper limit for the number of unique values to display. This is primarily
useful to prevent listing hundreds, thousands, or even millions of values for scale
(continuous interval, ratio) variables.

» Click Continue to open the main Define Variable Properties dialog box.
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>

Select a variable for which you want to create value labels or define or change other
variable properties.

Enter the label text for any unlabeled values that are displayed in the Value Label grid.

If there are values for which you want to create value labels but those values are not
displayed, you can enter values in the Value column below the last scanned value.

Repeat this process for each listed variable for which you want to create value labels.

Click OK to apply the value labels and other variable properties.

Defining Value Labels and Other Variable Properties

Figure 7-2
Define Variable Properties, main dialog box
Define ¥ariable Properties
Scanned Wariable List Current ‘ariable: ownfan Label Oz Fan machine
.| M| “arable Measurement Level | Ordinal il Tvpe | Wumeric ||
Ol owec Urlabeled valime S e
§ omnfan
% g Dwnpja Yalue Label grid: o Enter or edit labels in the gid. v'ou can enter additional values at the battom.
Jarate?
O] gl vty Changed | Missing | Count | Value Label
3l owrver 1 0 [l 5198 0 Mo
2 D 1202 1|¥es
3 i 99 |Mo answwver
4 | O O
] >
Copy Properties Urlabeled Y alues
Cases scanned: Erom énather Variable. . ] [ To Other Wariables... ] ’ Automatic Labels ]
Wl list lirit: I ak. ] ’ Paste ] [ Resat ] [ Cancel ] ’ Help ]

The Define Variable Properties main dialog box provides the following information
for the scanned variables:

Scanned Variable List. For each scanned variable, a check mark in the Unlabeled (U.)
column indicates that the variable contains values without assigned value labels.
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To sort the variable list to display all variables with unlabeled values at the top of
the list:

Click the Unlabeled column heading under Scanned Variable List.

You can also sort by variable name or measurement level by clicking the corresponding
column heading under Scanned Variable List.

Value Label Grid

m Label. Displays any value labels that have already been defined. You can add or
change labels in this column.

®  Value. Unique values for each selected variable. This list of unique values is based
on the number of scanned cases. For example, if you scanned only the first 100
cases in the data file, then the list reflects only the unique values present in those
cases. If the data file has already been sorted by the variable for which you want to
assign value labels, the list may display far fewer unique values than are actually
present in the data.

®  Count. The number of times each value occurs in the scanned cases.

m  Missing. Values defined as representing missing data. You can change the missing
values designation of the category by clicking the check box. A check indicates
that the category is defined as a user-missing category. If a variable already
has a range of values defined as user-missing (for example, 90-99), you cannot
add or delete missing values categories for that variable with Define Variable
Properties. You can use Variable View in the Data Editor to modify the missing
values categories for variables with missing values ranges. For more information,
see Missing Values in Chapter 5 on p. 112.

m  Changed. Indicates that you have added or changed a value label.

Note: If you specified 0 for the number of cases to scan in the initial dialog box, the
Value Label grid will initially be blank, except for any preexisting value labels and/or
defined missing values categories for the selected variable. In addition, the Suggest
button for the measurement level will be disabled.

Measurement Level. Value labels are primarily useful for categorical (nominal and
ordinal) variables, and some procedures treat categorical and scale variables differently;
s0 it is sometimes important to assign the correct measurement level. However, by
default, all new numeric variables are assigned the scale measurement level. Thus,
many variables that are in fact categorical may initially be displayed as scale.
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If you are unsure of what measurement level to assign to a variable, click Suggest.

Copy Properties. You can copy value labels and other variable properties from another
variable to the currently selected variable or from the currently selected variable to one
or more other variables.

Unlabeled Values. To create labels for unlabeled values automatically, click Automatic
Labels.

Variable Label and Display Format

You can change the descriptive variable label and the display format.
B You cannot change the variable’s fundamental type (string or numeric).
m  For string variables, you can change only the variable label, not the display format.

®  For numeric variables, you can change the numeric type (such as numeric, date,
dollar, or custom currency), width (maximum number of digits, including any
decimal and/or grouping indicators), and number of decimal positions.

®  For numeric date format, you can select a specific date format (such as
dd-mm-yyyy, mm/dd/yy, and yyyyddd)

®  For numeric custom format, you can select one of five custom currency formats
(CCA through CCE). For more information, see Currency Options in Chapter
45 on p. 636.

B An asterisk is displayed in the Value column if the specified width is less than the
width of the scanned values or the displayed values for preexisting defined value
labels or missing values categories.

B A period (.) is displayed if the scanned values or the displayed values for
preexisting defined value labels or missing values categories are invalid for the
selected display format type. For example, an internal numeric value of less than
86,400 is invalid for a date format variable.

Assigning the Measurement Level

When you click Suggest for the measurement level in the Define Variable Properties
main dialog box, the current variable is evaluated based on the scanned cases and
defined value labels, and a measurement level is suggested in the Suggest Measurement
Level dialog box that opens. The Explanation area provides a brief description of the
criteria used to provide the suggested measurement level.
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Figure 7-3
Suggest Measurement Level dialog box

Define Yariable Properties: Suggest Measurement Level

W ariable: Wnpc

Currert Meazurement Level | §oale

Suggested Level: Ordinal or Morminal

(&) Ordinal () Mominal

Explanation;  ownpc has only small, nonnegative, integer values and
does not have a large numer of different values.

& nominal level is one where the vanable values do not have a natural
ranking, for example names of countries.

An ordingl level is one where the vanable values have a natural order
but differences between values are not meaningful, for example,
importance of a political position coded "'low"’, "medium'’, and "high"".
A geale level is one where the differences between variable values are
comparable, for example, age it pears.

The suggested meazurement level iz bazed on empirical rules and iz not
a substitute far uzer judgrnent.

SPSS uses the meazurement level in some cases to determine whether
the wariable defines categories in a table or graph or iz to be zummarized.

Note: Values defined as representing missing values are not included in the evaluation
for measurement level. For example, the explanation for the suggested measurement
level may indicate that the suggestion is in part based on the fact that the variable
contains no negative values, whereas it may in fact contain negative values—but those
values are already defined as missing values.

» Click Continue to accept the suggested level of measurement or Cancel to leave the
measurement level unchanged.

Custom Variable Attributes

The Attributes button in Define Variable Properties opens the Custom Variable
Attributes dialog box. In addition to the standard variable attributes, such as value
labels, missing values, and measurement level, you can create your own custom
variable attributes. Like standard variable attributes, these custom attributes are saved
with SPSS-format data files.
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Figure 7-4
Custom Variable Attributes
Custom Variable Attributes

Custom Attributes For Avglncome

Hame |\J’alue |
AnsverFormat Computed value

DerivedFrom Avray... -
Farmula

mean(income?, Income2, Incame3)
Maotes

L Continue |[ Cancel ][ Help

Name. Attribute names must follow the same rules as variable names. For more
information, see Variable Names in Chapter 5 on p. 105.

Value. The value assigned to the attribute for the selected variable.

B Attribute names that begin with a dollar sign are reserved and cannot be modified.

m  The text Array..., displayed in a Value cell, indicates that this is an attribute

array, an attribute that contains multiple values. Click the button in the cell to
display the list of values.

Copying Variable Properties

The Apply Labels and Level dialog box is displayed when you click From Another
Variable or To Other Variables in the Define Variable Properties main dialog box. It
displays all of the scanned variables that match the current variable’s type (numeric or
string). For string variables, the defined width must also match.
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Figure 7-5
Apply Labels and Level dialog box

Apply Labels and Level to

Select the vanables that the current [T~
vanable's value labels, -
measuremnent level, missing value

definition, and farmat will be copied

to. [Walue label: and mizzing walues
are merged

Wanables:

Qs Fax machine [ow...
Owinz PDA [ownpda)
Oz steren/CO player...
Oz TV [owenty]

Owanz %W CR [ownwver]

Select a single variable from which to copy value labels and other variable properties
(except variable label).

or
Select one or more variables to which to copy value labels and other variable properties.

Click Copy to copy the value labels and the measurement level.

m  Existing value labels and missing value categories for target variable(s) are not
replaced.

m  Value labels and missing value categories for values not already defined for the
target variable(s) are added to the set of value labels and missing value categories
for the target variable(s).

The measurement level for the target variable(s) is always replaced.

If either the source or target variable has a defined range of missing values, missing
values definitions are not copied.
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Multiple Response Sets

Custom Tables and the Chart Builder support a special kind of “variable” called a
multiple response set. Multiple response sets aren’t really “variables” in the normal
sense. You can’t see them in the Data Editor, and other procedures don’t recognize
them. Multiple response sets use multiple variables to record responses to questions
where the respondent can give more than one answer. Multiple response sets are
treated like categorical variables, and most of the things you can do with categorical
variables, you can also do with multiple response sets.

Multiple response sets are constructed from multiple variables in the data file. A
multiple response set is a special construct within an SPSS-format data file. You can
define and save multiple response sets in an SPSS-format data file, but you cannot
import or export multiple response sets from/to other file formats. (You can copy
multiple response sets from other SPSS data files using Copy Data Properties, which
is accessed from the Data menu in the Data Editor window. For more information,
see Copying Data Properties on p. 145.)

Defining Multiple Response Sets

>

To define multiple response sets:

From the menus, choose:

Data
Define Multiple Response Sets...
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Define Multiple Response Sets dialog box

Define Multiple Response Sets

Set Definition

,{lCUnfidence inb.. [»] Hariables in Set:

Sets defined here are not available in
the Multiple Responze Frequencies

l{l Confidence in m..
Confidence in e
,{I Confidence in pr...

,{I Confidence in te...
I{IAge category [a.
H:I Murnber of childr

@ Car maker, most...
&) Car maker, seco...

&]l

&) Get news from inter...
&b Get news from radio...
&) Get news from telew. .
Corfidence in m... 4 &b Get news from new...
& Gt ews from new...

and Crosstabs procedurs

ult. Response Sets:

Fethmult
Emitzars
$mltnews

“ariable Coding

() Dichatomies
() Categories

Counted Walue: 1

Categaory Labels Source
() Variable labels
() Labels of gounted value

Set Name: | mitnews

SetLabet  |Mews sources

Eok J[ Paste |[ Resst

][ Cancel ” Help ]
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Select two or more variables. If your variables are coded as dichotomies, indicate
which value you want to have counted.

Enter a unique name for each multiple response set. The name can be up to 63 bytes
long. A dollar sign is automatically added to the beginning of the set name.

Enter a descriptive label for the set. (This is optional.)

Click Add to add the multiple response set to the list of defined sets.

Dichotomies

A multiple dichotomy set typically consists of multiple dichotomous variables:
variables with only two possible values of a yes/no, present/absent, checked/not
checked nature. Although the variables may not be strictly dichotomous, all of the
variables in the set are coded the same way, and the Counted Value represents the
positive/present/checked condition.
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For example, a survey asks the question, “Which of the following sources do you
rely on for news?”” and provides five possible responses. The respondent can indicate
multiple choices by checking a box next to each choice. The five responses become
five variables in the data file, coded 0 for No (not checked) and 1 for Yes (checked).
In the multiple dichotomy set, the Counted Value is 1.

The sample data file survey sample.sav (in the tutorial/sample_files directory of the
installation directory) already has three defined multiple response sets. $mitnews is a
multiple dichotomy set.

» Select (click) $mitnews in the Mult. Response Sets list.

This displays the variables and settings used to define this multiple response set.

m  The Variables in Set list displays the five variables used to construct the multiple
response set.

m  The Variable Coding group indicates that the variables are dichotomous.

®  The Counted Value is 1.
» Select (click) one of the variables in the Variables in Set list.
» Right-click the variable and select Variable Information from the pop-up context menu.

» In the Variable Information window, click the arrow on the Value Labels drop-down
list to display the entire list of defined value labels.

Figure 7-7
Variable information for multiple dichotomy source variable

Yariable Information E

Marne: newss

Label: Get news from internet

Measurement:  Mominal

alue Labels: 0 Mo ;I

The value labels indicate that the variable is a dichotomy with values of 0 and 1,
representing No and Yes, respectively. All five variables in the list are coded the
same way, and the value of 1 (the code for Yes) is the counted value for the multiple
dichotomy set.
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Categories

A multiple category set consists of multiple variables, all coded the same way, often
with many possible response categories. For example, a survey item states, “Name up
to three nationalities that best describe your ethnic heritage.” There may be hundreds
of possible responses, but for coding purposes the list is limited to the 40 most
common nationalities, with everything else relegated to an “other” category. In the
data file, the three choices become three variables, each with 41 categories (40 coded
nationalities and one “other” category).

In the sample data file, $ethmult and Smitcars are multiple category sets.

Category Label Source

For multiple dichotomies, you can control how sets are labeled.

m Variable labels. Uses the defined variable labels (or variable names for variables
without defined variable labels) as the set category labels. For example, if all of
the variables in the set have the same value label (or no defined value labels) for
the counted value (for example, Yes), then you should use the variable labels as
the set category labels.

m Labels of counted values. Uses the defined value labels of the counted values as
set category labels. Select this option only if all variables have a defined value
label for the counted value and the value label for the counted value is different
for each variable.

m  Use variable label as set label. If you select Label of counted values, you can also
use the variable label for the first variable in the set with a defined variable label as
the set label. If none of the variables in the set have defined variable labels, the
name of the first variable in the set is used as the set label.

Copying Data Properties

The Copy Data Properties Wizard provides the ability to use an external SPSS data file
as a template for defining file and variable properties in the active dataset. You can
also use variables in the active dataset as templates for other variables in the active
dataset. You can:

m  Copy selected file properties from an external data file or open dataset to the active
dataset. File properties include documents, file labels, multiple response sets,
variable sets, and weighting.
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Copy selected variable properties from an external data file or open dataset to
matching variables in the active dataset. Variable properties include value labels,
missing values, level of measurement, variable labels, print and write formats,
alignment, and column width (in the Data Editor).

Copy selected variable properties from one variable in either an external data file,
open dataset, or the active dataset to many variables in the active dataset.

Create new variables in the active dataset based on selected variables in an external
data file or open dataset.

When copying data properties, the following general rules apply:

If you use an external data file as the source data file, it must be an SPSS-format
data file.

If you use the active dataset as the source data file, it must contain at least one
variable. You cannot use a completely blank active dataset as the source data file.

Undefined (empty) properties in the source dataset do not overwrite defined
properties in the active dataset.

Variable properties are copied from the source variable only to target variables of
a matching type—string (alphanumeric) or numeric (including numeric, date,
and currency).

Note: Copy Data Properties replaces Apply Data Dictionary, formerly available on
the File menu.

To Copy Data Properties

» From the menus in the Data Editor window choose:

Data
Copy Data Properties...
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Figure 7-8
Copy Data Properties Wizard: Step 1

Copy Data Properties - Step 1 of

Welcome to the Copy Data Properties ‘Wizard.

Copy Data Properties can copy selected variable and dataset properties from an open dataset
or external SPSS data file to the active datazet.

You can aleo copy properties from ohe variable to another within the active dataset.

[ata properties are copied but not data values.,

Chooze the source of the propertiez

(%) &n external SPSS data file

C:\Program FileshSPS5145Tutonalhsample_files\demo. sav

() The active datazet [ smalldemo.sav [D1ataSet?] )

[ Hest: | ’ Finish ][ Cancel ] [ Help ]

» Select the data file with the file and/or variable properties that you want to copy. This
can be a currently open dataset, an external SPSS-format data file, or the active dataset.

» Follow the step-by-step instructions in the Copy Data Properties Wizard.

Selecting Source and Target Variables

In this step, you can specify the source variables containing the variable properties that
you want to copy and the target variables that will receive those variable properties.
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Figure 7-9
Copy Data Properties Wizard: Step 2

Copy Data Properties - Step 2 of

Copy data properties - Choose source and target vanables

(%) Apply properties from selected source dataset wariables to matching active dataset wariables.
LCreate matching wariables in the active dataszet if they do not already exist.

() Aspply properties from a single source variable o selected active dataset variables of the same type.

() Apply dataset properties only - no variable selection

@ A variable matches if the name and basic twpe [humeric or string and string length] are the zame.

The particular properties to apply will be specified on the follawing panels.
Right click on a wariable to see its properties.

Select the wariables in the source list whoze properties will be copied to the matching warisbles or that
should be created in the active datazet if they do not already exist. Use Chrl-click to madify the

zelection.
Source D ataset Yanables: Matching dctive D ataset
fﬁge in years [age] -~ fage [age]
fMarital shatusz [rarital] fmarital [rrarital]
g&\’ears at current addr. .. faddress [address]

fHousehold income in ...
d:llnu:ome categorn in th..
g&Price of primary vehicl...
d:IF'rimar_l,l vehicle price ..
fLevel of education [2d]
g?i\’ears with current em... s

Selected variables: 29 F atching wariables: 3
Wariables to be created: 26

[ < Back ]| Mext> | [ Finish ][ Cancel ] [ Help ]

Apply properties from selected source dataset variables to matching active dataset
variables. Variable properties are copied from one or more selected source variables
to matching variables in the active dataset. Variables “match” if both the variable
name and type (string or numeric) are the same. For string variables, the defined

length must also be the same. By default, only matching variables are displayed in the
two variable lists.

m Create matching variables in the active dataset if they do not already exist. This
updates the source list to display all variables in the source data file. If you select
source variables that do not exist in the active dataset (based on variable name),
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new variables will be created in the active dataset with the variable names and
properties from the source data file.

If the active dataset contains no variables (a blank, new dataset), all variables in the
source data file are displayed and new variables based on the selected source variables
are automatically created in the active dataset.

Apply properties from a single source variable to selected active dataset variables of the
same type. Variable properties from a single selected variable in the source list can
be applied to one or more selected variables in the active dataset list. Only variables
of the same type (numeric or string) as the selected variable in the source list are
displayed in the active dataset list. For string variables, only strings of the same
defined length as the source variable are displayed. This option is not available if
the active dataset contains no variables.

Note: You cannot create new variables in the active dataset with this option.

Apply dataset properties only—no variable selection. Only file properties (for example,
documents, file label, weight) will be applied to the active dataset. No variable
properties will be applied. This option is not available if the active dataset is also
the source data file.

Choosing Variable Properties to Copy

You can copy selected variable properties from the source variables to the target
variables. Undefined (empty) properties in the source variables do not overwrite
defined properties in the target variables.
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Figure 7-10
Copy Data Properties Wizard: Step 3

Copy Data Properties - Step 3o0f 5

Copy Data Properties - Choose Variable Properties to Copy
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Empty properties in source wanables will never replace target vanable properties.
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[Drata Editor Colurnn "Width

[ < Back ]| Mext> | ’ Finish ][ Cancel ] [ Help ]

Value Labels. Value labels are descriptive labels associated with data values. Value
labels are often used when numeric data values are used to represent non-numeric
categories (for example, codes of 1 and 2 for Male and Female). You can replace or
merge value labels in the target variables.

B Replace deletes any defined value labels for the target variable and replaces them
with the defined value labels from the source variable.

B Merge merges the defined value labels from the source variable with any existing
defined value label for the target variable. If the same value has a defined value
label in both the source and target variables, the value label in the target variable
is unchanged.
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Custom Attributes. User-defined custom variable attributes. For more information, see
Custom Variable Attributes in Chapter 5 on p. 115.

B Replace deletes any custom attributes for the target variable and replaces them
with the defined attributes from the source variable.

®  Merge merges the defined attributes from the source variable with any existing
defined attributes for the target variable.

Missing Values. Missing values are values identified as representing missing data (for
example, 98 for Do not know and 99 for Not applicable). Typically, these values also
have defined value labels that describe what the missing value codes stand for. Any
existing defined missing values for the target variable are deleted and replaced with the
defined missing values from the source variable.

Variable Label. Descriptive variable labels can contain spaces and reserved characters
not allowed in variable names. If you’re copying variable properties from a single
source variable to multiple target variables, you might want to think twice before
selecting this option.

Measurement Level. The measurement level can be nominal, ordinal, or scale. For
those procedures that distinguish between different measurement levels, nominal and
ordinal are both considered categorical.

Formats. For numeric variables, this controls numeric type (such as numeric, date, or
currency), width (total number of displayed characters, including leading and trailing
characters and decimal indicator), and number of decimal places displayed. This
option is ignored for string variables.

Alignment. This affects only alignment (left, right, center) in Data View in the Data
Editor.

Data Editor Column Width. This affects only column width in Data View in the Data
Editor.

Copying Dataset (File) Properties

You can apply selected, global dataset properties from the source data file to the active
dataset. (This is not available if the active dataset is the source data file.)
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Figure 7-1
Copy Data Properties Wizard: Step 4

Copy Data Properties - Step 4 of

Copy Data Properties - Choose Dataset Properties to Copy

Select the datazet properties to be copied to the warking data file.

For zome properties, pou can chooze to replace the existing values or to merge them with source
@ properties az far a5 pozsible. When merging, the working data file has priority,

Multiple Responze Sets and Yariable Sets that would be invalid in the working data file will be
ignored.

D atazet Properties to Copy
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Documents (=) Beplace () Merge
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[ < Back ]| Mext> | ’ Finish ][ Cancel ] [ Help ]

Multiple Response Sets. Applies multiple response set definitions from the source data
file to the active dataset. (Note: Multiple response sets are currently used only by the
Chart Builder and the Tables add-on component.)

m  Multiple response sets in the source data file that contain variables that do not exist
in the active dataset are ignored unless those variables will be created based on
specifications in step 2 (Selecting Source and Target Variables) in the Copy Data
Properties Wizard.
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Replace deletes all multiple response sets in the active dataset and replaces them
with the multiple response sets from the source data file.

Merge adds multiple response sets from the source data file to the collection of
multiple response sets in the active dataset. If a set with the same name exists in
both files, the existing set in the active dataset is unchanged.

Variable Sets. Variable sets are used to control the list of variables that are displayed in
dialog boxes. Variable sets are defined by selecting Define Sets from the Utilities menu.

Sets in the source data file that contain variables that do not exist in the active
dataset are ignored unless those variables will be created based on specifications in
step 2 (Selecting Source and Target Variables) in the Copy Data Properties Wizard.

Replace deletes any existing variable sets in the active dataset, replacing them with
variable sets from the source data file.

Merge adds variable sets from the source data file to the collection of variable sets
in the active dataset. If a set with the same name exists in both files, the existing
set in the active dataset is unchanged.

Documents. Notes appended to the data file via the DOCUMENT command.

Replace deletes any existing documents in the active dataset, replacing them with
the documents from the source data file.

Merge combines documents from the source and active dataset. Unique documents
in the source file that do not exist in the active dataset are added to the active
dataset. All documents are then sorted by date.

Custom Attributes. Custom data file attributes, typically created with the DATAFILE
ATTRIBUTE command in command syntax.

Replace deletes any existing custom data file attributes in the active dataset,
replacing them with the data file attributes from the source data file.

Merge combines data file attributes from the source and active dataset. Unique
attribute names in the source file that do not exist in the active dataset are added to
the active dataset. If the same attribute name exists in both data files, the named
attribute in the active dataset is unchanged.

Weight Specification. Weights cases by the current weight variable in the source data
file if there is a matching variable in the active dataset. This overrides any weighting
currently in effect in the active dataset.
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File Label. Descriptive label applied to a data file with the FILE LABEL command.
Results
Figure 7-12
Copy Data Properties Wizard: Step 5
Copy Data Properties - Step D of 5
Finish

“anahles to which properties will be applied: 0
Yanables to be copied: 0

Datazet properties to be copied: 5

(%) Execute the command

() Paste the command into & syhtas window

| Firizh | ’ Cancel ] [ Help ]

The last step in the Copy Data Properties Wizard provides information on the number
of variables for which variable properties will be copied from the source data file,
the number of new variables that will be created, and the number of dataset (file)
properties that will be copied.

You can also choose to paste the generated command syntax into a syntax window
and save the syntax for later use.
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Identifying Duplicate Cases

“Duplicate” cases may occur in your data for many reasons, including:
m  Data entry errors in which the same case is accidentally entered more than once.

m  Multiple cases share a common primary ID value but have different secondary ID
values, such as family members who all live in the same house.

m  Multiple cases represent the same case but with different values for variables other
than those that identify the case, such as multiple purchases made by the same
person or company for different products or at different times.

Identify Duplicate Cases allows you to define duplicate almost any way that you
want and provides some control over the automatic determination of primary versus
duplicate cases.

To Identify and Flag Duplicate Cases

» From the menus choose:

Data
Identify Duplicate Cases...

» Select one or more variables that identify matching cases.

» Select one or more of the options in the Variables to Create group.

Optionally, you can:

» Select one or more variables to sort cases within groups defined by the selected
matching cases variables. The sort order defined by these variables determines the
“first” and “last” case in each group. Otherwise, the original file order is used.

» Automatically filter duplicate cases so that they won’t be included in reports, charts, or
calculations of statistics.
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Figure 7-13
Identify Duplicate Cases dialog box
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Define matching cases by. Cases are considered duplicates if their values match for
all selected variables. If you want to identify only cases that are a 100% match in
all respects, select all of the variables.

Sort within matching groups by. Cases are automatically sorted by the variables that
define matching cases. You can select additional sorting variables that will determine
the sequential order of cases in each matching group.

m  For each sort variable, you can sort in ascending or descending order.

m  If you select multiple sort variables, cases are sorted by each variable within
categories of the preceding variable in the list. For example, if you select date as
the first sorting variable and amount as the second sorting variable, cases will
be sorted by amount within each date.
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m  Use the up and down arrow buttons to the right of the list to change the sort
order of the variables.

m  The sort order determines the “first” and “last” case within each matching group,
which determines the value of the optional primary indicator variable. For
example, if you want to filter out all but the most recent case in each matching
group, you could sort cases within the group in ascending order of a date variable,
which would make the most recent date the last date in the group.

Indicator of primary cases. Creates a variable with a value of 1 for all unique cases and
the case identified as the primary case in each group of matching cases and a value of 0
for the nonprimary duplicates in each group.

m  The primary case can be either the last or first case in each matching group, as
determined by the sort order within the matching group. If you don’t specify
any sort variables, the original file order determines the order of cases within
each group.

B You can use the indicator variable as a filter variable to exclude nonprimary
duplicates from reports and analyses without deleting those cases from the data file.

Sequential count of matching cases in each group. Creates a variable with a sequential
value from 1 to n for cases in each matching group. The sequence is based on the
current order of cases in each group, which is either the original file order or the order
determined by any specified sort variables.

Move matching cases to the top. Sorts the data file so that all groups of matching cases
are at the top of the data file, making it easy to visually inspect the matching cases
in the Data Editor.

Display frequencies for created variables. Frequency tables containing counts for each
value of the created variables. For example, for the primary indicator variable, the
table would show the number of cases with a value 0 for that variable, which indicates
the number of duplicates, and the number of cases with a value of 1 for that variable,
which indicates the number of unique and primary cases.

Missing Values. For numeric variables, the system-missing value is treated like any
other value—cases with the system-missing value for an identifier variable are treated
as having matching values for that variable. For string variables, cases with no value
for an identifier variable are treated as having matching values for that variable.
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Visual Binning

Visual Binning is designed to assist you in the process of creating new variables based
on grouping contiguous values of existing variables into a limited number of distinct
categories. You can use Visual Binning to:

m  Create categorical variables from continuous scale variables. For example, you
could use a scale income variable to create a new categorical variable that contains
income ranges.

m  Collapse a large number of ordinal categories into a smaller set of categories.

For example, you could collapse a rating scale of nine down to three categories
representing low, medium, and high.

In the first step, you:
» Select the numeric scale and/or ordinal variables for which you want to create new
categorical (binned) variables.

Figure 7-14
Initial dialog box for selecting variables to bin
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Optionally, you can limit the number of cases to scan. For data files with a large
number of cases, limiting the number of cases scanned can save time, but you should
avoid this if possible because it will affect the distribution of values used in subsequent
calculations in Visual Binning.

Note: String variables and nominal numeric variables are not displayed in the source
variable list. Visual Binning requires numeric variables, measured on either a scale or
ordinal level, since it assumes that the data values represent some logical order that
can be used to group values in a meaningful fashion. You can change the defined
measurement level of a variable in Variable View in the Data Editor. For more
information, see Variable Measurement Level in Chapter 5 on p. 106.

To Bin Variables

» From the menus in the Data Editor window choose:

Transform
Visual Binning...

» Select the numeric scale and/or ordinal variables for which you want to create new
categorical (binned) variables.

» Select a variable in the Scanned Variable List.

» Enter a name for the new binned variable. Variable names must be unique and must
follow SPSS variable naming rules. For more information, see Variable Names in
Chapter 5 on p. 105.

» Define the binning criteria for the new variable. For more information, see Binning
Variables on p. 160.

» Click OK.
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Binning Variables

Figure 7-15
Visual Binning, main dialog box
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The Visual Binning main dialog
scanned variables:

box provides the following information for the

Scanned Variable List. Displays the variables you selected in the initial dialog box.
You can sort the list by measurement level (scale or ordinal) or by variable label or

name by clicking on the column

headings.

Cases Scanned. Indicates the number of cases scanned. All scanned cases without
user-missing or system-missing values for the selected variable are used to generate
the distribution of values used in calculations in Visual Binning, including the
histogram displayed in the main dialog box and cutpoints based on percentiles or

standard deviation units.

Missing Values. Indicates the number of scanned cases with user-missing or
system-missing values. Missing values are not included in any of the binned categories.
For more information, see User-Missing Values in Visual Binning on p. 167.




161

Data Preparation

Current Variable. The name and variable label (if any) for the currently selected variable
that will be used as the basis for the new, binned variable.

Binned Variable. Name and optional variable label for the new, binned variable.

®  Name. You must enter a name for the new variable. Variable names must be unique
and must follow SPSS variable naming rules. For more information, see Variable
Names in Chapter 5 on p. 105.

®m Label. You can enter a descriptive variable label up to 255 characters long. The
default variable label is the variable label (if any) or variable name of the source
variable with (Binned) appended to the end of the label.

Minimum and Maximum. Minimum and maximum values for the currently selected
variable, based on the scanned cases and not including values defined as user-missing.

Nonmissing Values. The histogram displays the distribution of nonmissing values for
the currently selected variable, based on the scanned cases.

B After you define bins for the new variable, vertical lines on the histogram are
displayed to indicate the cutpoints that define bins.

B You can click and drag the cutpoint lines to different locations on the histogram,
changing the bin ranges.

B You can remove bins by dragging cutpoint lines off the histogram.

Note: The histogram (displaying nonmissing values), the minimum, and the maximum
are based on the scanned values. If you do not include all cases in the scan, the true
distribution may not be accurately reflected, particularly if the data file has been sorted
by the selected variable. If you scan zero cases, no information about the distribution
of values is available.

Grid. Displays the values that define the upper endpoints of each bin and optional
value labels for each bin.

m  Value. The values that define the upper endpoints of each bin. You can enter values
or use Make Cutpoints to automatically create bins based on selected criteria. By
default, a cutpoint with a value of HIGH is automatically included. This bin will
contain any nonmissing values above the other cutpoints. The bin defined by the
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lowest cutpoint will include all nonmissing values lower than or equal to that value
(or simply lower than that value, depending on how you define upper endpoints).

m Label. Optional, descriptive labels for the values of the new, binned variable. Since
the values of the new variable will simply be sequential integers from 1 to 7, labels
that describe what the values represent can be very useful. You can enter labels or
use Make Labels to automatically create value labels.

To Delete a Bin from the Grid
Right-click on the either the Value or Label cell for the bin.

From the pop-up context menu, select Delete Row.

Note: If you delete the HIGH bin, any cases with values higher than the last specified
cutpoint value will be assigned the system-missing value for the new variable.

To Delete All Labels or Delete All Defined Bins
Right-click anywhere in the grid.

From the pop-up context menu select either Delete All Labels or Delete All Cutpoints.

Upper Endpoints. Controls treatment of upper endpoint values entered in the Value
column of the grid.

® Included (<=). Cases with the value specified in the Value cell are included in the
binned category. For example, if you specify values of 25, 50, and 75, cases with a
value of exactly 25 will go in the first bin, since this will include all cases with
values less than or equal to 25.

m  Excluded (<). Cases with the value specified in the Value cell are not included in
the binned category. Instead, they are included in the next bin. For example, if
you specify values of 25, 50, and 75, cases with a value of exactly 25 will go
in the second bin rather than the first, since the first bin will contain only cases
with values less than 25.

Make Cutpoints. Generates binned categories automatically for equal width intervals,
intervals with the same number of cases, or intervals based on standard deviations. This
is not available if you scanned zero cases. For more information, see Automatically
Generating Binned Categories on p. 163.
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Make Labels. Generates descriptive labels for the sequential integer values of the
new, binned variable, based on the values in the grid and the specified treatment of
upper endpoints (included or excluded).

Reverse scale. By default, values of the new, binned variable are ascending sequential
integers from 1 to n. Reversing the scale makes the values descending sequential
integers from n to 1.

Copy Bins. You can copy the binning specifications from another variable to the
currently selected variable or from the selected variable to multiple other variables.
For more information, see Copying Binned Categories on p. 166.

Automatically Generating Binned Categories

vV v v Y

The Make Cutpoints dialog box allows you to auto-generate binned categories based
on selected criteria.

To Use the Make Cutpoints Dialog Box

Select (click) a variable in the Scanned Variable List.

Click Make Cutpoints.

Select the criteria for generating cutpoints that will define the binned categories.

Click Apply.
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Figure 7-16
Make Cutpoints dialog box

Make Cutpoints

(%) Equal ‘width Intervalz
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Apply will replace the current cutpaint definitions with this specification.
A final interval will nchude all remaining values: N cutpoints produce
M+1 intervals.

Note: The Make Cutpoints dialog box is not available if you scanned zero cases.

Equal Width Intervals. Generates binned categories of equal width (for example, 1-10,
11-20, and 21-30) based on any two of the following three criteria:

m  First Cutpoint Location. The value that defines the upper end of the lowest binned
category (for example, a value of 10 indicates a range that includes all values
up to 10).

®  Number of Cutpoints. The number of binned categories is the number of cutpoints
plus one. For example, 9 cutpoints generate 10 binned categories.

®  Width. The width of each interval. For example, a value of 10 would bin age in
years into 10-year intervals.
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Equal Percentiles Based on Scanned Cases. Generates binned categories with an equal
number of cases in each bin (using the aempirical algorithm for percentiles), based
on either of the following criteria:

®  Number of Cutpoints. The number of binned categories is the number of cutpoints
plus one. For example, three cutpoints generate four percentile bins (quartiles),
each containing 25% of the cases.

®  Width (%). Width of each interval, expressed as a percentage of the total number of
cases. For example, a value of 33.3 would produce three binned categories (two
cutpoints), each containing 33.3% of the cases.

If the source variable contains a relatively small number of distinct values or a large
number of cases with the same value, you may get fewer bins than requested. If there
are multiple identical values at a cutpoint, they will all go into the same interval; so
the actual percentages may not always be exactly equal.

Cutpoints at Mean and Selected Standard Deviations Based on Scanned Cases. Generates
binned categories based on the values of the mean and standard deviation of the
distribution of the variable.

m If you don’t select any of the standard deviation intervals, two binned categories
will be created, with the mean as the cutpoint dividing the bins.

B You can select any combination of standard deviation intervals based on one, two,
and/or three standard deviations. For example, selecting all three would result in
eight binned categories—six bins in one standard deviation intervals and two bins
for cases more than three standard deviations above and below the mean.

In a normal distribution, 68% of the cases fall within one standard deviation of the
mean; 95%, within two standard deviations; and 99%, within three standard deviations.
Creating binned categories based on standard deviations may result in some defined
bins outside of the actual data range and even outside of the range of possible data
values (for example, a negative salary range).

Note: Calculations of percentiles and standard deviations are based on the scanned
cases. If you limit the number of cases scanned, the resulting bins may not contain
the proportion of cases that you wanted in those bins, particularly if the data file is
sorted by the source variable. For example, if you limit the scan to the first 100 cases
of a data file with 1000 cases and the data file is sorted in ascending order of age of
respondent, instead of four percentile age bins each containing 25% of the cases,
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you may find that the first three bins each contain only about 3.3% of the cases, and
the last bin contains 90% of the cases.

Copying Binned Categories

When creating binned categories for one or more variables, you can copy the binning
specifications from another variable to the currently selected variable or from the
selected variable to multiple other variables.

Figure 7-17
Copying bins to or from the current variable

Copy Bands from Current

Select the vanables to be banded
like: the current wanable.
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Dz TV [ownty]

Ovanz WCR [ownver]

To Copy Binning Specifications
» Define binned categories for at least one variable—but do rot click OK or Paste.

» Select (click) a variable in the Scanned Variable List for which you have defined
binned categories.

» Click To Other Variables.

» Select the variables for which you want to create new variables with the same binned
categories.
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» Click Copy.

or

» Select (click) a variable in the Scanned Variable List to which you want to copy
defined binned categories.

» Click From Another Variable.
» Select the variable with the defined binned categories that you want to copy.

» Click Copy.

If you have specified value labels for the variable from which you are copying the
binning specifications, those are also copied.

Note: Once you click OK in the Visual Binning main dialog box to create new binned
variables (or close the dialog box in any other way), you cannot use Visual Binning to
copy those binned categories to other variables.

User-Missing Values in Visual Binning

Values defined as user-missing (values identified as codes for missing data) for

the source variable are not included in the binned categories for the new variable.
User-missing values for the source variables are copied as user-missing values for the
new variable, and any defined value labels for missing value codes are also copied.

If a missing value code conflicts with one of the binned category values for the new
variable, the missing value code for the new variable is recoded to a nonconflicting
value by adding 100 to the highest binned category value. For example, if a value of 1
is defined as user-missing for the source variable and the new variable will have six
binned categories, any cases with a value of 1 for the source variable will have a
value of 106 for the new variable, and 106 will be defined as user-missing. If the
user-missing value for the source variable had a defined value label, that label will be
retained as the value label for the recoded value of the new variable.

Note: If the source variable has a defined range of user-missing values of the form
LO-n, where n is a positive number, the corresponding user-missing values for the
new variable will be negative numbers.
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In an ideal situation, your raw data are perfectly suitable for the type of analysis you
want to perform, and any relationships between variables are either conveniently linear
or neatly orthogonal. Unfortunately, this is rarely the case. Preliminary analysis may
reveal inconvenient coding schemes or coding errors, or data transformations may be
required in order to expose the true relationship between variables.

You can perform data transformations ranging from simple tasks, such as collapsing
categories for analysis, to more advanced tasks, such as creating new variables based
on complex equations and conditional statements.

Computing Variables

Use the Compute dialog box to compute values for a variable based on numeric
transformations of other variables.

B You can compute values for numeric or string (alphanumeric) variables.

B You can create new variables or replace the values of existing variables. For new
variables, you can also specify the variable type and label.

You can compute values selectively for subsets of data based on logical conditions.

You can use more than 70 built-in functions, including arithmetic functions,
statistical functions, distribution functions, and string functions.

168
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Figure 8-1
Compute Variable dialog box
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To Compute Variables

» From the menus choose:

Transform
Compute Variable...

» Type the name of a single target variable. It can be an existing variable or a new
variable to be added to the active dataset.

» To build an expression, either paste components into the Expression field or type
directly in the Expression field.

B You can paste functions or commonly used system variables by selecting a group
from the Function group list and double-clicking the function or variable in the
Functions and Special Variables list (or select the function or variable and click
the arrow adjacent to the Function group list). Fill in any parameters indicated by
question marks (only applies to functions). The function group labeled All provides
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a listing of all available functions and system variables. A brief description of
the currently selected function or variable is displayed in a reserved area in the

dialog box.

String constants must be enclosed in quotation marks or apostrophes.

If values contain decimals, a period (.) must be used as the decimal indicator.

For new string variables, you must also select Type & Label to specify the data type.

Compute Variable: If Cases

The If Cases dialog box allows you to apply data transformations to selected subsets
of cases, using conditional expressions. A conditional expression returns a value

of true, false, or missing for each case.

Figure 8-2
Compute Variable If Cases dialog box
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m  [f the result of a conditional expression is frue, the case is included in the selected

subset.

m  [f the result of a conditional expression is false or missing, the case is not included

in the selected subset.
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®  Most conditional expressions use one or more of the six relational operators (<, >,
<=, >=, =, and ~=) on the calculator pad.

m  Conditional expressions can include variable names, constants, arithmetic
operators, numeric (and other) functions, logical variables, and relational operators.

Compute Variable: Type and Label

By default, new computed variables are numeric. To compute a new string variable,
you must specify the data type and width.

Label. Optional, descriptive variable label up to 120 characters long. You can enter a
label or use the first 110 characters of the compute expression as the label.

Type. Computed variables can be numeric or string (alphanumeric). String variables

cannot be used in calculations.

Figure 8-3
Type and Label dialog box

Compute ¥ariable: Type and Label
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Functions

Many types of functions are supported, including:

Arithmetic functions.
Statistical functions.
String functions.

Date and time functions.

Distribution functions.

Random variable functions.
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B Missing value functions.
m  Scoring functions (SPSS Server only).

For more information and a detailed description of each function, type functions on the
Index tab of the Help system.

Missing Values in Functions

Functions and simple arithmetic expressions treat missing values in different ways.
In the expression:

(varl+var2+var3) /3

the result is missing if a case has a missing value for any of the three variables.

In the expression:
MEAN (varl, wvar2, var3)

the result is missing only if the case has missing values for all three variables.

For statistical functions, you can specify the minimum number of arguments that
must have nonmissing values. To do so, type a period and the minimum number after
the function name, as in:

MEAN.2 (varl, var2, var3)

Random Number Generators

The Random Number Generators dialog box allows you to select the random number
generator and set the starting sequence value so you can reproduce a sequence of
random numbers.

Active Generator. Two different random number generators are available:

m  SPSS 12 Compatible. The random number generator used in SPSS 12 and previous
releases. If you need to reproduce randomized results generated in previous
releases based on a specified seed value, use this random number generator.

m  Mersenne Twister. A newer random number generator that is more reliable for
simulation purposes. If reproducing randomized results from SPSS 12 or earlier is
not an issue, use this random number generator.
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Active Generator Initialization. The random number seed changes each time a random
number is generated for use in transformations (such as random distribution functions),
random sampling, or case weighting. To replicate a sequence of random numbers,

set the initialization starting point value prior to each analysis that uses the random
numbers. The value must be a positive integer.

Figure 8-4
Random Number Generators dialog box
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To select the random number generator and/or set the initialization value:

» From the menus choose:

Transform
Random Number Generators

Count Occurrences of Values within Cases

This dialog box creates a variable that counts the occurrences of the same value(s) in a
list of variables for each case. For example, a survey might contain a list of magazines
with yes/no check boxes to indicate which magazines each respondent reads. You
could count the number of yes responses for each respondent to create a new variable
that contains the total number of magazines read.
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Figure 8-5
Count Occurrences of Values within Cases dialog box
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To Count Occurrences of Values within Cases

» From the menus choose:

Transform
Count Values within Cases...

» Enter a target variable name.
» Select two or more variables of the same type (numeric or string).

» Click Define Values and specify which value or values should be counted.

Optionally, you can define a subset of cases for which to count occurrences of values.

Count Values within Cases: Values to Count

The value of the target variable (on the main dialog box) is incremented by 1 each
time one of the selected variables matches a specification in the Values to Count list
here. If a case matches several specifications for any variable, the target variable is
incremented several times for that variable.

Value specifications can include individual values, missing or system-missing

values, and ranges. Ranges include their endpoints and any user-missing values that
fall within the range.
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Figure 8-6
Values to Count dialog box
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Count Occurrences: If Cases

The If Cases dialog box allows you to count occurrences of values for a selected subset
of cases, using conditional expressions. A conditional expression returns a value
of true, false, or missing for each case.

Figure 8-7
Count Occurrences If Cases dialog box
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For general considerations on using the If Cases dialog box, see Compute Variable: If
Cases on p. 170.

Recoding Values

You can modify data values by recoding them. This is particularly useful for collapsing
or combining categories. You can recode the values within existing variables, or you
can create new variables based on the recoded values of existing variables.

Recode into Same Variables

The Recode into Same Variables dialog box allows you to reassign the values of
existing variables or collapse ranges of existing values into new values. For example,
you could collapse salaries into salary range categories.

You can recode numeric and string variables. If you select multiple variables, they
must all be the same type. You cannot recode numeric and string variables together.

Figure 8-8
Recode into Same Variables dialog box
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To Recode Values of a Variable

» From the menus choose:

Transform
Recode Into Same Variables...
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» Select the variables you want to recode. If you select multiple variables, they must be
the same type (numeric or string).

» Click Old and New Values and specify how to recode values.

Optionally, you can define a subset of cases to recode. The If Cases dialog box for
doing this is the same as the one described for Count Occurrences.

Recode into Same Variables: 0ld and New Values

You can define values to recode in this dialog box. All value specifications must be the
same data type (numeric or string) as the variables selected in the main dialog box.

0ld Value. The value(s) to be recoded. You can recode single values, ranges of values,
and missing values. System-missing values and ranges cannot be selected for string
variables because neither concept applies to string variables. Ranges include their
endpoints and any user-missing values that fall within the range.

Value. Individual old value to be recoded into a new value. The value must be the
same data type (numeric or string) as the variable(s) being recoded.

System-missing. Values assigned by the program when values in your data are
undefined according to the format type you have specified, when a numeric field is
blank, or when a value resulting from a transformation command is undefined.
Numeric system-missing values are displayed as periods. String variables cannot
have system-missing values, since any character is legal in a string variable.

System- or user-missing. Observations with values that cither have been defined as
user-missing values or are unknown and have been assigned the system-missing
value, which is indicated with a period (.).

Range. Inclusive range of values. Not available for string variables. Any
user-missing values within the range are included.

All other values. Any remaining values not included in one of the specifications on
the Old-New list. This appears as ELSE on the Old-New list.

New Value. The single value into which each old value or range of values is recoded.
You can enter a value or assign the system-missing value.
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® Value. Value into which one or more old values will be recoded. The value must be
the same data type (numeric or string) as the old value.

m  System-missing. Recodes specified old values into the system-missing value. The
system-missing value is not used in calculations, and cases with the system-missing
value are excluded from many procedures. Not available for string variables.

Old—>New. The list of specifications that will be used to recode the variable(s). You
can add, change, and remove specifications from the list. The list is automatically
sorted, based on the old value specification, using the following order: single values,
missing values, ranges, and all other values. If you change a recode specification on
the list, the procedure automatically re-sorts the list, if necessary, to maintain this order.

Figure 8-9
Old and New Values dialog box

Recode into 5ame VYariables: Old and Mew Values
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" Value: I o \.I’a!ue:l " System-missing
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Add Lowest thru 24999 —> 1
Range: 2b000 thru 49999 —> 2

chanae. | |50000 thru 74999 —> 3

| through | ;l 75000 thru Highest —> 4

" Range: Remove |
[Cowest through I

¥ Range:

| through highest

" All other values

-
" Bystem- or user-missing
-

Continue Cancel Help

Recode into Different Variables

The Recode into Different Variables dialog box allows you to reassign the values of
existing variables or collapse ranges of existing values into new values for a new
variable. For example, you could collapse salaries into a new variable containing
salary-range categories.

B You can recode numeric and string variables.
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B You can recode numeric variables into string variables and vice versa.

m  [fyou select multiple variables, they must all be the same type. You cannot recode
numeric and string variables together.

Figure 8-10
Recode into Different Variables dialog box

1 Aecode into Different Yanables
R —— Numeric ¥ariable -> Output
bdate - y Output Variable ———————
i b
gender < —
id E Isalcat Change |
jobcat .
jobtime Label:
minority ISaIary range categories
name >
prevexp
salbegin If... |

Old and New Values... |

oK | Paste | Beset | Cancel | Help |

To Recode Values of a Variable into a New Variable

» From the menus choose:

Transform
Recode Into Different Variables...

» Select the variables you want to recode. If you select multiple variables, they must be
the same type (numeric or string).

» Enter an output (new) variable name for each new variable and click Change.

» Click Old and New Values and specify how to recode values.

Optionally, you can define a subset of cases to recode. The If Cases dialog box for
doing this is the same as the one described for Count Occurrences.

Recode into Different Variables: Old and New Values

You can define values to recode in this dialog box.
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0ld Value. The value(s) to be recoded. You can recode single values, ranges of values,
and missing values. System-missing values and ranges cannot be selected for string
variables because neither concept applies to string variables. Old values must be the
same data type (numeric or string) as the original variable. Ranges include their
endpoints and any user-missing values that fall within the range.

Value. Individual old value to be recoded into a new value. The value must be the
same data type (numeric or string) as the variable(s) being recoded.

System-missing. Values assigned by the program when values in your data are
undefined according to the format type you have specified, when a numeric field is
blank, or when a value resulting from a transformation command is undefined.
Numeric system-missing values are displayed as periods. String variables cannot
have system-missing values, since any character is legal in a string variable.

System- or user-missing. Observations with values that either have been defined as
user-missing values or are unknown and have been assigned the system-missing
value, which is indicated with a period (.).

Range. Inclusive range of values. Not available for string variables. Any
user-missing values within the range are included.

All other values. Any remaining values not included in one of the specifications on
the Old-New list. This appears as ELSE on the Old-New list.

New Value. The single value into which each old value or range of values is recoded.
New values can be numeric or string.

Value. Value into which one or more old values will be recoded. The value must be
the same data type (numeric or string) as the old value.

System-missing. Recodes specified old values into the system-missing value. The
system-missing value is not used in calculations, and cases with the system-missing
value are excluded from many procedures. Not available for string variables.

Copy old values. Retains the old value. If some values don’t require recoding,
use this to include the old values. Any old values that are not specified are not
included in the new variable, and cases with those values will be assigned the
system-missing value for the new variable.

Output variables are strings. Defines the new, recoded variable as a string
(alphanumeric) variable. The old variable can be numeric or string.
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Convert numeric strings to numbers. Converts string values containing numbers to
numeric values. Strings containing anything other than numbers and an optional sign
(+ or -) are assigned the system-missing value.

0ld->New. The list of specifications that will be used to recode the variable(s). You
can add, change, and remove specifications from the list. The list is automatically
sorted, based on the old value specification, using the following order: single values,
missing values, ranges, and all other values. If you change a recode specification on
the list, the procedure automatically re-sorts the list, if necessary, to maintain this order.

Figure 8-11
Old and New Values dialog box

Recode into Different Yanables: Old and Hew Values E2

~0ld Value New ¥Yalue
" ¥Yalue: I 0 Value:l " System-missing
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 Range:
lLowestthrongh I Bemove |
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" All other values Continue | Cancel Help |
Rank Cases

The Rank Cases dialog box allows you to create new variables containing ranks,
normal and Savage scores, and percentile values for numeric variables.

New variable names and descriptive variable labels are automatically generated,
based on the original variable name and the selected measure(s). A summary table lists
the original variables, the new variables, and the variable labels.
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Optionally, you can:
B Rank cases in ascending or descending order.

®  Organize rankings into subgroups by selecting one or more grouping variables for
the By list. Ranks are computed within each group. Groups are defined by the
combination of values of the grouping variables. For example, if you select gender
and minority as grouping variables, ranks are computed for each combination
of gender and minority.

Figure 8-12

Rank Cases dialog box
Variable(s): =
educ salary
i Paste
jobcat |- |
jobtime Reset
minority |
i Cancel
rsalary By: |
salbegin - Help

e |

~Assign Rank 1 to

& Smallest value ¥ Display summary tables

¢ Largest value Rank Types... Ties...

To Rank Cases

» From the menus choose:

Transform
Rank Cases...

» Select one or more variables to rank. You can rank only numeric variables.

Optionally, you can rank cases in ascending or descending order and organize ranks
into subgroups.
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Rank Cases: Types

You can select multiple ranking methods. A separate ranking variable is created
for each method. Ranking methods include simple ranks, Savage scores, fractional
ranks, and percentiles. You can also create rankings based on proportion estimates
and normal scores.

Rank. Simple rank. The value of the new variable equals its rank.

Savage score. The new variable contains Savage scores based on an exponential
distribution.

Fractional rank. The value of the new variable equals rank divided by the sum of the
weights of the nonmissing cases.

Fractional rank as percent. Each rank is divided by the number of cases with valid
values and multiplied by 100.

Sum of case weights. The value of the new variable equals the sum of case weights.
The new variable is a constant for all cases in the same group.

Ntiles. Ranks are based on percentile groups, with each group containing approximately
the same number of cases. For example, 4 Ntiles would assign a rank of 1 to cases
below the 25th percentile, 2 to cases between the 25th and 50th percentile, 3 to cases
between the 50th and 75th percentile, and 4 to cases above the 75th percentile.

Proportion estimates. Estimates of the cumulative proportion of the distribution
corresponding to a particular rank.

Normal scores. The z scores corresponding to the estimated cumulative proportion.
Proportion Estimation Formula. For proportion estimates and normal scores, you can
select the proportion estimation formula: Blom, Tukey, Rankit, or Van der Waerden.

®  Blom. Creates new ranking variable based on proportion estimates that uses the
formula (r-3/8) / (w+1/4), where w is the sum of the case weights and r is the rank.

m  Tukey. Uses the formula (r-1/3) / (w+1/3), where r is the rank and w is the sum of
the case weights.

m  Rankit. Uses the formula (r-1/2) / w, where w is the number of observations and r is
the rank, ranging from 1 to w.

®  Van der Waerden. Van der Waerden’s transformation, defined by the formula
r/(w+1), where w is the sum of the case weights and r is the rank, ranging from 1
to w.
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Figure 8-13
Rank Cases Types dialog box
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Rank Cases: Ties

This dialog box controls the method for assigning rankings to cases with the same
value on the original variable.

Figure 8-14
Rank Cases Ties dialog box

Rank Cases: Ties E3

Rank Assigned to Ties Continue |
= Mean  Low  High Cancel |

{5 tial ranks t i |
sequential ranks to unique values Help |

The following table shows how the different methods assign ranks to tied values:

Value Mean Low High Sequential
10 1 1 1 1
15 3 2 4 2
15 3 2 4 2
15 3 2 4 2
16 5 5 5 3
20 6 6 6 4
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The Automatic Recode dialog box allows you to convert string and numeric values
into consecutive integers. When category codes are not sequential, the resulting empty
cells reduce performance and increase memory requirements for many procedures.
Additionally, some procedures cannot use string variables, and some require
consecutive integer values for factor levels.

Figure 8-15

Automatic Recode dialog box
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®  The new variable(s) created by Automatic Recode retain any defined variable and
value labels from the old variable. For any values without a defined value label,
the original value is used as the label for the recoded value. A table displays the
old and new values and value labels.

m  String values are recoded in alphabetical order, with uppercase letters preceding
their lowercase counterparts.

B Missing values are recoded into missing values higher than any nonmissing values,
with their order preserved. For example, if the original variable has 10 nonmissing
values, the lowest missing value would be recoded to 11, and the value 11 would
be a missing value for the new variable.
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Use the same recoding scheme for all variables. This option allows you to apply a
single autorecoding scheme to all the selected variables, yielding a consistent coding
scheme for all the new variables.

If you select this option, the following rules and limitations apply:
m  All variables must be of the same type (numeric or string).

m All observed values for all selected variables are used to create a sorted order of
values to recode into sequential integers.

m  User-missing values for the new variables are based on the first variable in the list
with defined user-missing values. All other values from other original variables,
except for system-missing, are treated as valid.

Treat blank string values as user-missing. For string variables, blank or null values
are not treated as system-missing. This option will autorecode blank strings into a
user-missing value higher than the highest nonmissing value.

Templates

You can save the autorecoding scheme in a template file and then apply it to other
variables and other data files.

For example, you may have a large number of alphanumeric product codes that you
autorecode into integers every month, but some months new product codes are added
that change the original autorecoding scheme. If you save the original scheme in a
template and then apply it to the new data that contain the new set of codes, any new
codes encountered in the data are autorecoded into values higher than the last value in
the template, preserving the original autorecode scheme of the original product codes.

Save template as. Saves the autorecode scheme for the selected variables in an external
template file.

m  The template contains information that maps the original nonmissing values to
the recoded values.

B Only information for nonmissing values is saved in the template. User-missing
value information is not retained.
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If you have selected multiple variables for recoding but you have not selected to
use the same autorecoding scheme for all variables or you are not applying an
existing template as part of the autorecoding, the template will be based on the
first variable in the list.

If you have selected multiple variables for recoding and you have also selected Use
the same recoding scheme for all variables and/or you have selected Apply template,
then the template will contain the combined autorecoding scheme for all variables.

Apply template from. Applies a previously saved autorecode template to variables
selected for recoding, appending any additional values found in the variables to the end
of the scheme and preserving the relationship between the original and autorecoded
values stored in the saved scheme.

All variables selected for recoding must be the same type (numeric or string), and
that type must match the type defined in the template.

Templates do not contain any information on user-missing values. User-missing
values for the target variables are based on the first variable in the original
variable list with defined user-missing values. All other values from other original
variables, except for system-missing, are treated as valid.

Value mappings from the template are applied first. All remaining values are
recoded into values higher than the last value in the template, with user-missing
values (based on the first variable in the list with defined user-missing values)
recoded into values higher than the last valid value.

If you have selected multiple variables for autorecoding, the template is applied
first, followed by a common, combined autorecoding for all additional values
found in the selected variables, resulting in a single, common autorecoding scheme
for all selected variables.

To Recode String or Numeric Values into Consecutive Integers

From the menus choose:

Transform
Automatic Recode...

» Select one or more variables to recode.

» For each selected variable, enter a name for the new variable and click New Name.
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Date and Time Wizard

>

>

The Date and Time Wizard simplifies a number of common tasks associated with
date and time variables.

To Use the Date and Time Wizard

From the menus choose:

Transform
Date/Time...

Select the task you wish to accomplish and follow the steps to define the task.

Figure 8-16
Date and Time Wizard introduction screen

Date and Time Wizard

Welcame ko the date and time wizard
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T
L]
’@/} (") Extract a part of a date or time variable
Assign periodicity to a dataset (for time series data). This ends the wizard and opens the

O Define Dates dialog box

[ Cancel ] [ Help ]

m Learn how dates and times are represented in SPSS. This choice leads to a screen
that provides a brief overview of date/time variables in SPSS. By clicking on the
Help button, it also provides a link to more detailed information.

m Create a date/time variable from a string containing a date or time. Use this option
to create a date/time variable from a string variable. For example, you have a
string variable representing dates in the form mm/dd/yyyy and want to create a
date/time variable from this.
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m Create a date/time variable from variables holding parts of dates or times. This choice
allows you to construct a date/time variable from a set of existing variables. For
example, you have a variable that represents the month (as an integer), a second
that represents the day of the month, and a third that represents the year. You can
combine these three variables into a single date/time variable.

m Calculate with dates and times. Use this option to add or subtract values from
date/time variables. For example, you can calculate the duration of a process
by subtracting a variable representing the start time of the process from another
variable representing the end time of the process.

m Extract a part of a date or time variable. This option allows you to extract part of a
date/time variable, such as the day of the month from a date/time variable, which
has the form mm/dd/yyyy.

®m  Assign periodicity to a dataset. This choice takes you to the Define Dates dialog
box, used to create date/time variables that consist of a set of sequential dates. This
feature is typically used to associate dates with time series data.

Note: Tasks are disabled when the dataset lacks the types of variables required to
accomplish the task. For instance, if the dataset contains no string variables, then the
task to create a date/time variable from a string does not apply and is disabled.

Dates and Times in SPSS

Variables that represent dates and times in SPSS have a variable type of numeric, with
display formats that correspond to the specific date/time formats. These variables are
generally referred to as date/time variables. SPSS distinguishes between date/time
variables that actually represent dates and those that represent a time duration that is
independent of any date, such as 20 hours, 10 minutes, and 15 seconds. The latter are
referred to as duration variables and the former as date or date/time variables. For a
complete list of display formats, see “Date and Time” in the “Universals” section of
the SPSS Command Syntax Reference.

Date and date/time variables. Date variables have a format representing a date, such as
mm/dd/yyyy. Date/time variables have a format representing a date and time, such

as dd-mmm-yyyy hh:mm:ss. Internally, date and date/time variables are stored as the
number of seconds from October 14, 1582. Date and date/time variables are sometimes
referred to as date-format variables.
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m  Both two- and four-digit year specifications are recognized. By default, two-digit
years represent a range beginning 69 years prior to the current date and ending 30
years after the current date. This range is determined by your Options settings and
is configurable (from the Edit menu, choose Options and click the Data tab).

m  Dashes, periods, commas, slashes, or blanks can be used as delimiters in
day-month-year formats.

®  Months can be represented in digits, Roman numerals, or three-character
abbreviations, and they can be fully spelled out. Three-letter abbreviations
and fully spelled-out month names must be in English; month names in other
languages are not recognized.

Duration Variables. Duration variables have a format representing a time duration, such
as hh:mm. They are stored internally as seconds without reference to a particular date.

m In time specifications (applies to date/time and duration variables), colons can be
used as delimiters between hours, minutes, and seconds. Hours and minutes are
required, but seconds are optional. A period is required to separate seconds from
fractional seconds. Hours can be of unlimited magnitude, but the maximum value
for minutes is 59 and for seconds is 59.999....

Current Date and Time. The system variable $7/ME holds the current date and time. It
represents the number of seconds from October 14, 1582, to the date and time when
the transformation command that uses it is executed.

Create a Date/Time Variable from a String

To create a date/time variable from a string variable:

» Seclect Create a date/time variable from a string containing a date or time on the
introduction screen of the Date and Time Wizard.



191

Data Transformations

Select String Variable to Convert to Date/Time Variable

Figure 8-17
Create date/time variable from string variable, step 1

Date and Time Wizard - Step 1 of 2 E
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< Back I Mext = | Fimish | Cancel | Help |

» Select the string variable to convert in the Variables list. Note that the list displays
only string variables.

» Select the pattern from the Patterns list that matches how dates are represented by the
string variable. The Sample Values list displays actual values of the selected variable
in the data file. Values of the string variable that do not fit the selected pattern result in
a value of system-missing for the new variable.
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Specify Result of Converting String Variable to Date/Time Variable

Figure 8-18
Create date/time variable from string variable, step 2

Date and Time Wizard - Step 2 of 2 E

Create a DatefTime Variable fronm a String Yariable
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3
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Yariable Label:
/ I Process Start Date
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< Back I IExt = | Finish | Cancel | Help |

» Enter a name for the Result Variable. This cannot be the name of an existing variable.

Optionally, you can:
m  Select a date/time format for the new variable from the Output Format list.

B Assign a descriptive variable label to the new variable.

Create a Date/Time Variable from a Set of Variables

To merge a set of existing variables into a single date/time variable:

» Seclect Create a date/time variable from variables holding parts of dates or times on the
introduction screen of the Date and Time Wizard.
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Select Variables to Merge into Single Date/Time Variable

Figure 8-19
Create date/time variable from variable set, step 1

Date and Time Wizard - Step 1 of 2 E
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» Select the variables that represent the different parts of the date/time.

Some combinations of selections are not allowed. For instance, creating a
date/time variable from Year and Day of Month is invalid because once Year is
chosen, a full date is required.

You cannot use an existing date/time variable as one of the parts of the final
date/time variable you’re creating. Variables that make up the parts of the new
date/time variable must be integers. The exception is the allowed use of an existing
date/time variable as the Seconds part of the new variable. Since fractional
seconds are allowed, the variable used for Seconds is not required to be an integer.

Values, for any part of the new variable, that are not within the allowed range
result in a value of system-missing for the new variable. For instance, if you
inadvertently use a variable representing day of month for Month, any cases with
day of month values in the range 14-31 will be assigned the system-missing value
for the new variable since the valid range for months in SPSS is 1-13
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Specify Date/Time Variable Created by Merging Variables

Figure 8-20
Create date/time variable from variable set, step 2

Date and Time Wizard - Step 2 of 2 E

‘ou can name and label the result wariable and assign an appropriate Format

Result Yariable: Cukput Format:
BirthCiate
1nea
10 2
3
"8 Yariahle Label:
/ | Birth Date

Execution
[5 Create the variable nowv " Paste the syntax into the syntax window
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» Enter a name for the Result Variable. This cannot be the name of an existing variable.

» Select a date/time format from the Output Format list.
Optionally, you can:

B Assign a descriptive variable label to the new variable.

Add or Subtract Values from Date/Time Variables

To add or subtract values from date/time variables:

» Select Calculate with dates and times on the introduction screen of the Date and Time
Wizard.
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Figure 8-21
Add or subtract values from date/time variables, step 1

Date and Time Wizard - Step 1 of 3

Do Calculations on Dates

Choose one of the following tasks and press Mext

® Add or subtract a duration from a date {e.q., add a month to an age or add a time variable to
a dateftime variable)

O Calculate the number of time units between two dates (e.qg., calculate an age in years from a
1 birthdate and another date)

’ <Back [[ Mext> | ’ Firish ] ’ Cancel

| |

Help ]

® Add or subtract a duration from a date. Use this option to add to or subtract from
a date-format variable. You can add or subtract durations that are fixed values,
such as 10 days, or the values from a numeric variable, such as a variable that
represents years.

m  Calculate the number of time units between two dates. Use this option to obtain the
difference between two dates as measured in a chosen unit. For example, you can

obtain the number of years or the number of days separating two dates.

m  Subtract two durations. Use this option to obtain the difference between two
variables that have formats of durations, such as hh:mm or hh:mm:ss.

Note: Tasks are disabled when the dataset lacks the types of variables required to
accomplish the task. For instance, if the dataset lacks two variables with formats of
durations, then the task to subtract two durations does not apply and is disabled.
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Add or Subtract a Duration from a Date

To add or subtract a duration from a date-format variable:

» Select Add or subtract a duration from a date on the screen of the Date and Time Wizard
labeled Do Calculations on Dates.

Select Date/Time Variable and Duration to Add or Subtract

Figure 8-22
Add or subtract duration, step 2

Date and Time Wizard - Step 2 of 3

Add to or subtract From a date or dateftime variable

Choose a date or date/time variable.
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’ <Back [[ Mext > ¢ Cancel ] ’ Help

» Select a date (or time) variable.

» Select a duration variable or enter a value for Duration Constant. Variables used for
durations cannot be date or date/time variables. They can be duration variables or
simple numeric variables.

» Select the unit that the duration represents from the drop-down list. Select Duration
if using a variable and the variable is in the form of a duration, such as hh:mm or
hh:mm:ss.
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Specify Result of Adding or Subtracting a Duration from a Date/Time Variable

Figure 8-23

Add or subtract duration, step 3

Date and Time Wizard - Step 3 of 3

Calculation:

Result Yariable:
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» Enter a name for Result Variable. This cannot be the name of an existing variable.

Optionally, you can:

B Assign a descriptive variable label to the new variable.

Subtract Date-Format Variables

To subtract two date-format variables:

» Select Calculate the number of time units between two dates on the screen of the Date and

Time Wizard labeled Do Calculations on Dates.
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Select Date-Format Variables to Subtract

Figure 8-24
Subtract dates, step 2

Date and Time Wizard - Step 2 of 3
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l J {

» Select the variables to subtract.

» Select the unit for the result from the drop-down list.
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Specify Result of Subtracting Two Date-Format Variables

Figure 8-25
Subtract dates, step 3
Date and Time Wizard - Step 3 of 3
Calculation: MextRel - LastUp
Result Yariable: Units:
YearsLastUp Years
nka
10 2
a / i Yatiable Label:
4 ‘fears since last upgrade
76
Execution
(%) Create the variable now () Paste the synkax into the syntax window
[ Finish | ’ Cancel ] ’ Help ]

» Enter a name for Result Variable. This cannot be the name of an existing variable.

Optionally, you can:

B Assign a descriptive variable label to the new variable.

Subtract Duration Variables

To subtract two duration variables:

» Select Subtract two durations on the screen of the Date and Time Wizard labeled Do
Calculations on Dates.
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Select Duration Variables to Subtract

Figure 8-26
Subtract two durations, step 2

Date and Time Wizard - Step 2 of 3

S

» Select the variables to subtract.
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Specify Result of Subtracting Two Duration Variables

Figure 8-27
Subtract two durations, step 3

Date and Time Wizard - Step 3 of 3 E
Calculation: Time2 - Time1
Result Yariable: Cukput Format:
TOifF
1nea
10 2
[y 3 ddd bhimm:ss:s
-3
t6 Yariable Label:
/ I Tirne Difference

Execution
[5 Create the variable nowv " Paste the syntax into the syntax window

< Back | IExt = | Finish I Cancel | Help |

» Enter a name for Result Variable. This cannot be the name of an existing variable.

» Select a duration format from the Output Format list.
Optionally, you can:

B Assign a descriptive variable label to the new variable.

Extract Part of a Date/Time Variable

To extract a component—such as the year—from a date/time variable:

» Select Extract a part of a date or time variable on the introduction screen of the Date
and Time Wizard.
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Select Component to Extract from Date/Time Variable

Figure 8-28
Get part of a date/time variable, step 1

Date and Time Wizard - Step 1 of 2 E

Get part of & date or time as an ordinary numeric variable.

Choose a variable and the component of the date or time to extract,

‘ariables: Dake or Time:
@ $TIME » |® BirthDateTime
< StartDate
12 & EndDate Format: dd-rmm-yyy B
11 1 )
0 /2 BTmel
e ) BIMNEZ o Unit to Extract:
3 - -
T g Time portion ;I

$TIME is the current date and time.,

< Back I Mext = I Firisty Cancel Help

» Select the variable containing the date or time part to extract.

» Select the part of the variable to extract, from the drop-down list. You can extract
information from dates that is not explicitly part of the display date, such as day of
the week.
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Specify Result of Extracting Component from Date/Time Variable

Figure 8-29
Get part of a date/time variable, step 2

D ate and Time Wizard - Step 2 of 2 [ x|

Input Yariable: BirthDateTime
Unit Extracted: Time poarkion

Enter a name for the result variable and optionally, a label,

Result Yariable: Cutput Forrmat:
BirthTime:

unka

10 2
g_/ 3 ddd bh:mim:ss:s

a

"6 Yariable Label:

/ I Birth Hour and Minute
=

Execution
[G Create the variable now " Paste the syntax into the syntasx window

< Back | fext = | Finish I Cancel | Help |

» Enter a name for Result Variable. This cannot be the name of an existing variable.

» If you’re extracting the date or time part of a date/time variable, then you must select a
format from the Output Format list. In cases where the output format is not required,
the Output Format list will be disabled.

Optionally, you can:

B Assign a descriptive variable label to the new variable.

Time Series Data Transformations

Several data transformations that are useful in time series analysis are provided:

m  Generate date variables to establish periodicity and to distinguish between
historical, validation, and forecasting periods.
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m  Create new time series variables as functions of existing time series variables.

B Replace system- and user-missing values with estimates based on one of several
methods.

A time series is obtained by measuring a variable (or set of variables) regularly over a
period of time. Time series data transformations assume a data file structure in which
each case (row) represents a set of observations at a different time, and the length of
time between cases is uniform.

Define Dates

The Define Dates dialog box allows you to generate date variables that can be used to
establish the periodicity of a time series and to label output from time series analysis.

Figure 8-30
Define Dates dialog box

Define Dates

Cases Are: 0K
—First Casels:————————

Weeks, days =l Periodicity at R

Weeks, work days[b] higher level (edosiei

Weeks, work days([6)

Hours Week: |1 Cancel
Days, hours .
Dai s, work huurIB‘ Day: I1 7 Help
“Weeks, days, hours l_

0

Weeks, work days, hour Hour: 24
Minutes

Hours, minutes
Days, hours, minutes ||

]

Current Dates:
None

Cases Are. Defines the time interval used to generate dates.

B Not dated removes any previously defined date variables. Any variables with the
following names are deleted: year , quarter , month_, week , day , hour_,
minute_, second_, and date .

B Custom indicates the presence of custom date variables created with command
syntax (for example, a four-day workweek). This item merely reflects the current
state of the active dataset. Selecting it from the list has no effect.
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First Case Is. Defines the starting date value, which is assigned to the first case.
Sequential values, based on the time interval, are assigned to subsequent cases.

Periodicity at higher level. Indicates the repetitive cyclical variation, such as the number
of months in a year or the number of days in a week. The value displayed indicates the
maximum value you can enter.

A new numeric variable is created for each component that is used to define the date.
The new variable names end with an underscore. A descriptive string variable, date
is also created from the components. For example, if you selected Weeks, days, hours,
four new variables are created: week , day , hour , and date .

If date variables have already been defined, they are replaced when you define new
date variables that will have the same names as the existing date variables.

To Define Dates for Time Series Data

» From the menus choose:

Data
Define Dates...

» Select a time interval from the Cases Are list.

» Enter the value(s) that define the starting date for First Case Is, which determines the
date assigned to the first case.

Date Variables versus Date Format Variables

Date variables created with Define Dates should not be confused with date format
variables defined in the Variable view of the Data Editor. Date variables are used

to establish periodicity for time series data. Date format variables represent dates
and/or times displayed in various date/time formats. Date variables are simple integers
representing the number of days, weeks, hours, and so on, from a user-specified
starting point. Internally, most date format variables are stored as the number of
seconds from October 14, 1582.
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Create Time Series

The Create Time Series dialog box allows you to create new variables based on
functions of existing numeric time series variables. These transformed values are
useful in many time series analysis procedures.

Default new variable names are the first six characters of the existing variable used
to create it, followed by an underscore and a sequential number. For example, for the
variable price, the new variable name would be price I. The new variables retain any
defined value labels from the original variables.

Available functions for creating time series variables include differences, moving
averages, running medians, lag, and lead functions.

Figure 8-31
Create Time Series dialog box

demand New Variable(s):
income price_1=DIFF[price 1
month_ Paste
i =
year_ Beset |
~MName and Function Cancel |
Name: Iprice_1 Change |
Help |
Function:
T

Order: |1_ Spai: |1_

Current Periodicity: 12

To Create New Time Series Variables

» From the menus choose:

Transform
Create Time Series...

» Select the time series function that you want to use to transform the original variable(s).
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» Select the variable(s) from which you want to create new time series variables. Only
numeric variables can be used.

Optionally, you can:
®  Enter variable names to override the default new variable names.

m  Change the function for a selected variable.

Time Series Transformation Functions

Difference. Nonseasonal difference between successive values in the series. The
order is the number of previous values used to calculate the difference. Because one
observation is lost for each order of difference, system-missing values appear at the
beginning of the series. For example, if the difference order is 2, the first two cases
will have the system-missing value for the new variable.

Seasonal difference. Difference between series values a constant span apart. The span
is based on the currently defined periodicity. To compute seasonal differences, you
must have defined date variables (Data menu, Define Dates) that include a periodic
component (such as months of the year). The order is the number of seasonal periods
used to compute the difference. The number of cases with the system-missing value
at the beginning of the series is equal to the periodicity multiplied by the order. For
example, if the current periodicity is 12 and the order is 2, the first 24 cases will have
the system-missing value for the new variable.

Centered moving average. Average of a span of series values surrounding and including
the current value. The span is the number of series values used to compute the
average. If the span is even, the moving average is computed by averaging each pair
of uncentered means. The number of cases with the system-missing value at the
beginning and at the end of the series for a span of n is equal to n/2 for even span
values and for odd span values. For example, if the span is 5, the number of cases with
the system-missing value at the beginning and at the end of the series is 2.

Prior moving average. Average of the span of series values preceding the current value.
The span is the number of preceding series values used to compute the average. The
number of cases with the system-missing value at the beginning of the series is equal
to the span value.

Running median. Median of a span of series values surrounding and including the
current value. The span is the number of series values used to compute the median.
If the span is even, the median is computed by averaging each pair of uncentered
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medians. The number of cases with the system-missing value at the beginning and at
the end of the series for a span of n is equal to n/2 for even span values and for odd
span values. For example, if the span is 5, the number of cases with the system-missing
value at the beginning and at the end of the series is 2.

Cumulative sum. Cumulative sum of series values up to and including the current value.

Lag. Value of a previous case, based on the specified lag order. The order is the number
of cases prior to the current case from which the value is obtained. The number of cases
with the system-missing value at the beginning of the series is equal to the order value.

Lead. Value of a subsequent case, based on the specified lead order. The order is the
number of cases after the current case from which the value is obtained. The number of
cases with the system-missing value at the end of the series is equal to the order value.

Smoothing. New series values based on a compound data smoother. The smoother
starts with a running median of 4, which is centered by a running median of 2. It then
resmoothes these values by applying a running median of 5, a running median of 3,
and hanning (running weighted averages). Residuals are computed by subtracting the
smoothed series from the original series. This whole process is then repeated on the
computed residuals. Finally, the smoothed residuals are computed by subtracting

the smoothed values obtained the first time through the process. This is sometimes
referred to as T4253H smoothing.

Replace Missing Values

Missing observations can be problematic in analysis, and some time series measures
cannot be computed if there are missing values in the series. Sometimes the value for
a particular observation is simply not known. In addition, missing data can result
from any of the following:

m  Each degree of differencing reduces the length of a series by 1.
m  Each degree of seasonal differencing reduces the length of a series by one season.

m If you create new series that contain forecasts beyond the end of the existing series
(by clicking a Save button and making suitable choices), the original series and the
generated residual series will have missing data for the new observations.

®  Some transformations (for example, the log transformation) produce missing data
for certain values of the original series.
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Missing data at the beginning or end of a series pose no particular problem; they
simply shorten the useful length of the series. Gaps in the middle of a series (embedded
missing data) can be a much more serious problem. The extent of the problem depends
on the analytical procedure you are using.

The Replace Missing Values dialog box allows you to create new time series
variables from existing ones, replacing missing values with estimates computed with
one of several methods. Default new variable names are the first six characters of the
existing variable used to create it, followed by an underscore and a sequential number.
For example, for the variable price, the new variable name would be price 1. The new
variables retain any defined value labels from the original variables.

Figure 8-32

Replace Missing Values dialog box
demand iz vertel e -m
income
month_ Paste |
price
year_ Beset |

Cancel |

~MName and Method

Name: Idemand_1 Change | Help |

Method: IMean of nearby points j

Span of nearby points:

« Mumber: |2 oAl

To Replace Missing Values for Time Series Variables

From the menus choose:

Transform
Replace Missing Values...

Select the estimation method you want to use to replace missing values.

Select the variable(s) for which you want to replace missing values.
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Optionally, you can:
® Enter variable names to override the default new variable names.

m  Change the estimation method for a selected variable.

Estimation Methods for Replacing Missing Values

Series mean. Replaces missing values with the mean for the entire series.

Mean of nearby points. Replaces missing values with the mean of valid surrounding
values. The span of nearby points is the number of valid values above and below the
missing value used to compute the mean.

Median of nearby points. Replaces missing values with the median of valid surrounding
values. The span of nearby points is the number of valid values above and below the
missing value used to compute the median.

Linear interpolation. Replaces missing values using a linear interpolation. The last
valid value before the missing value and the first valid value after the missing value are
used for the interpolation. If the first or last case in the series has a missing value, the
missing value is not replaced.

Linear trend at point. Replaces missing values with the linear trend for that point. The
existing series is regressed on an index variable scaled 1 to n. Missing values are
replaced with their predicted values.

Scoring Data with Predictive Models

The process of applying a predictive model to a set of data is referred to as scoring
the data. SPSS, Clementine, and AnswerTree have procedures for building predictive
models such as regression, clustering, tree, and neural network models. Once a model
has been built, the model specifications can be saved as an XML file containing all of
the information necessary to reconstruct the model. The SPSS Server product then
provides the means to read an XML model file and apply the model to a dataset.

Example. A credit application is rated for risk based on various aspects of the applicant
and the loan in question. The credit score obtained from the risk model is used to
accept or reject the loan application.
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Scoring is treated as a transformation of the data. The model is expressed internally as
a set of numeric transformations to be applied to a given set of variables—the predictor
variables specified in the model—in order to obtain a predicted result. In this sense,
the process of scoring data with a given model is inherently the same as applying any
function, such as a square root function, to a set of data.

Scoring is only available with SPSS Server and can be done interactively by users
working in distributed analysis mode. For scoring large data files you’ll probably want
to make use of the SPSS Batch Facility, a separate executable version of SPSS provided
with SPSS Server. For information about using the SPSS Batch Facility, see the SPSS
Batch Facility User s Guide, provided as a PDF file on the SPSS Server product CD.

The scoring process consists of the following:
Loading a model from a file in XML (PMML) format.

Computing your scores as a new variable, using the ApplyModel or StrApplyModel
function available in the Compute Variable dialog box.

For details concerning the ApplyModel or StrApplyModel function, see Scoring
Expressions in the Transformation Expressions section of the SPSS Command Syntax
Reference.

The following table lists the SPSS procedures that support the export of model
specifications to XML. The exported models can be used with SPSS Server to score
new data as described above. The full list of model types that can be scored with SPSS
Server is provided in the description of the ApplyModel function.

Procedure Name Command Name SPSS Option
Discriminant DISCRIMINANT Base

Linear Regression REGRESSTON Base

TwoStep Cluster TWOSTEP CLUSTER Base

Generalized Linear Models GENLIN Advanced Models
Complex Samples General Linear CSGLM Complex Samples
Model

Complex Samples Logistic CSLOGISTIC Complex Samples
Regression

Complex Samples Ordinal CSORDINAL Complex Samples
Regression

Logistic Regression LOGISTIC REGRESSION Regression
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Procedure Name

Command Name

SPSS Option

Multinomial Logistic Regression

NOMREG

Regression

Classification Tree

TREE

Tree

Loading a Saved Model

The Load Model dialog box allows you to load predictive models saved in XML
(PMML) format and is only available when working in distributed analysis mode.
Loading models is a necessary first step to scoring data with them.

Figure 8-33
Load Model output
hdadel “ariables
SPES Variahles Mame Lakel Type Wickth Role hessurement
Aoe_Group Aoge_Graup Age group Mumeric & | Factar Plotningl
F
renuEncy Freguency Mumber of purchases | Mumeric 7| Covariste | Continuous
Fender Gender Gender String 6 | Factor Morminal
Has_Broadband Haz_Broadband Has hon?e broadhand Mumeric 10 | Factor motminal
connection
Haz_Child Has_Chiled Hasz children Mumeric 10 | Factar Tarniral
Income_Group Income_Group Income group Mumeric 10 | Factor Tarninal
Log_Amourt X
g_Amau Log_Amount Log-transformed Mumeric & | Covariste | Continuous
amaurt
Recenc i
¥ Recency Days since last Mumeric 10 | Covariste | Continuous
purchase
Response Response Responze Mumeric 10 | Target Tarminal
To Load a Model

» From the menus choose:

Transform
Prepare Model
Load Model...
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Figure 8-34
Prepare Model Load Model dialog box

Prepare Model: Load Model

Mame: | mregression K

Ciimultinomial_logistic_merged. xml Paste

Missing Walues
Cancel

(%) Use Yalue Substitution
Help

E

(:) Use System-Missing

To apply this model, use the SPS5 Server Only
functions: ApplyModel or StrapplyMadel located in
Compute Transfarmm.

» Enter a name to associate with this model. Each loaded model must have a unique
name.

» Click File and select a model file. The resulting Open File dialog box displays the files
that are available in distributed analysis mode. This includes files on the machine
where SPSS Server is installed and files on your local computer that reside in shared
folders or on shared drives.

Note: When you score data, the model will be applied to variables in the active dataset
with the same names as the variables from the model file. You can map variables in
the original model to different variables in the active dataset with the use of command
syntax (see the MODEL, HANDLE command).

Name. A name used to identify this model. The rules for valid model names are the
same as for SPSS variable names (see Variable Names in Chapter 5 on p. 105), with
the addition of the $ character as an allowed first character. You will use this name
to specify the model when scoring data with the ApplyModel or StrApplyModel
functions.

File. The XML (PMML) file containing the model specifications.
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Missing Values

This group of options controls the treatment of missing values, encountered during
the scoring process, for the predictor variables defined in the model. A missing value
in the context of scoring refers to one of the following:

A predictor variable contains no value. For numeric variables, this means the
system-missing value. For string variables, this means a null string.

The value has been defined as user-missing, in the model, for the given predictor.
Values defined as user-missing in the active dataset, but not in the model, are not
treated as missing values in the scoring process.

The predictor variable is categorical and the value is not one of the categories
defined in the model.

Use Value Substitution. Attempt to use value substitution when scoring cases with
missing values. The method for determining a value to substitute for a missing value
depends on the type of predictive model.

SPSS Models. For independent variables in linear regression and discriminant
models, if mean value substitution for missing values was specified when building
and saving the model, then this mean value is used in place of the missing value in
the scoring computation, and scoring proceeds. If the mean value is not available,
then the system-missing value is returned.

AnswerTree models & SPSS TREE command models. For the CHAID and Exhaustive
CHAID models, the biggest child node is selected for a missing split variable.
The biggest child node is the one with the largest population among the child
nodes using learning sample cases. For C&RT and QUEST models, surrogate split
variables (if any) are used first. (Surrogate splits are splits that attempt to match
the original split as closely as possible using alternate predictors.) If no surrogate
splits are specified or all surrogate split variables are missing, the biggest child
node is used.

Clementine models. Linear regression models are handled as described under SPSS
models. Logistic regression models are handled as described under Logistic
Regression models. C&RT Tree models are handled as described for C&RT
models under AnswerTree models.

Logistic Regression models. For covariates in logistic regression models, if a
mean value of the predictor was included as part of the saved model, then this
mean value is used in place of the missing value in the scoring computation, and
scoring proceeds. If the predictor is categorical (for example, a factor in a logistic
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regression model), or if the mean value is not available, then the system-missing
value is returned.

Use System-Missing. Return the system-missing value when scoring a case with a
missing value.

Displaying a List of Loaded Models

You can obtain a list of the currently loaded models. From the menus (only available
in distributed analysis mode) choose:

Transform
Prepare Model
List Model(s)

This will generate a Model Handles table. The table contains a list of all currently
loaded models and includes the name (referred to as the model handle) assigned to

the model, the type of model, the path to the model file, and the method for handling
missing values.

Figure 8-35
Listing of loaded models

Model Handles

Walidation
Mame Type Input File Mame handling Wizsing handling
mregression MOMREG Chmodelzimregression . xml O SUBSTITUTE
tree TREE Crmodelstree xml Oh SUBSTITUTE

Additional Features Available with Command Syntax

From the Load Model dialog box, you can paste your selections into a syntax window
and edit the resulting MODEL, HANDLE command syntax. This allows you to:

m  Map variables in the original model to different variables in the active dataset (with
the MAP subcommand). By default, the model is applied to variables in the active
dataset with the same names as the variables from the model file.

See the SPSS Command Syntax Reference for complete syntax information.
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Data files are not always organized in the ideal form for your specific needs. You
may want to combine data files, sort the data in a different order, select a subset of
cases, or change the unit of analysis by grouping cases together. A wide range of file
transformation capabilities is available, including the ability to:

Sort data. You can sort cases based on the value of one or more variables.

Transpose cases and variables. The SPSS data file format reads rows as cases and
columns as variables. For data files in which this order is reversed, you can switch the
rows and columns and read the data in the correct format.

Merge files. You can merge two or more data files. You can combine files with the
same variables but different cases or the same cases but different variables.

Select subsets of cases. You can restrict your analysis to a subset of cases or perform
simultaneous analyses on different subsets.

Aggregate data. You can change the unit of analysis by aggregating cases based on the
value of one or more grouping variables.

Weight data. Weight cases for analysis based on the value of a weight variable.

Restructure data. You can restructure data to create a single case (record) from multiple
cases or create multiple cases from a single case.

Sort Cases

This dialog box sorts cases (rows) of the data file based on the values of one or more
sorting variables. You can sort cases in ascending or descending order.

216
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m If you select multiple sort variables, cases are sorted by each variable within
categories of the preceding variable on the Sort list. For example, if you select
gender as the first sorting variable and minority as the second sorting variable,
cases will be sorted by minority classification within each gender category.

B The sort sequence is based on the locale-defined order (and is not necessarily the
same as the numerical order of the character codes). The default locale is the
operating system locale. You can control the locale with the Language setting on
the General tab of the Options dialog box (Edit menu).

Figure 9-1
Sort Cases dialog box

i Sort Cases

educ gender [4)

id minority [4] Paste |

jobcat

jobtime Reset |

name >

prevexp O (e Cancel |

33:2"!’_ * Ascending

salbegin |
. " Descending Help

To Sort Cases

» From the menus choose:

Data
Sort Cases...

» Select one or more sorting variables.

Transpose

Transpose creates a new data file in which the rows and columns in the original data
file are transposed so that cases (rows) become variables and variables (columns)
become cases. Transpose automatically creates new variable names and displays a
list of the new variable names.

B A new string variable that contains the original variable name, case [bl, is
automatically created.
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m [f the active dataset contains an ID or name variable with unique values, you can
use it as the name variable, and its values will be used as variable names in the
transposed data file. If it is a numeric variable, the variable names start with the
letter V, followed by the numeric value.

m  User-missing values are converted to the system-missing value in the transposed
data file. To retain any of these values, change the definition of missing values in
the Variable View in the Data Editor.

To Transpose Variables and Cases

» From the menus choose:

Data
Transpose...

» Select one or more variables to transpose into cases.

Merging Data Files

You can merge data from two files in two different ways. You can:

m  Merge the active dataset with another open dataset or SPSS-format data file
containing the same variables but different cases.

m  Merge the active dataset with another open dataset or SPSS-format data file
containing the same cases but different variables.

To Merge Files

» From the menus choose:

Data
Merge Files

» Select Add Cases or Add Variables.
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Figure 9-2
Selecting files to merge

Add Cases to regiont.sav [DataSet1]

Select a dataset from the lisk of open dakaset or from & file bo merge with the active
dataset

(%) an open dataset

reqionz,say [Dakagekz]

() an external SPSS data file

Mon-5P53 data files must be opened in SPSS before they can be used as park of a merge.

Continue ] [ Cancel ][ Help

Add Cases

Add Cases merges the active dataset with a second dataset or SPSS-format data file
that contains the same variables (columns) but different cases (rows). For example,

you might record the same information for customers in two different sales regions

and maintain the data for each region in separate files. The second dataset can be an
external SPSS-format data file or a dataset available in the current session.
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Figure 9-3
Add Cases dialog box
Add Cases from region2.sav
Unpaired Yariables: “ariables in Mew Active Dataset:
datebrth [ name
awhrent [ age
zex [ \:l eduyrs
brthdate [+) famzize
zERd [+] income
jobcat
rarital
[JIndicate case sounce as variabls;

[*] = Active datazet
[+] = region2. zav

[ [1]4 l ’Easte] [Beset] [Cancel] [ Help ]

Unpaired Variables. Variables to be excluded from the new, merged data file. Variables
from the active dataset are identified with an asterisk (*). Variables from the other
dataset are identified with a plus sign (+). By default, this list contains:

Variables from either data file that do not match a variable name in the other

file. You can create pairs from unpaired variables and include them in the new,
merged file.

Variables defined as numeric data in one file and string data in the other file.
Numeric variables cannot be merged with string variables.

String variables of unequal width. The defined width of a string variable must
be the same in both data files.

Variables in New Active Dataset. Variables to be included in the new, merged data file.
By default, all of the variables that match both the name and the data type (numeric or
string) are included on the list.

You can remove variables from the list if you do not want them to be included
in the merged file.

Any unpaired variables included in the merged file will contain missing data for
cases from the file that does not contain that variable.
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Indicate case source as variable. Indicates the source data file for each case. This
variable has a value of 0 for cases from the active dataset and a value of 1 for cases
from the external data file.

To Merge Data Files with the Same Variables and Different Cases

Open at least one of the data files that you want to merge. If you have multiple datasets
open, make one of the datasets that you want to merge the active dataset. The cases
from this file will appear first in the new, merged data file.

From the menus choose:

Data
Merge Files
Add Cases...

Select the dataset or SPSS-format data file to merge with the active dataset.

Remove any variables that you do not want from the Variables in New Active Dataset
list.

Add any variable pairs from the Unpaired Variables list that represent the same
information recorded under different variable names in the two files. For example, date
of birth might have the variable name brthdate in one file and datebrth in the other file.

To Select a Pair of Unpaired Variables
Click one of the variables on the Unpaired Variables list.

Ctrl-click the other variable on the list. (Press the Ctrl key and click the left mouse
button at the same time.)

Click Pair to move the variable pair to the Variables in New Active Dataset list. (The
variable name from the active dataset is used as the variable name in the merged file.)
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Figure 9-4
Selecting pairs of variables with Ctrl-click
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Add Cases: Rename

You can rename variables from either the active dataset or the other dataset before
moving them from the unpaired list to the list of variables to be included in the merged

data file. Renaming variables enables you to:

m  Use the variable name from the other dataset rather than the name from the active
dataset for variable pairs.

Include two variables with the same name but of unmatched types or different
string widths. For example, to include both the numeric variable sex from the
active dataset and the string variable sex from the other dataset, one of them must

be renamed first.
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Add Cases: Dictionary Information

Any existing dictionary information (variable and value labels, user-missing values,
display formats) in the active dataset is applied to the merged data file.

m [f any dictionary information for a variable is undefined in the active dataset,
dictionary information from the other dataset is used.

m [f the active dataset contains any defined value labels or user-missing values for
a variable, any additional value labels or user-missing values for that variable in
the other dataset are ignored.

Merging More Than Two Data Sources

Using command syntax, you can merge up to 50 datasets and/or data files. For more

information, see the ADD FILES command in the SPSS Command Syntax Reference
(available from the Help menu).

Add Variables

Add Variables merges the active dataset with another open dataset or SPSS-format
data file that contains the same cases (rows) but different variables (columns). For

example, you might want to merge a data file that contains pre-test results with one
that contains post-test results.

m Cases must be sorted in the same order in both datasets.

m [f one or more key variables are used to match cases, the two datasets must be
sorted by ascending order of the key variable(s).

B Variable names in the second data file that duplicate variable names in the active

dataset are excluded by default because Add Variables assumes that these variables
contain duplicate information.

Indicate case source as variable. Indicates the source data file for each case. This
variable has a value of 0 for cases from the active dataset and a value of 1 for cases
from the external data file.
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Figure 9-5
Add Variables dialog box
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Excluded Variables. Variables to be excluded from the new, merged data file. By
default, this list contains any variable names from the other dataset that duplicate
variable names in the active dataset. Variables from the active dataset are identified
with an asterisk (*). Variables from the other dataset are identified with a plus sign (+).
If you want to include an excluded variable with a duplicate name in the merged file,
you can rename it and add it to the list of variables to be included.

New Active Dataset. Variables to be included in the new, merged dataset. By default,
all unique variable names in both datasets are included on the list.

Key Variables. If some cases in one dataset do not have matching cases in the other
dataset (that is, some cases are missing in one dataset), use key variables to identify
and correctly match cases from the two datasets. You can also use key variables with
table lookup files.

m  The key variables must have the same names in both datasets.

m  Both datasets must be sorted by ascending order of the key variables, and the order
of variables on the Key Variables list must be the same as their sort sequence.

m  Cases that do not match on the key variables are included in the merged file but are
not merged with cases from the other file. Unmatched cases contain values for
only the variables in the file from which they are taken; variables from the other
file contain the system-missing value.
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Non-active or active dataset is keyed table. A keyed table, or table lookup file, is a file
in which data for each “case” can be applied to multiple cases in the other data file.
For example, if one file contains information on individual family members (such

as sex, age, education) and the other file contains overall family information (such

as total income, family size, location), you can use the file of family data as a table
lookup file and apply the common family data to each individual family member

in the merged data file.

To Merge Files with the Same Cases but Different Variables

» Open at least one of the data files that you want to merge. If you have multiple datasets
open, make one of the datasets that you want to merge the active dataset.

» From the menus choose:

Data
Merge Files
Add Variables...

» Select the dataset or SPSS-format data file to merge with the active dataset.

To Select Key Variables
» Select the variables from the external file variables (+) on the Excluded Variables list.
» Select Match cases on key variables in sorted files.

» Add the variables to the Key Variables list.

The key variables must exist in both the active dataset and the other dataset. Both
datasets must be sorted by ascending order of the key variables, and the order of
variables on the Key Variables list must be the same as their sort sequence.

Add Variables: Rename

You can rename variables from either the active dataset or the other dataset before
moving them to the list of variables to be included in the merged data file. This is
primarily useful if you want to include two variables with the same name that contain
different information in the two files.



226

Chapter 9

Merging More Than Two Data Sources

Using command syntax, you can merge up to 50 datasets and/or data files. For more
information, see the MATCH FILES command in the SPSS Command Syntax Reference
(available from the Help menu).

Aggregate Data

Aggregate Data aggregates groups of cases in the active dataset into single cases
and creates a new, aggregated file or creates new variables in the active dataset that
contain aggregated data. Cases are aggregated based on the value of one or more
break (grouping) variables.

m [f you create a new, aggregated data file, the new data file contains one case for
each group defined by the break variables. For example, if there is one break
variable with two values, the new data file will contain only two cases.

m If you add aggregate variables to the active dataset, the data file itself is not
aggregated. Each case with the same value(s) of the break variable(s) receives
the same values for the new aggregate variables. For example, if gender is the
only break variable, all males would receive the same value for a new aggregate
variable that represents average age.
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Figure 9-6
Aggregate Data dialog box
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Break Variable(s). Cases are grouped together based on the values of the break
variables. Each unique combination of break variable values defines a group. When
creating a new, aggregated data file, all break variables are saved in the new file with
their existing names and dictionary information. The break variable can be either
numeric or string.

Aggregated Variables. Source variables are used with aggregate functions to create
new aggregate variables. The aggregate variable name is followed by an optional
variable label in quotes, the name of the aggregate function, and the source variable
name in parentheses.
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You can override the default aggregate variable names with new variable names,
provide descriptive variable labels, and change the functions used to compute the
aggregated data values. You can also create a variable that contains the number of
cases in each break group.

To Aggregate a Data File

From the menus choose:

Data
Aggregate...

Select one or more break variables that define how cases are grouped to create
aggregated data.

Select one or more aggregate variables.

Select an aggregate function for each aggregate variable.

Saving Aggregated Results

You can add aggregate variables to the active dataset or create a new, aggregated
data file.

m  Add aggregated variables to active dataset. New variables based on aggregate
functions are added to the active dataset. The data file itself is not aggregated.
Each case with the same value(s) of the break variable(s) receives the same values
for the new aggregate variables.

m Create a new dataset containing only the aggregated variables. Saves aggregated
data to a new dataset in the current session. The dataset includes the break
variables that define the aggregated cases and all aggregate variables defined by
aggregate functions. The active dataset is unaffected.

m  Write a new data file containing only the aggregated variables. Saves aggregated
data to an external data file. The file includes the break variables that define the
aggregated cases and all aggregate variables defined by aggregate functions. The
active dataset is unaffected.

Sorting Options for Large Data Files

For very large data files, it may be more efficient to aggregate presorted data.
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File is already sorted on break variable(s). If the data have already been sorted by values
of the break variables, this option enables the procedure to run more quickly and use
less memory. Use this option with caution.

m  Data must by sorted by values of the break variables in the same order as the break
variables specified for the Aggregate Data procedure.

m [fyou are adding variables to the active dataset, select this option only if the data
are sorted by ascending values of the break variables.

Sort file before aggregating. In very rare instances with large data files, you may find it
necessary to sort the data file by values of the break variables prior to aggregating. This
option is not recommended unless you encounter memory or performance problems.

Aggregate Data: Aggregate Function

This dialog box specifies the function to use to calculate aggregated data values for
selected variables on the Aggregate Variables list in the Aggregate Data dialog box.
Aggregate functions include:

B Summary functions for numeric variables, including mean, median, standard
deviation, and sum.

B Number of cases, including unweighted, weighted, nonmissing, and missing
m Percentage or fraction of values above or below a specified value

m Percentage or fraction of values inside or outside of a specified range



230

Chapter 9

Figure 9-7

Aggregate Function dialog box
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Aggregate Data: Variable Name and Label

Aggregate Data assigns default variable names for the aggregated variables in the new
data file. This dialog box enables you to change the variable name for the selected
variable on the Aggregate Variables list and provide a descriptive variable label. For
more information, see Variable Names in Chapter 5 on p. 105.

Figure 9-8
Variable Name and Label dialog box
SUM[pop33) Continue |
Name: IW Cancel |
Label: IState Population 1993 Help |
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Split File splits the data file into separate groups for analysis based on the values

of one or more grouping variables. If you select multiple grouping variables, cases
are grouped by each variable within categories of the preceding variable on the
Groups Based On list. For example, if you select gender as the first grouping variable
and minority as the second grouping variable, cases will be grouped by minority

classification within each gender category.

B You can specify up to eight grouping variables.

m  Each eight characters of a long string variable (string variables longer than eight

characters) counts as a variable toward the limit of eight grouping variables.

m  Cases should be sorted by values of the grouping variables and in the same order
that variables are listed in the Groups Based On list. If the data file isn’t already

sorted, select Sort the file by grouping variables.

Figure 9-9
Split File dialog box

: Split File
bdate " Analyze all cases, do not create groups 0K |
educ * Compare groups
id ~omp group Paste |
jobcat " Organize output by groups
]u.htlmle Groups Based on: Reset |
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salary Help |
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© Sort the file by grouping wvariables

" File is already sorted

Current Status: Organize output by:gender

Compare groups. Split-file groups are presented together for comparison purposes. For
pivot tables, a single pivot table is created and each split-file variable can be moved

between table dimensions. For charts, a separate chart is created for each split-file
group and the charts are displayed together in the Viewer.
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Organize output by groups. All results from each procedure are displayed separately
for each split-file group.

To Split a Data File for Analysis
From the menus choose:
Data

Split File...

Select Compare groups or Organize output by groups.

Select one or more grouping variables.

Select Cases

Select Cases provides several methods for selecting a subgroup of cases based on
criteria that include variables and complex expressions. You can also select a random
sample of cases. The criteria used to define a subgroup can include:

Variable values and ranges
Date and time ranges
Case (row) numbers
Arithmetic expressions

Logical expressions

Functions
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Figure 9-10
Select Cases dialog box
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All cases. Turns case filtering off and uses all cases.

If condition is satisfied. Use a conditional expression to select cases. If the result of
the conditional expression is true, the case is selected. If the result is false or missing,
the case is not selected.

Random sample of cases. Sclects a random sample based on an approximate percentage
or an exact number of cases.

Based on time or case range. Selects cases based on a range of case numbers or a
range of dates/times.

Use filter variable. Use the selected numeric variable from the data file as the filter
variable. Cases with any value other than O or missing for the filter variable are
selected.
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Output

This section controls the treatment of unselected cases. You can choose one of the
following alternatives for the treatment of unselected cases:

m Filter out unselected cases. Unselected cases are not included in the analysis but
remain in the dataset. You can use the unselected cases later in the session if you
turn filtering off. If you select a random sample or if you select cases based on a
conditional expression, this generates a variable named filter § with a value of 1
for selected cases and a value of 0 for unselected cases.

m  Copy selected cases to a new dataset. Selected cases are copied to a new dataset,
leaving the original dataset unaffected. Unselected cases are not included in the
new dataset and are left in their original state in the original dataset.

m Delete unselected cases. Unselected cases are deleted from the dataset. Deleted
cases can be recovered only by exiting from the file without saving any changes
and then reopening the file. The deletion of cases is permanent if you save the
changes to the data file. Note: If you delete unselected cases and save the file,
the cases cannot be recovered.

To Select a Subset of Cases
» From the menus choose:
Data
Select Cases...

» Select one of the methods for selecting cases.

» Specify the criteria for selecting cases.

Select Cases: If

This dialog box allows you to select subsets of cases using conditional expressions. A
conditional expression returns a value of true, false, or missing for each case.
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Figure 9-1
Select Cases If dialog box
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m  [f the result of a conditional expression is true, the case is included in the selected
subset.

m If the result of a conditional expression is false or missing, the case is not included
in the selected subset.

®  Most conditional expressions use one or more of the six relational operators (<, >,
<=, >=, =, and ~=) on the calculator pad.

m  Conditional expressions can include variable names, constants, arithmetic
operators, numeric (and other) functions, logical variables, and relational operators.

Select Cases: Random Sample

This dialog box allows you to select a random sample based on an approximate
percentage or an exact number of cases. Sampling is performed without replacement;
so, the same case cannot be selected more than once.

Figure 9-12

Select Cases Random Sample dialog box
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Approximately. Generates a random sample of approximately the specified percentage
of cases. Since this routine makes an independent pseudo-random decision for each
case, the percentage of cases selected can only approximate the specified percentage.
The more cases there are in the data file, the closer the percentage of cases selected
is to the specified percentage.

Exactly. A user-specified number of cases. You must also specify the number of cases
from which to generate the sample. This second number should be less than or equal
to the total number of cases in the data file. If the number exceeds the total number
of cases in the data file, the sample will contain proportionally fewer cases than the
requested number.

Select Cases: Range

This dialog box selects cases based on a range of case numbers or a range of dates
or times.

m  Case ranges are based on row number as displayed in the Data Editor.

m Date and time ranges are available only for time series data with defined date
variables (Data menu, Define Dates).

Figure 9-13
Select Cases Range dialog box for range of cases (no defined date variables)
_ | Select Cases: Range

First Case  Last Case
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Cancel
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Select Cases Range dialog box for time series data with defined date variables

I Select Cases: Range

First Case
Wieek:
Day:

Last Case

Cancel

Weight Cases

Weight Cases gives cases different weights (by simulated replication) for statistical

analysis.

B The values of the weighting variable should indicate the number of observations

represented by single cases in your data file.

m  Cases with zero, negative, or missing values for the weighting variable are

excluded from analysis.

m  Fractional values are valid; they are used exactly where this is meaningful and

most likely where cases are tabulated.

Figure 9-15

Weight Cases dialog box
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>

Once you apply a weight variable, it remains in effect until you select another weight
variable or turn off weighting. If you save a weighted data file, weighting information
is saved with the data file. You can turn off weighting at any time, even after the file
has been saved in weighted form.

Weights in Crosstabs. The Crosstabs procedure has several options for handling case
weights. For more information, see Crosstabs Cell Display in Chapter 17 on p. 372.

Weights in scatterplots and histograms. Scatterplots and histograms have an option for
turning case weights on and off, but this does not affect cases with a zero, negative, or
missing value for the weight variable. These cases remain excluded from the chart
even if you turn weighting off from within the chart.

To Weight Cases

From the menus choose:

Data
Weight Cases...

Select Weight cases by.

Select a frequency variable.

The values of the frequency variable are used as case weights. For example, a case
with a value of 3 for the frequency variable will represent three cases in the weighted
data file.

Restructuring Data

Use the Restructure Data Wizard to restructure your data for the SPSS procedure
that you want to use. The wizard replaces the current file with a new, restructured
file. The wizard can:

B Restructure selected variables into cases.
m Restructure selected cases into variables.

m  Transpose all data.
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To Restructure Data

» From the menus choose:

Data
Restructure...

» Select the type of restructuring that you want to do.

» Select the data to restructure.

Optionally, you can:

m  Create identification variables, which allow you to trace a value in the new file
back to a value in the original file.

m  Sort the data prior to restructuring.
®  Define options for the new file.

m  Paste the command syntax into a syntax window.

Restructure Data Wizard: Select Type

Use the Restructure Data Wizard to restructure your data. In the first dialog box, select
the type of restructuring that you want to do.
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Figure 9-16
Restructure Data Wizard
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m  Restructure selected variables into cases. Choose this when you have groups of
related columns in your data and you want them to appear in groups of rows in the

new data file. If you choose this, the wizard will display the steps for Variables
to Cases.

m  Restructure selected cases into variables. Choose this when you have groups of
related rows in your data and you want them to appear in groups of columns in

the new data file. If you choose this, the wizard will display the steps for Cases
to Variables.

m  Transpose all data. Choose this when you want to transpose your data. All rows will
become columns and all columns will become rows in the new data. This choice
closes the Restructure Data Wizard and opens the Transpose Data dialog box.
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Deciding How to Restructure the Data

A variable contains information that you want to analyze—for example, a
measurement or a score. A case is an observation—for example, an individual. In a
simple data structure, each variable is a single column in your data and each case is
a single row. So, for example, if you were measuring test scores for all students in a
class, all score values would appear in only one column, and there would be a row for
each student.
When you analyze data, you are often analyzing how a variable varies according
to some condition. The condition can be a specific experimental treatment, a
demographic, a point in time, or something else. In data analysis, conditions of interest
are often referred to as factors. When you analyze factors, you have a complex data
structure. You may have information about a variable in more than one column in your
data (for example, a column for each level of a factor), or you may have information
about a case in more than one row (for example, a row for each level of a factor). The
Restructure Data Wizard helps you to restructure files with a complex data structure.
The structure of the current file and the structure that you want in the new file
determine the choices that you make in the wizard.

How are the data arranged in the current file? The current data may be arranged so that
factors are recorded in a separate variable (in groups of cases) or with the variable
(in groups of variables).

m  Groups of cases. Does the current file have variables and conditions recorded in
separate columns? For example:

var factor
8 1
9 1
3 2
1 2
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In this example, the first two rows are a case group because they are related. They
contain data for the same factor level. In SPSS data analysis, the factor is often referred
to as a grouping variable when the data are structured this way.

®  Groups of columns. Does the current file have variables and conditions recorded in
the same column? For example:

var_1 var_2
8 3
9 1

In this example, the two columns are a variable group because they are related. They
contain data for the same variable—var I for factor level 1 and var 2 for factor level
2. In SPSS data analysis, the factor is often referred to as a repeated measure when
the data are structured this way.

How should the data be arranged in the new file? This is usually determined by the
procedure that you want to use to analyze your data.

m  Procedures that require groups of cases. Your data must be structured in case
groups to do analyses that require a grouping variable. Examples are univariate,
multivariate, and variance components with General Linear Model, Mixed
Models, and OLAP Cubes; and independent samples with T Test or Nonparametric
Tests. If your current data structure is variable groups and you want to do these
analyses, select Restructure selected variables into cases.

®  Procedures that require groups of variables. Your data must be structured in variable
groups to analyze repeated measures. Examples are repeated measures with
General Linear Model, time-dependent covariate analysis with Cox Regression
Analysis, paired samples with T Test, or related samples with Nonparametric
Tests. If your current data structure is case groups and you want to do these
analyses, select Restructure selected cases into variables.

Example of Variables to Cases

In this example, test scores are recorded in separate columns for each factor, 4 and B.



243

File Handling and File Transformations

Figure 9-17

Current data for variables to cases

score_a score_h
1014.00 aG4 .00
3400 G3E.00
310.00 F33.00

—

)

o

You want to do an independent-samples ¢ test. You have a column group consisting of
score_a and score_b, but you don’t have the grouping variable that the procedure
requires. Select Restructure selected variables into cases in the Restructure Data Wizard,
restructure one variable group into a new variable named score, and create an index
named group. The new data file is shown in the following figure.

Figure 9-18
New, restructured data for variables to cases
graup scare

SCORE_A 1014.00
SCORE_B gE4.00
SCORE_A BG4.00
SCORE_BE B36.00
SCORE_A 810.00
SCORE_B 633.00

o e o b —

When you run the independent-samples ¢ test, you can now use group as the grouping
variable.

Example of Cases to Variables

In this example, test scores are recorded twice for each subject—before and after a

treatment.
Figure 9-19
Current data for cases to variables
id scor tirme
1 1 1014.00 |bef
2 1 864,00 | aft
3 2 G4 .00 | hef
4 2 F3E.00 | aft

You want to do a paired-samples ¢ test. Your data structure is case groups, but you
don’t have the repeated measures for the paired variables that the procedure requires.
Select Restructure selected cases into variables in the Restructure Data Wizard, use
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id to identify the row groups in the current data, and use time to create the variable
group in the new file.

Figure 9-20
New, restructured data for cases to variables
id aft hef
1 1 a4 .00 1014.00
2 2 536.00 G54.00

When you run the paired-samples # test, you can now use bef and aft as the variable pair.

Restructure Data Wizard (Variables to Cases): Number of Variable Groups

Note: The wizard presents this step if you choose to restructure variable groups into
rows.

In this step, decide how many variable groups in the current file that you want to
restructure in the new file.

How many variable groups are in the current file? Think about how many variable
groups exist in the current data. A group of related columns, called a variable group,
records repeated measures of the same variable in separate columns. For example, if
you have three columns in the current data—w/, w2, and w3—that record width,
you have one variable group. If you have an additional three columns—#/, 42, and
h3—that record height, you have two variable groups.

How many variable groups should be in the new file? Consider how many variable
groups you want to have represented in the new data file. You do not have to
restructure all variable groups into the new file.
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Figure 9-21
Restructure Data Wizard: Number of Variable Groups, Step 2

Restructure Data Wizard - Step 2 of 7 m

Yanables to Cases: Mumber of Yariable Groups

“You have chosen to restructure selected vanables into groups of related cazes inthe new file.

o A group of related variables, called a vaniable group, represents measurements on one variable.

For example, the wariable may be width. |f it iz recorded in three separate measurements, each one
reprezenting & different point in time--w1, w2, and w3, then the data are arranged in a group of vaniables.

If there iz mare than one variable in the file often it iz also recorded in a variable group, for exanmple height,
recorded in b, h2, and h3.

Howy many variable groups do you want to restructure?

& One [for example, wi, w2, and w3}

= Mare than one [for example, wl, w2, w3 and 1, h2, h3, etc)

How b anp I2

< Back I Mewt » I Firizh | Cancel | Help |

m  One. The wizard will create a single restructured variable in the new file from
one variable group in the current file.

®  More than one. The wizard will create multiple restructured variables in the new

file. The number that you specify affects the next step, in which the wizard
automatically creates the specified number of new variables.

Restructure Data Wizard (Variables to Cases): Select Variables

Note: The wizard presents this step if you choose to restructure variable groups into
rows.
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In this step, provide information about how the variables in the current file should be
used in the new file. You can also create a variable that identifies the rows in the
new file.

Figure 9-22
Restructure Data Wizard: Select Variables, Step 3

Variables to Cases: Select Variables

For each variable group you have in the cument data the restructured file will have one target vanable.

In thiz step, chooze how to identify caze groups in the restructured data, and choose which wariables belong with
each target variable.

Optionally, you can alzo choose variables to copy to the new file as Fised Yariables.

“anables in the Current File: o
— Caze Group |dentification
@ score_a

-
4 score_b Use case number J

Mame: Iid Lakel.. |

— " anables to be Transpozed
Target Y anable: I sCOre j

&

Eixed % anablefs):

¢ Back | et | Eirish | Cancel | Help |

How should the new rows be identified? You can create a variable in the new data

file that identifies the row in the current data file that was used to create a group of
new rows. The identifier can be a sequential case number or it can be the values of
the variable. Use the controls in Case Group Identification to define the identification
variable in the new file. Click a cell to change the default variable name and provide a
descriptive variable label for the identification variable.

What should be restructured in the new file? In the previous step, you told the wizard
how many variable groups you want to restructure. The wizard created one new
variable for each group. The values for the variable group will appear in that variable
in the new file. Use the controls in Variables to be Transposed to define the restructured
variable in the new file.
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To Specify One Restructured Variable

Put the variables that make up the variable group that you want to transform into
the Variables to be Transposed list. All of the variables in the group must be of the
same type (numeric or string).

You can include the same variable more than once in the variable group (variables are
copied rather than moved from the source variable list); its values are repeated in
the new file.

To Specify Multiple Restructured Variables

Select the first target variable that you want to define from the Target Variable
drop-down list.

Put the variables that make up the variable group that you want to transform into the
Variables to be Transposed list. All of the variables in the group must be of the same
type (numeric or string). You can include the same variable more than once in the
variable group. (A variable is copied rather than moved from the source variable list,
and its values are repeated in the new file.)

Select the next target variable that you want to define, and repeat the variable selection
process for all available target variables.

®  Although you can include the same variable more than once in the same target
variable group, you cannot include the same variable in more than one target
variable group.

m  Each target variable group list must contain the same number of variables.
(Variables that are listed more than once are included in the count.)

®  The number of target variable groups is determined by the number of variable
groups that you specified in the previous step. You can change the default variable
names here, but you must return to the previous step to change the number of
variable groups to restructure.

B You must define variable groups (by selecting variables in the source list) for all
available target variables before you can proceed to the next step.

What should be copied into the new file? Variables that aren’t restructured can be copied
into the new file. Their values will be propagated in the new rows. Move variables that
you want to copy into the new file into the Fixed Variable(s) list.
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Restructure Data Wizard (Variables to Cases): Create Index Variables

Note: The wizard presents this step if you choose to restructure variable groups into

TOWS.

In this step, decide whether to create index variables. An index is a new variable
that sequentially identifies a row group based on the original variable from which
the new row was created.

Figure 9-23

Restructure Data Wizard: Create Index Variables, Step 4

Restructure Data Wizard - Step 4 of 7 m

Wariables to Cazes: Create Index WVariables

In the cuent data, walues for a waniable group appear in a single case in multiple wariables. For example, a single
cage contains the values for wl, w2, and w3,

In the new data, values for a variable group will appear in multiple cases in a single vaniable. For example, there
will be three cases, one each for wi, w2, and w3,

Anindex iz a hew variable that identifies the group of new cazes that waz created fromm the original caze. For

exanple, at index named "w'" would have the waluez 1, 2, and 3.

0.07

0.1

0.05

0.02

0.04

rafra|ra| ===

[51 ST E T L B

0.0&

Howe many index variables do pou want to create?
* One

Usze thiz when a wariable group records the effects of a single
treatretk.

0.7

011

0.05

0.0z

0.04

rafrapa| ===
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005

" More than one Haw famy? |2

Usze thiz when a wariable group recaords the effects of more that
one reatment.
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002

0.04

| oo | raf—

0.0z

=] L] Rt ol o) |

005

" Mone

Uze thiz if index information iz stared in one of the zets of varables
to be transpozed.

< Back | Mext = | Firnzh | Cancel | Help

How many index variables should be in the new file? Index variables can be used
as grouping variables in SPSS procedures. In most cases, a single index variable is
sufficient; however, if the variable groups in your current file reflect multiple factor

levels, multiple indices may be appropriate.

®  One. The wizard will create a single index variable.
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®  More than one. The wizard will create multiple indices and enter the number of
indices that you want to create. The number that you specify affects the next step,
in which the wizard automatically creates the specified number of indices.

m  None. Select this if you do not want to create index variables in the new file.

Example of One Index for Variables to Cases

In the current data, there is one variable group, width, and one factor, time. Width was
measured three times and recorded in wi, w2, and w3.

Figure 9-24
Current data for one index
subject '] Wi w3
1 1 .70 4,30 570
2 2 710 5.90 560

We’ll restructure the variable group into a single variable, width, and create a single
numeric index. The new data are shown in the following table.

Figure 9-25
New, restructured data with one index
subject indesx width
1 1 1 G0
2 1 2 4,30
3 1 3 2.70
4 2 1 7.0
5 2 2 5.90
4] 2 3 5. B0

Index starts with 1 and increments for each variable in the group. It restarts each time a
new row is encountered in the original file. We can now use index in SPSS procedures
that require a grouping variable.

Example of Two Indices for Variables to Cases

When a variable group records more than one factor, you can create more than one
index; however, the current data must be arranged so that the levels of the first factor
are a primary index within which the levels of subsequent factors cycle. In the current
data, there is one variable group, width, and two factors, 4 and B. The data are arranged
so that levels of factor B cycle within levels of factor 4.
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Figure 9-26

Current data for two indices

subject w_alhi w_alh2 w_az2bi wa2h2
5.50 G.40 5.80 5.80
7.40 710 5.60 G.70

1
2

8]

We’ll restructure the variable group into a single variable, width, and create two
indices. The new data are shown in the following table.

Figure 9-27
New, restructured data with two indices

subject index_a index_b width

5.50
6.40
5.80
590
7.40
7.10
5.60
6.70

||| m]|a|w|ra]—
ta bafra ra| = = =] =
taf | = =] =] =
ta| =t = | = | =

Restructure Data Wizard (Variables to Cases): Create One Index Variable

Note: The wizard presents this step if you choose to restructure variable groups into
rows and create one index variable.

In this step, decide what values you want for the index variable. The values can be
sequential numbers or the names of the variables in an original variable group. You
can also specify a name and a label for the new index variable.
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Figure 9-28
Restructure Data Wizard: Create One Index Variable, Step 5

Restructure Data Wizard - Step 5 of 7 (x|

Variables to Cases: Create One Index Variable

You have chosen to create one index variable. The variable's values cah be sequential numbers or the names of
variables in a group.

In the table you can specify the name and label for the index variable.

‘wihat kind of index values?

¥ Sequential numbers
Index W alues: 1.2.3

" Wariable names
Irdes & alies: IW'I s j

Edit the Index Variable Mame and Label;
| |Narne |Label |Levels | Index Values

1 |index 31,2, 3

¢ Back Finizh | Cancel | Help |

For more information, see Example of One Index for Variables to Cases on p. 249.

m  Sequential numbers. The wizard will automatically assign sequential numbers as
index values.

m Variable names. The wizard will use the names of the selected variable group as
index values. Choose a variable group from the list.

®  Names and labels. Click a cell to change the default variable name and provide a
descriptive variable label for the index variable.

Restructure Data Wizard (Variables to Cases): Create Multiple Index Variables

Note: The wizard presents this step if you choose to restructure variable groups into
rows and create multiple index variables.
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In this step, specify the number of levels for each index variable. You can also specify
a name and a label for the new index variable.

Figure 9-29
Restructure Data Wizard: Create Multiple Index Variables, Step 5

Variables to Cases: Create Multiple Index Variables

“ou have choszen to have multiple index vanables created in your new data file. The first wariable in the table iz the
primary index. Al subzequent indexes cycle within each level of thiz index.

In the table below, enter the number of levels for each indexr vanable. You can also edit the Mame and Label of
each index vanable.

Index VYariable Mamesz, Labelz, and Mumber of Lewvels:

Iame Lakel Levels | Index Values
index_a
2 | index_h

=

Total number of combined levels [product):

Mate that the product of the number of levels of all the index variables must equal the 'Tatal' number
dizplaved below the table. Thiz nurmber equals the number of variables to be transposed.

¢ Back | et | Eirish | Cancel | Help |

For more information, see Example of Two Indices for Variables to Cases on p. 249.

How many levels are recorded in the current file? Consider how many factor levels
are recorded in the current data. A level defines a group of cases that experienced
identical conditions. If there are multiple factors, the current data must be arranged
so that the levels of the first factor are a primary index within which the levels of
subsequent factors cycle.

How many levels should be in the new file? Enter the number of levels for each index.
The values for multiple index variables are always sequential numbers. The values
start at 1 and increment for each level. The first index increments the slowest, and the
last index increments the fastest.
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Total combined levels. You cannot create more levels than exist in the current data.
Because the restructured data will contain one row for each combination of treatments,
the wizard checks the number of levels that you create. It will compare the product
of the levels that you create to the number of variables in your variable groups. They
must match.

Names and labels. Click a cell to change the default variable name and provide a
descriptive variable label for the index variables.

Restructure Data Wizard (Variables to Cases): Options

Note: The wizard presents this step if you choose to restructure variable groups into
TOWS.

In this step, specify options for the new, restructured file.
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Figure 9-30
Restructure Data Wizard: Options, Step 6

Restructure Data Wizard - Step b of 7 m

Yanables to Cazes: Options

In this step pou can zet options that will be applied to the restuctured data file,

— Handling of Yariables not Selected

& Drop vanable(s] from te new data hile

" Keep and hreat as fixed variablels]

— System Mizzing or Blank Yalues in all Tranzposzed Yariables
% Create a caze in the new file

= Digcard the data

r— Case Count Variable

[ Count the number of new cases created by the case in the cunent data

[ ame; I

LLabel: I

< Back I Mewt » I Firizh | Cancel | Help |

Drop unselected variables? In the Select Variables step (step 3), you selected variable
groups to be restructured, variables to be copied, and an identification variable from
the current data. The data from the selected variables will appear in the new file. If
there are other variables in the current data, you can choose to discard or keep them.

Keep missing data? The wizard checks each potential new row for null values. A null
value is a system-missing or blank value. You can choose to keep or discard rows that
contain only null values.

Create a count variable? The wizard can create a count variable in the new file. It
contains the number of new rows generated by a row in the current data. A count
variable may be useful if you choose to discard null values from the new file because
that makes it possible to generate a different number of new rows for a given row
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in the current data. Click a cell to change the default variable name and provide a
descriptive variable label for the count variable.

Restructure Data Wizard (Cases to Variables): Select Variables

Note: The wizard presents this step if you choose to restructure case groups into

columns.

In this step, provide information about how the variables in the current file should

be used in the new file.

Figure 9-31

Restructure Data Wizard: Select Variables, Step 2

Cases to Variables: Select Variables

Drata frarm caze groups in the current file will be restructured inta zsingle cases it the new file.

Chooge wvaniables that identify cage groups by moving those vaniables into the [dentifier Y anable list, Optionally pou
can algo choose Index Yariables.

The varnables that remair in the list of %anables in the Cument File either contain data that wany within a

caze group or data that do nok wary.

A warisble with data that wary will become a group of new variablas in the restructured file. A wariable with

data that do nat wary will be copied inta the new file.

Wariablez in the Curent File:

|dentifier Yariable(s):

< zoor

i

|ndex  ariable(z):

@ time

¢ Back

Firizh | Cancel | Help |

What identifies case groups in the current data? A case group is a group of rows that are
related because they measure the same observational unit—for example, an individual
or an institution. The wizard needs to know which variables in the current file identify
the case groups so that it can consolidate each group into a single row in the new
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file. Move variables that identify case groups in the current file into the Identifier
Variable(s) list. Variables that are used to split the current data file are automatically
used to identify case groups. Each time a new combination of identification values
is encountered, the wizard will create a new row, so cases in the current file should
be sorted by values of the identification variables, in the same order that variables
are listed in the Identifier Variable(s) list. If the current data file isn’t already sorted,
you can sort it in the next step.

How should the new variable groups be created in the new file? In the original data, a
variable appears in a single column. In the new data file, that variable will appear

in multiple new columns. Index variables are variables in the current data that the
wizard should use to create the new columns. The restructured data will contain one
new variable for each unique value in these columns. Move the variables that should
be used to form the new variable groups to the Index Variable(s) list. When the wizard
presents options, you can also choose to order the new columns by index.

What happens to the other columns? The wizard automatically decides what to do
with the variables that remain in the Current File list. It checks each variable to see
if the data values vary within a case group. If they do, the wizard restructures the
values into a variable group in the new file. If they don’t, the wizard copies the values
into the new file.

Restructure Data Wizard (Cases to Variables): Sort Data

Note: The wizard presents this step if you choose to restructure case groups into
columns.

In this step, decide whether to sort the current file before restructuring it. Each time the
wizard encounters a new combination of identification values, a new row is created, so
it is important that the data are sorted by the variables that identify case groups.
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Figure 9-32
Restructure Data Wizard: Sorting Data, Step 3

Cazes to Variables: Sorting D ata

The warniables that you uzed to identify caze groups in the curent file need to be sorted before the file can be
restiuctured. |F you are not sure about wour data, select "rez'

o Mote that you can undo the restiuctuning of data; however, if you chooge to sort your data in this wizard the
zorting cannot be undone.

Sort the current data?
EE
1[1]1 |003
1[1]2 |004
1 [ 1]z ooz &% Hes - data will be soted by the [dentifier and Index vanables
2111 |.oog
21 1|2 |oo7
21113 |.00&
21101 010
21 1]3 |.o0&
311011 1010 1111 [003
; 1 : :ggg : } g :gg; = Mo - uge the data as cumently soted
21 1]2 |o07 2011 |oog
1{1]2 004 201]|2 |oa7
1]1]32 002 21 1]2 [oos
21101 [0

< Back I Mewt » I Firizh | Cancel | Help |

How are the rows ordered in the current file? Consider how the current data are sorted
and which variables you are using to identify case groups (specified in the previous
step).

m  Yes. The wizard will automatically sort the current data by the identification
variables, in the same order that variables are listed in the Identifier Variable(s) list
in the previous step. Choose this when the data aren’t sorted by the identification
variables or when you aren’t sure. This choice requires a separate pass of the data,
but it guarantees that the rows are correctly ordered for restructuring.

®  No. The wizard will not sort the current data. Choose this when you are sure that
the current data are sorted by the variables that identify case groups.
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Restructure Data Wizard (Cases to Variables): Options

Note: The wizard presents this step if you choose to restructure case groups into
columns.

In this step, specify options for the new, restructured file.

Figure 9-33
Restructure Data Wizard: Options, Step 4

Cases to Variables: Options

In this step pou can set options that will be applied to the restiuctured data file.

— Order af Mew % ariable Groups

& Haroup by aniginal vanable (for exarmple: wi v wd BT hE R}

7 Group by index [far example: wl b1, w2 b2, w3 h3]

r— Case Count Variable

™ Count the number of cazes in the curent data uzed to create a new case

i Eli = I

L atel: |

— Indicator V ariable:

™ Create indicator vaniables

Eoot Hame: |ind

¢ Back I Mest » I Firizh | Cancel | Help

How should the new variable groups be ordered in the new file?

m By variable. The wizard groups the new variables created from an original variable
together.

m  Byindex. The wizard groups the variables according to the values of the index
variables.
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Example. The variables to be restructured are w and 4, and the index is month:

w h month

Grouping by variable results in:

wjan w.feb hjan

Grouping by index results in:

wjan  hjan w.feb

Create a count variable? The wizard can create a count variable in the new file. It
contains the number of rows in the current data that were used to create a row in
the new data file.

Create indicator variables? The wizard can use the index variables to create indicator
variables in the new data file. It creates one new variable for each unique value of the
index variable. The indicator variables signal the presence or absence of a value for a
case. An indicator variable has the value of 1 if the case has a value; otherwise, it is 0.

Example. The index variable is product. It records the products that a customer
purchased. The original data are:

customer product
1 chick

1 eggs

2 eggs

3 chick

Creating an indicator variable results in one new variable for each unique value of
product. The restructured data are:

customer indchick indeggs
1 1 1
2 0 1

3 1 0
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In this example, the restructured data could be used to get frequency counts of the
products that customers buy.

Restructure Data Wizard: Finish

This is the final step of the Restructure Data Wizard. Decide what to do with your
specifications.

Figure 9-34
Restructure Data Wizard: Finish

Restructure Data Wizard - Finish

Finish

‘what do you want o do?

N T
L=

1 [ewma

| e e s | I
o [ o[ e |-t § [ o [
.| e

HABEEE

e this when pou want to replace the current file immediately.

i Paste the spntax generated by the wizard into a spntas window

Usze thiz when you do not want to replace the current file and when
yau watt ta modify the syntas.

< Back fewt > | Firizh I Cancel Help
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m  Restructure now. The wizard will create the new, restructured file. Choose this
if you want to replace the current file immediately. Note: If original data are
weighted, the new data will be weighted unless the variable that is used as the
weight is restructured or dropped from the new file.

m Paste syntax. The wizard will paste the syntax it generates into a syntax window.
Choose this when you are not ready to replace the current file, when you want to
modify the syntax, or when you want to save it for future use.
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When you run a procedure, the results are displayed in a window called the Viewer.
In this window, you can easily navigate to the output that you want to see. You can
also manipulate the output and create a document that contains precisely the output
that you want.

Viewer

Results are displayed in the Viewer. You can use the Viewer to:
B Browse results.

m  Show or hide selected tables and charts.

m  Change the display order of results by moving selected items.
|

Move items between the Viewer and other applications.

262
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Figure 10-1
Viewer
Double-click i viewer.spo - SP55 Viewer [_[O] x]
a book icon to ﬁa Edit View Data Transform  Insert Fomat Analyze  Graphs  Utiities  Add-ore  ‘window  Help
N = = B[
an item | I EH .
@ Cutput Minority Classification ;I
) = fEl Frequen:les
Click to expand Curnulative
or collapse the Frequency | Percent | Walid Percent Fercent
outline view Valid Mo 370 781 78 781
Yes 104 2148 1.8 100.0
Total 474 100.0 100.0
[g Employment Categor
@ Minority Classificatiol
] summarize
B & Crosﬁabs
) Title Employment Category * Gender Crosstabulation
. Hetes Count
@ Caze Processing Summ:
Emplayment Category * Gender
Female hiale Total
Ermployrnent Category  Clerical 206 187 363
Custodial 0 7 |
Manager 10 74 a4
Total 216 258 474
4 3|kl | _»I_I
[¥ [SPS5 Processor is ieady [ 4
Outline pane Click an item to selectit Contents pane Double-click a table
and go directly to it to pivot or edit it

The Viewer is divided into two panes:
B The left pane of the Viewer contains an outline view of the contents.

m  The right pane contains statistical tables, charts, and text output.

You can use the scroll bars to browse the results, or you can click an item in the outline
to go directly to the corresponding table or chart. You can click and drag the right
border of the outline pane to change the width of the outline pane.

Using the Draft Viewer

If you prefer simple text output rather than interactive pivot tables, you can use the
Draft Viewer.

To Use the Draft Viewer

» In any window, from the menus choose:

Edit
Options...
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» On the General tab, click Draft for the output viewer type.
» To change the format options for Draft Viewer output, click the Draft Viewer tab.

For more information, see Draft Viewer in Chapter 11 on p. 297. You can also search
the Help facility to learn more:

» In any window, from the menus choose:

Help
Topics

» Click the Index tab in the Help Topics window.

» Type draft viewer, and then double-click the index entry.

Showing and Hiding Results

In the Viewer, you can selectively show and hide individual tables or results from an
entire procedure. This process is useful when you want to shorten the amount of
visible output in the contents pane.

To Hide Tables and Charts

» Double-click the item’s book icon in the outline pane of the Viewer.
or

» Click the item to select it.

» From the menus choose:
View

Hide

or

» Click the closed book (Hide) icon on the Outlining toolbar.

The open book (Show) icon becomes the active icon, indicating that the item is now
hidden.

To Hide Procedure Results

» Click the box to the left of the procedure name in the outline pane.
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This hides all results from the procedure and collapses the outline view.

Moving, Deleting, and Copying Output

You can rearrange the results by copying, moving, or deleting an item or a group
of items.
To Move Output in the Viewer

» Click an item in the outline or contents pane. (Shift-click to select multiple items, or
Ctrl-click to select noncontiguous items.)

» Click and drag selected items (hold down the mouse button while dragging).

» Release the mouse button on the item just above the location where you want to drop
the moved items.

You can also move items by using Cut and Paste After on the Edit menu.

To Delete Output in the Viewer

» Click an item in the outline or contents pane. (Shift-click to select multiple items, or
Ctrl-click to select noncontiguous items.)

» Press Delete.
or
» From the menus choose:
Edit
Delete

To Copy Output in the Viewer

» Click an item in the outline or contents pane. (Shift-click to select multiple items, or
Ctrl-click to select noncontiguous items.)

» Hold down the Ctrl key while you click and drag selected items (hold down the mouse
button while dragging).

» Release the mouse button to drop the items where you want them.
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You can also copy items by using Copy and Paste After on the Edit menu.

Changing Initial Alignment

By default, all results are initially left-aligned. You can change the initial alignment
(choose Options on the Edit menu, then click the Viewer tab) at any time.

Changing Alignment of Output Items

>

>

In the outline or contents pane, click the items that you want to align (Shift-click or
Ctrl-click to select multiple items).

From the menus choose:
Format
Align Left
Other alignment options include Center and Align Right.

Note: All results are displayed left-aligned in the Viewer. Only the alignment of
printed results is affected by the alignment settings. Centered and right-aligned items
are identified by a small symbol above and to the left of the item.

Viewer Outline

The outline pane provides a table of contents of the Viewer document. You can use the
outline pane to navigate through your results and control the display. Most actions in
the outline pane have a corresponding effect on the contents pane.

m  Selecting an item in the outline pane displays the corresponding item in the
contents pane.

B Moving an item in the outline pane moves the corresponding item in the contents
pane.

m  Collapsing the outline view hides the results from all items in the collapsed levels.
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Figure 10-2
Collapsed outline view and hidden results
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Controlling the outline display. To control the outline display, you can:
m  Expand and collapse the outline view.

m  Change the outline level for selected items.

m  Change the size of items in the outline display.
]

Change the font that is used in the outline display.

To Collapse and Expand the Outline View
» Click the box to the left of the outline item that you want to collapse or expand.
or
» Click the item in the outline.
» From the menus choose:

View
Collapse
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or
View
Expand

To Change the Outline Level
» Click the item in the outline pane.

» Click the left arrow on the Outlining toolbar to promote the item (move the item to
the left).

» Click the right arrow on the Outlining toolbar to demote the item (move the item
to the right).

or

From the menus choose:
Edit
Outline
Promote

or
Edit
Outline
Demote

Changing the outline level is particularly useful after you move items in the outline
level. Moving items can change the outline level of the items, and you can use the left-
and right-arrow buttons on the Outlining toolbar to restore the original outline level.

To Change the Size of Outline Items

» From the menus choose:
View
Outline Size
Small

Other options include Medium and Large.

The icons and their associated text change size.
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To Change the Font in the Outline

>

>

From the menus choose:
View
QOutline Font...

Select a font.

Adding Items to the Viewer

In the Viewer, you can add items such as titles, new text, charts, or material from
other applications.

To Add a Title or Text

>

>

Text items that are not connected to a table or chart can be added to the Viewer.
Click the table, chart, or other object that will precede the title or text.

From the menus choose:

Insert
New Title

or

Insert
New Text

Double-click the new object.

Enter the text that you want at this location.

To Add a Text File

>

In the outline pane or contents pane of the Viewer, click the table, chart, or other
object that will precede the text.

From the menus choose:

Insert
Text File...

Select a text file.
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To edit the text, double-click it.

Using Output in Other Applications

Pivot tables and charts can be copied and pasted into another Windows application,
such as a word-processing program or a spreadsheet. You can paste the pivot tables or
charts in various formats, including the following formats:

Embedded object. For applications that support ActiveX objects, you can embed pivot
tables and interactive charts. After you paste the table, it can be activated in place by
double-clicking it, and then it can be edited as if in the Viewer.

Picture (metafile). You can paste pivot tables, text output, and charts as metafile
pictures. The picture format can be resized in the other application, and sometimes a
limited amount of editing can be done with the facilities of the other application. Pivot
tables that are pasted as pictures retain all borders and font characteristics.

RTF (rich text format). Pivot tables can be pasted into other applications in RTF format.
In most applications, this means that the pivot table is pasted as a table that can then
be edited in the other application. (Note: Microsoft Word may not display extremely
wide tables properly.)

Bitmap. Charts can be pasted into other applications as bitmaps.

BIFF. The contents of a table can be pasted into a spreadsheet and retain numeric
precision.

Text. The contents of a table can be copied and pasted as text. This process can be
useful for applications such as e-mail, where the application can accept or transmit
only text.

To Copy a Table or Chart

>

>

Select the table or chart to be copied.

From the menus choose:
Edit
Copy
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To Copy and Paste Results into Another Application
» Copy the results in the Viewer.

» From the menus in the target application choose:
Edit
Paste
or

Edit
Paste Special...

Paste. Output is copied to the Clipboard in a number of formats. Each application
determines the “best” format to use for Paste. In many applications, Paste will paste
results as a picture (metafile). For word-processing applications, Paste will paste
pivot tables in RTF format, which pastes the pivot table as a table. For spreadsheet
applications, Paste will paste pivot tables in BIFF format. Charts are pasted as
metafiles.

Paste Special. Results are copied to the Clipboard in multiple formats. Paste Special
allows you to select the format that you want from the list of formats that are available
to the target application.

To Embed a Table in Another Application

You can embed pivot tables and interactive charts in other applications in ActiveX
format. An embedded object can be activated in place by double-clicking it, and the
object can then be edited and pivoted as if in the Viewer.

If you have applications that support ActiveX objects:

» Double-click the file objs-on.bat, which is located in the directory in which SPSS is
installed.

This action turns on ActiveX embedding for pivot tables. The file objs-off bat turns
ActiveX embedding off.

To embed a pivot table or interactive chart in another application:

» In the Viewer, copy the table.
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» From the menus in the target application choose:
Edit
Paste Special...

» From the list, select SPSS Pivot Table Object or SPSS Graphics Control Object.

The target application must support ActiveX objects. See the application’s
documentation for information about ActiveX support. Some applications that do
not support ActiveX may initially accept ActiveX pivot tables but may then exhibit
unstable behavior. Do not rely on embedded objects until you have tested the
application’s stability with embedded ActiveX objects.

To Paste a Pivot Table or Chart as a Picture (Metafile)
» In the Viewer, copy the table or chart.

» From the menus in the target application choose:
Edit
Paste Special...

» From the list, select Picture.

The item is pasted as a metafile. Only the layer and columns that were visible when
the item was copied are available in the metafile. Other layers or hidden columns
are not available.

To Paste a Pivot Table as a Table (RTF)
» In the Viewer, copy the pivot table.

» From the menus in the target application choose:
Edit
Paste Special...

» From the list, select Formatted Text (RTF) or Rich Text Format.

The pivot table is pasted as a table. Only the layer and columns that were visible when
the item was copied are pasted into the table. Other layers or hidden columns are not
available. You can copy and paste only one pivot table at a time in this format. (Note:
Microsoft Word may not display extremely wide tables properly.)
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To Paste a Pivot Table as Text
» In the Viewer, copy the table.

» From the menus in the target application choose:
Edit
Paste Special...

» From the list, select Unformatted Text.

Unformatted pivot table text contains tabs between columns. You can align columns
by adjusting the tab stops in the other application.

To Copy and Paste Multiple Items into Another Application

» Select the tables and/or charts to be copied. (Shift-click or Ctrl-click to select multiple
items.)

» From the menus choose:
Edit
Copy Objects

» In the target application, from the menus choose:
Edit
Paste

Note: Use Copy Objects only to copy multiple items from the Viewer to another
application. For copying and pasting within Viewer documents (for example, between
two Viewer windows), use Copy on the Edit menu.

Pasting Objects into the Viewer

Objects from other applications can be pasted into the Viewer. You can use either Paste
After or Paste Special. Either type of pasting puts the new object after the currently
selected object in the Viewer. Use Paste Special when you want to choose the format
of the pasted object.
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Paste Special

Paste Special allows you to select the format of a copied object that is pasted into the
Viewer. The possible file types for the object are listed in the Paste Special dialog box.
The object will be inserted in the Viewer following the currently selected object.

Figure 10-3
Paste Special dialog box
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Pasting Objects from Other Applications into the Viewer
» In the other application, copy the object.

» In the outline pane or contents pane of the Viewer, click the table, chart, or other
object that will precede the object.

» From the menus choose:
Edit
Paste Special...

» From the list, select the format for the object.
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Export Output

Export Output saves Viewer output in HTML, text, Word/RTF, Excel, PowerPoint
(requires PowerPoint 97 or later), and PDF formats. Charts can also be exported in a
number of different graphics formats. (Note: Export to PowerPoint is not available
in the Student Version.)

Output Document. Exports any combination of pivot tables, text output, and charts.

®  For HTML and text formats, charts are exported in the currently selected chart
export format. For HTML document format, charts are embedded by reference,
and you should export charts in a suitable format for inclusion in HTML
documents. For text document format, a line is inserted in the text file for each
chart, indicating the filename of the exported chart.

For Word/RTF format, charts are included in the Word file in metafile format.
Charts are not included in Excel documents.

For PowerPoint format, charts are exported in TIFF format and embedded in the
PowerPoint file.

m  For PDF format, charts are included in the PDF file in metafile format.

Output Document (No Charts). Exports pivot tables and text output. Any charts in the
Viewer are ignored.

Charts Only. Available export formats include: Windows metafile (WMF), enhanced
metafile (EMF), Windows bitmap (BMP), encapsulated PostScript (EPS), JPEG, TIFF,
PNG, and Macintosh PICT.

Export What. You can export all objects in the Viewer, all visible objects, or only
selected objects.

Export Format. For output documents, the available options are HTML, text, Excel,
Word/RTF, PowerPoint, and PDF; for HTML and text format, charts are exported in
the currently selected chart format in the Options dialog box for the selected format.
For Charts Only, choose a chart export format from the drop-down list. For output
documents, pivot tables and text are exported in the following manner:

m  HTML file (*.htm). Pivot tables are exported as HTML tables. Text output is
exported as preformatted HTML.

m  Text file (*.txt). Pivot tables can be exported in tab-separated or space-separated
format. All text output is exported in space-separated format.
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Excel file (*.xIs). Pivot table rows, columns, and cells are exported as Excel
rows, columns, and cells, with all formatting attributes intact—for example, cell
borders, font styles, and background colors. Text output is exported with all font
attributes intact. Each line in the text output is a row in the Excel file, with the
entire contents of the line contained in a single cell.

Word/RTF file (*.doc). Pivot tables are exported as Word tables with all formatting
attributes intact—for example, cell borders, font styles, background colors, and
so on. Text output is exported as formatted RTF. Text output in SPSS is always
displayed in a fixed-pitch (monospaced) font and is exported with the same font
attributes. A fixed-pitch font is required for proper alignment of space-separated
text output. (Note: Microsoft Word may not display extremely wide tables
properly.)

PowerPoint file (*.ppt). Pivot tables are exported as Word tables and are embedded
on separate slides in the PowerPoint file, with one slide for each pivot table. All
formatting attributes of the pivot table are retained—for example, cell borders,
font styles, and background colors. Text output is exported as formatted RTF. Text
output in SPSS is always displayed in a fixed-pitch (monospaced) font and is
exported with the same font attributes. A fixed-pitch font is required for proper
alignment of space-separated text output. (Note: Export to PowerPoint is not
available in the Student Version.)

Portable Document Format (*.pdf). All output is exported as it appears in Print
Preview, with all formatting attributes intact.

Output Management System. You can also automatically export all output or
user-specified types of output as text, HTML, XML, or SPSS-format data files. For
more information, see Output Management System in Chapter 49 on p. 693.

To Export Output

» Make the Viewer the active window (click anywhere in the window).

>

From the menus choose:

Export...

» Enter a filename (or prefix for charts) and select an export format.
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Figure 10-4
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HTML, Word/RTF, and Excel Options

When you click Options in the Export Output dialog box, a dialog box is displayed,
which controls the inclusion of footnotes and captions for documents that are exported
in HTML, Word/RTF, and Excel formats, controls the chart export options for HTML
documents, and controls the handling of multilayer pivot tables.

Image Format. Controls the chart export format and optional settings, including chart
size for HTML documents. For Word/RTF, all charts are exported in Windows metafile
(WMF) format. For Excel, charts are not included.

Export Footnotes and Caption. Check this box to include any footnotes and captions
along with the export of pivot tables.

Export All Layers. Check this box to export all layers of a multilayer pivot table. If the
box is left unchecked, only the top layer is exported.

To Set HTML, Word/RTF, and Excel Export Options
Make the Viewer the active window (click anywhere in the window).
From the menus choose:
File
Export...
Select HTML file or Word/RTF file or Excel file as the export format.

Click Options.

PowerPoint Options

PowerPoint Options controls the inclusion of titles for slides, the inclusion of footnotes
and captions for pivot tables, the handling of multilayer pivot tables, and the options
for charts exported to PowerPoint. (Note: Export to PowerPoint is not available in the
Student Version.)

Include Title on Slide. Check this box to include a title on each slide that is created by
the export. Each slide contains a single item that is exported from the Viewer. The title
is formed from the outline entry for the item in the outline pane of the Viewer.
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Export Footnotes and Caption. Check this box to include any footnotes and captions
along with the export of pivot tables.

Export All Layers. Check this box to export all layers of a multilayer pivot table; each
layer is placed on a separate slide, and all layers have the same title. If this box is left
unchecked, only the top layer is exported.

To Set PowerPoint Export Options
» Make the Viewer the active window (click anywhere in the window).

» From the menus choose:
File
Export...

» Select PowerPoint file as the export format.

» Click Options.

Figure 10-6
PowerPoint Options dialog box
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PDF Options

PDF Options controls the options for exporting Viewer output in portable document
format (PDF).

Optimize for fast Web viewing. This option provides faster access and viewing when
downloading the file from the Internet by downloading the document a page at a time
(byte serving), allowing users to view and scroll the document while it is downloading.
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Embed bookmarks. This option includes bookmarks in the PDF document that
correspond to the Viewer outline entries. Like the Viewer outline pane, bookmarks can
make it much easier to navigate documents with a large number of output objects.

Embed fonts. Embedding fonts ensures that the PDF document will look the same on
all computers. Otherwise, if some fonts used in the document are not available on
the computer being used to view (or print) the PDF document, font substitution may
yield suboptimal results.

m  Only characters that are used in the document. This option embeds only the font
information necessary to display the PDF file consistently, regardless of the fonts
installed on a particular computer.

m  All characters. This option embeds all characters from all fonts used in the
document. This is probably useful only if you need the ability to edit the PDF
document and it is important for all of the edited material to use the same fonts as
the original. For double-byte character sets (for example, Asian languages), this
may result in a substantially larger file size.

Exporting Multilayer Pivot Tables. There are three options for exporting multilayer
pivot tables in PDF format:

®  Honor Print Layer setting. This uses the Table Properties settings for each table to
determine if all layers or only the currently visible layer should be included. (With
the default TableLook setting, only the currently visible layer is included.) For
more information, see Table Properties: Printing in Chapter 12 on p. 327.

m  Export all layers. All layers of all pivot tables are included, regardless of the Table
Properties settings.

m  Export visible layer only. Only the visible layer is included for all pivot tables,
regardless of the Table Properties settings.

To Set PDF Export Options
Make the Viewer the active window (click anywhere in the window).
From the menus choose:
File
Export...

Select Portable Document Format as the export format.

Click Options.
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Figure 10-7
PDF Options dialog box
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Other Settings That Affect PDF Output

Page Setup. Page size, orientation, margins, content and display of page headers
and footers, and printed chart size in PDF documents are controlled by page setup
options (File menu, Page Setup in the Viewer window). For more information, see
Page Setup on p. 291.

Table Properties/TableLooks. Scaling of wide and/or long tables and printing of table
layers are controlled by table properties for each table. These properties can also be
saved in TableLooks. For more information, see Table Properties: Printing in Chapter
12 on p. 327.

Default/Current Printer. The resolution (DPI) of the PDF document is the current
resolution setting for the default or currently selected printer (which can be changed
using Page Setup). The maximum resolution is 1200 DPI. If the printer setting
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is higher, the PDF document resolution will be 1200 DPI. Note: High-resolution
documents may yield poor results when printed on lower-resolution printers.

Text Options

Text Options controls pivot table, text output, and chart format options and the
inclusion of footnotes and captions for documents that are exported in text format.
Pivot tables can be exported in tab-separated or space-separated format. For
tab-separated format, if a cell is not empty, its contents and a tab character are printed.
If a cell is empty, a tab character is printed.
All text output is exported in space-separated format. All space-separated output
requires a fixed-pitch (monospaced) font for proper alignment.

Cell Formatting. For space-separated pivot tables, by default all line wrapping is
removed, and each column is set to the width of the longest label or value in the
column. To limit the width of columns and wrap long labels, specify a number of
characters for the column width. This setting affects only pivot tables.

Cell Separators. For space-separated pivot tables, you can specify the characters that
are used to create cell borders.

Image Format. Controls the chart export format and optional settings, including chart
size.

Insert page break between tables. Inserts a form feed/page break between each table.
For multilayer pivot tables, this option inserts a page break between each layer.

To Set Text Export Options
» Make the Viewer the active window (click anywhere in the window).
» From the menus choose:
File
Export...

» Select Text file as the export format.

» Click Options.
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Figure 10-8
Text Options dialog box
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Chart Size Options

Chart Size controls the size of exported charts. The custom percentage specification
allows you to decrease or increase the size of the exported chart up to 200%.

To Set the Size for Exported Charts

» Make the Viewer the active window (click anywhere in the window).

» From the menus choose:

File
Export...

» For output documents, click Options, select the export format, and then click Chart Size.

» For Charts Only, select the export format, and then click Chart Size.
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Figure 10-9
Export Chart Size dialog box
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JPEG Chart Export Options

Color Depth. JPEG charts can be exported as true color (24 bit) or 256 grayscale.

Color Space. Refers to the way that colors are encoded in the image. The YUV color
model is one form of color encoding, commonly used for digital video and MPEG
transmission. The acronym stands for Y-signal, U-signal, V-signal. The Y component
specifies grayscale or luminance, and the U and V components correspond to the
chrominance (color information).

The ratios represent the sampling rates for each component. Reducing the U and V
sampling rates reduces file size (and also quality). Color Space determines the degree
of “lossiness” for colors in the exported image. YUV 4:4:4 is lossless, while YUV
4:2:2 and YUV 4:1:1 represent the decreasing trade-off between file size (disk space)
and quality of the colors that are represented.

Progressive Encoding. Enables the image to load in stages, initially displaying at low
resolution and then increasing in quality as the image continues to load.

Compression Quality Setting. Controls the ratio of compression to image quality. The
higher the image quality, the larger the exported file size.

Color Operations. The following operations are available:
m Invert. Each pixel is saved as the inverse of the original color.

m  Gamma correction. Adjusts the intensity of colors in the exported chart by changing
the gamma constant that is used to map the intensity values. Basically, this feature
can be used to lighten or darken the bitmapped image. The value can range from
0.10 (darkest) to 6.5 (lightest).
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BMP and PICT Chart Export Options

Color Depth. Determines the number of colors in the exported chart. A chart that is
saved under any depth will have a minimum of the number of colors that are actually
used and a maximum of the number of colors that are allowed by the depth. For
example, if the chart contains three colors—red, white, and black—and you save it as
16 colors, the chart will remain as three colors.

m If the number of colors in the chart exceeds the number of colors for that depth, the
colors will be dithered to replicate the colors in the chart.

B Current screen depth is the number of colors that are currently displayed on your
computer monitor.

Color Operations. The following operations are available:
®m Invert. Each pixel is saved as the inverse of the original color.

®  Gamma correction. Adjusts the intensity of colors in the exported chart by changing
the gamma constant that is used to map the intensity values. Basically, this feature

can be used to lighten or darken the bitmapped image. The value can range from
0.10 (darkest) to 6.5 (lightest).

Use RLE compression. (BMP only.) A lossless compression technique supported by
common Windows file formats. Lossless compression means that image quality has
not been sacrificed for the sake of smaller files.

PNG and TIFF Chart Export Options

Color Depth. Determines the number of colors in the exported chart. A chart that is
saved under any depth will have a minimum of the number of colors that are actually
used and a maximum of the number of colors that are allowed by the depth. For
example, if the chart contains three colors—red, white, and black—and you save it as
16 colors, the chart will remain as three colors.

m  [fthe number of colors in the chart exceeds the number of colors for that depth, the
colors will be dithered to replicate the colors in the chart.

B Current screen depth is the number of colors currently displayed on your computer
monitor.
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Color Operations. The following operations are available:
®m Invert. Each pixel is saved as the inverse of the original color.

m  Gamma correction. Adjusts the intensity of colors in the exported chart by changing
the gamma constant that is used to map the intensity values. Basically, this feature
can be used to lighten or darken the bitmapped image. The value can range from
0.10 (darkest) to 6.5 (lightest).

Transparency. Allows you to select a color that will appear transparent in the exported
chart. The feature is available only with 32-bit true color export. Enter integer values
between 0 and 255 for each color. The default value for each color is 255, creating a
default transparent color of white.

Format. (TIFF only.) Allows you to set the color space and compress the exported
chart. All color depths are available with RGB color. Only 24- and 32-bit true color is
available with CMYK. With the YCbCr option, only 24-bit true color is available.

EPS Chart Export Options

Trees, Maps, and Interactive Charts

For trees (Classification Trees option), maps (Maps option), and interactive charts
(Graphs menu, Interactive submenu), the following EPS options are available:

Image Preview. Allows you to save a preview image within the EPS image. A preview
image is used mainly when an EPS file is placed within another document. Many
applications cannot display an EPS image on screen but can display the preview

that is saved with the image. The preview image can be either WMF (smaller and
more scalable) or TIFF (more portable and supported by other platforms). Check the
application in which you want to include the EPS graphic to see what preview format
the application supports.

Fonts. Controls the treatment of TrueType fonts in EPS images.

m  Convert to PostScript fonts. Converts TrueType fonts to PostScript (Type 1) fonts
based on font family. For example, Times New Roman is converted to Times,
and Arial is converted to Helvetica. Note: This format is not recommended for
interactive graphics that use the SPSS marker font (for example, scatterplots),
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because there are no meaningful PostScript equivalents for the SPSS TrueType
marker symbols.

m  Replace fonts with curves. Turns TrueType fonts into PostScript curve data. The
text itself is no longer editable as text in applications that can edit EPS graphics.
There is also a loss of quality, but this option is useful if you have a PostScript
printer that doesn’t support Type 42 fonts, and you need to preserve special
TrueType symbols, such as the markers that are used in interactive scatterplots.

Other Charts
For all other charts, the following EPS options are available:

Include TIFF preview. Saves a preview with the EPS image in TIFF format for display
in applications that cannot display EPS images on screen.

Fonts. Controls the treatment of fonts in EPS images.

m  Replace fonts with curves. Turns fonts into PostScript curve data. The text itself is
no longer editable as text in applications that can edit EPS graphics. This option is
useful if the fonts that are used in the chart are not available on the output device.

m  Use font references. If the fonts that are used in the chart are available on the output
device, the fonts are used. Otherwise, the output device uses alternate fonts.

WMF Chart Export Options

Aldus placeable. Provides a degree of device independence (same physical size when
opened at 96 dpi versus 120 dpi), but not all applications support this format.

Standard Windows. Supported by most applications that can display Windows
metafiles.

To Set Chart Export Options

» Make the Viewer the active window (click anywhere in the window).

» From the menus choose:
File
Export...
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» For output documents, click Options, select the export format, and then click Chart
Options.

» For Charts Only, select the export format, and then click Options.

Viewer Printing
There are two options for printing the contents of the Viewer window:

All visible output. Prints only items that are currently displayed in the contents pane.
Hidden items (items with a closed book icon in the outline pane or hidden in collapsed
outline layers) are not printed.

Selection. Prints only items that are currently selected in the outline and/or contents
panes.

Figure 10-10
Viewer Print dialog box

Print n E

r— Prirker

Mame: IHF' Lazeret 8000 Senesz PS ;I Properties... |

Status Ready
Type: HPF Lazerlet 8000 Series PS
wihere:  LPT1:

Comment; [ Print ta file

— Print range Copie

& & visible output MHumber of copies: I'I 3:

" Selection
I Collate
1 2 3

Cancel

Help |

To Print Output and Charts

» Make the Viewer the active window (click anywhere in the window).
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» From the menus choose:

File
Print...

» Select the print settings that you want.

» Click OK to print.

Print Preview

Print Preview shows you what will print on each page for Viewer documents. It is a
good idea to check Print Preview before actually printing a Viewer document, because
Print Preview shows you items that may not be visible by looking at the contents
pane of the Viewer, including:

B Page breaks
Hidden layers of pivot tables
Breaks in wide tables

Complete output from large tables

Headers and footers that are printed on each page
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Figure 10-11
Print Preview

req_contacts.spo - SPSS Viewer (all visible output)

Fraqusncies
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If any output is currently selected in the Viewer, the preview displays only the selected
output. To view a preview for all output, make sure nothing is selected in the Viewer.
To View a Print Preview
» Make the Viewer the active window (click anywhere in the window).
» From the menus choose:

File
Print Preview
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With Page Setup, you can control:

m  Paper size and orientation
® Page margins

B Page headers and footers
®  Page numbering

®m  Printed size for charts
Figure 10-12

Page Setup dialog box

Page Setup

e —
AutoSelect Tray -]

Working with Output

Page Setup settings are saved with the Viewer document. Page Setup affects settings
for printing Viewer documents only. These settings have no effect on printing data

from the Data Editor or printing syntax from a syntax window.

To Change Page Setup

» Make the Viewer the active window (click anywhere in the window).
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» From the menus choose:
File
Page Setup...

» Change the settings and click OK.

Page Setup Options: Headers and Footers

Headers and footers are the information that is printed at the top and bottom of each
page. You can enter any text that you want to use as headers and footers. You can also
use the toolbar in the middle of the dialog box to insert:

® Date and time
Page numbers
Viewer filename

Outline heading labels

Page titles and subtitles
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Figure 10-13
Page Setup Options dialog box, Header/Footer tab

Header/Foater I Opticnz |

Ok | Cancel | Help |

Outline heading labels indicate the first-, second-, third-, and/or fourth-level outline
heading for the first item on each page.

Page titles and subtitles print the current page titles and subtitles. Page titles and
subtitles are created with New Page Title on the Viewer Insert menu or the TITLE
and SUBTITLE commands in command syntax. If you have not specified any page
titles or subtitles, this setting is ignored.

Note: Font characteristics for new page titles and subtitles are controlled on the
Viewer tab of the Options dialog box (accessed by choosing Options on the Edit
menu). Font characteristics for existing page titles and subtitles can be changed by
editing the titles in the Viewer.

To see how your headers and footers will look on the printed page, choose Print
Preview from the File menu.
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Page Setup Options: Options

This dialog box controls the printed chart size, the space between printed output items,
and page numbering.

Printed Chart Size. Controls the size of the printed chart relative to the defined page
size. The chart’s aspect ratio (width-to-height ratio) is not affected by the printed chart
size. The overall printed size of a chart is limited by both its height and width. When
the outer borders of a chart reach the left and right borders of the page, the chart size
cannot increase further to fill additional page height.

Space between items. Controls the space between printed items. Each pivot table,
chart, and text object is a separate item. This setting does not affect the display of
items in the Viewer.

Number pages starting with. Numbers pages sequentially, starting with the specified
number.

Figure 10-14
Page Setup Options dialog box, Options tab

Page Setup: Options
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Saving Output

The contents of the Viewer can be saved to a Viewer document. The saved document
includes both panes of the Viewer window (the outline and the contents).

To Save a Viewer Document
» From the Viewer window menus choose:
File

Save

» Enter the name of the document, and then click Save.

To save results in external formats (for example, HTML or text), use Export on the File
menu. (This feature is not available in the standalone SmartViewer.)

Save With Password Option
Save With Password allows you to password-protect your Viewer files.

Password. The password is case-sensitive and can be up to 16 characters. If you assign
a password, the file cannot be viewed without entering the password.

OEM Code. Leave this field blank unless you have a contractual agreement with SPSS
Inc. to redistribute the SmartViewer. The OEM license code is provided with the
contract.
To Save Viewer Files with a Password
» From the Viewer window menus choose:
File
Save with Password...
Enter the password.

Reenter the password to confirm it, and then click OK.

Enter a filename in the Save As dialog box.

vV v v VY

Click Save.
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Note: Leave the OEM Code field blank unless you have a contractual agreement with
SPSS Inc. to redistribute the SmartViewer.
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Draft Viewer

The Draft Viewer provides results in draft form, including:
m  Simple text output (instead of pivot tables)
m  Charts as metafile pictures (instead of chart objects)

Text output in the Draft Viewer can be edited, charts can be resized, and both text

output and charts can be pasted into other applications. However, charts cannot be
edited, and the interactive features of pivot tables and charts are not available.

297
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Figure 11-1
Draft Viewer window
i Draft Viewer | _ (O] x|
File Edit Miew |nzert Faomnat Graphs Utlities window Help
S8 @ ol m s 0] 2[z] ||| Bls]ufe]
Y
Fremquency [Percent |Valid Cumualative
Percent Percent
Walid|East 1z0 0.8 0.2 0.8
Central |161 41.3 41.3 721
West 109 Z27.9 z7.9 lo0.0
Total 390 lo0.d 100,40
Fremquency Percent Valid Cumulative
Dercent Percent
Walid East 1z0 30,8 30,8 30.8
Central 161 41.3 41.3 7z.1
West las Z7.8 z7.9 lod.0 —
Total 390 loo.0 1o0.0 _I
-

To Create Draft Output

» From the menus choose:
File
New
Draft Output

» To make draft output the default output type, from the menus choose:
Edit
Options...
» Click the General tab.

» Select Draft under Viewer Type at Startup.
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Note: New output is always displayed in the designated Viewer window. If you have
both a Viewer and a Draft Viewer window open, the designated window is the one

opened most recently or the one designated with the Designate Window button (the
plus sign icon) on the toolbar.

Controlling Draft Output Format

Output that would be displayed as pivot tables in the Viewer is converted to text output
for the Draft Viewer. The default settings for converted pivot table output include
the following:

m  Each column is set to the width of the column label, and labels are not wrapped
to multiple lines.

®  Alignment is controlled by spaces (instead of tabs).

B Box characters from the SPSS Marker Set font are used as row and column
separators.

m [f box characters are turned off, vertical line characters (|) are used as column
separators and dashes () are used as row separators.

You can control the format of new draft output using Draft Viewer Options (Edit
menu, Options, Draft Viewer tab).
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Figure 11-2
Draft Viewer Options

Piwvot Tables I Data I Currency I Scriptz
General I Viewer Draft Viewer | Output Labels I Charts I Interactive
— Digplay Output Items — Tabular Output
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I/ Title . Fiow: l_
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¥ Text Dutput
_ |:- — Test Dutput
— Page Breaks Eetween Page ‘width: Page Length;
I™ Procedures I ltems ¢ Standard [80 characters] % Standard (59 lines)
— Eont  wide 132 characters]) € Infinite
ICourierNew j |8 ;I " Custom: IBEI  Custom: |59
Ok, | Cancel | Apply | Help

Column width. To reduce the width of tables that contain long labels, select Maximum
characters under Column width. Labels longer than the specified width are wrapped to
fit the maximum width.
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Draft output before and after setting maximum column width

i= Draft Viewer
File  Edit  Wiew

Inzert  Format

Graphs
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Utilities  Window Help
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Table with Autofit Column Widths

Fregquency |Percent ([Valid Percent |Cumalatiwve Percent
Talid|East 1z0 30.8 30.8 0.8
Central |16l 41_3 41.3 7Z.1
West 1las Z7.3 z7.8 100.0
Total 390 loo.0 lo0.0

Table with Column Width set to Maximum of 12 Characters

Fregquency |FPercent |Valid Cumnalative
Percent Percent
Valid|East 1z0 0.2 0.2 0.2
Central 161 413 41.3 721
West 1092 z7.9 Z7.9 io00.0
Total 220 i00.0 lo00.0

H

Draft Viewer

Row and column separators. As an alternative to box characters for row and column
borders, you can use the Cell Separators settings to control the row and column
separators displayed in new draft output. You can specify different cell separators or
enter blank spaces if you don’t want any characters used to mark rows and columns.

You must deselect Display Box Character to specify cell separators.
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Figure 11-4
Draft output before and after setting cell separators
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Space-separated versus tab-separated columns. The Draft Viewer is designed to
display space-separated output in a fixed-pitch (monospaced) font. If you want to
paste draft output into another application, you must use a fixed-pitch font to align
space-separated columns properly. If you select Tabs for the column separator, you
can use any font that you want in the other application and set the tabs to align output
properly. However, tab-separated output will not align properly in the Draft Viewer.
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Figure 11-5
Tab-separated output in the Draft Viewer and formatted in a word processor
i Draft Viewer =1 5
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To Set Draft Viewer Options

» From the menus choose:

Edit
Options...
Click the Draft Viewer tab.

Select the settings that you want.

Click OK or Apply.
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Draft Viewer output display options affect only new output produced after you change
the settings. Output already displayed in the Draft Viewer is not affected by changes in
these settings.

Fonts in Draft Output

You can modify the font attributes (such as font, size, and style) of text output in the
Draft Viewer. However, if you use box characters for row and column borders, proper
column alignment for space-separated text requires a fixed-pitch (monospaced) font,
such as Courier. Additionally, other font changes, such as size and style (for example,
bold and italic), applied to only part of a table can affect column alignment.

Row and column borders. The default solid-line row and column borders use the
SPSS Marker Set font. The line-drawing characters used to draw the borders are not
supported by other fonts.

To Change Fonts in Draft Viewer
» Select the text to which you want to apply the font change.

» From the Draft Viewer menus choose:

Format
Font...

» Select the font attributes that you want to apply to the selected text.

To Print Draft Output

» From the Draft Viewer menus choose:

File
Print...

To Print Only a Selected Portion of the Draft Output
» Select the output that you want to print.
» From the menus choose:

File
Print...
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» Select Selection.

Draft Viewer Print Preview

Print Preview shows you what will print on each page for draft documents. It is usually
a good idea to check Print Preview before actually printing a Viewer document because
Print Preview shows you items that may not fit on the page, including:

®  Long tables

m  Wide tables produced by converted pivot table output without column-width
control

m  Text output created with the Wide page-width option (Draft Viewer Options) with
the printer set to Portrait mode

Output that is too wide for the page is truncated, not printed on another page. There are
several things that you can do to prevent wide output from being truncated:

m  Use a smaller font size (Format menu, Fonts).
m  Select Landscape for the page orientation (File menu, Page Setup).

®  For new output, specify a narrow maximum column width (Edit menu, Options,
Draft Viewer tab).

For long tables, use page breaks (Insert menu, Page Break) to control where the table
breaks between pages.

To View Draft Viewer Print Preview

» From the Draft Viewer menus choose:
File
Print Preview

To Save Draft Viewer Output

» From the Draft Viewer menus choose:
File
Save

Draft Viewer output is saved in rich text format (RTF).



306

Chapter 11

To Save Draft Output as Text

» From the Draft Viewer menus choose:
File
Export...

You can export all text or just the selected text. Only text output (converted pivot table
output and text output) is saved in the exported files; charts are not included.
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Many of the results in the Viewer are presented in tables that can be pivoted
interactively. That is, you can rearrange the rows, columns, and layers.

Manipulating a Pivot Table

Options for manipulating a pivot table include:
Transposing rows and columns

Moving rows and columns

Creating multidimensional layers

Grouping and ungrouping rows and columns
Showing and hiding cells

Rotating row and column labels

Finding definitions of terms

To Edit a Pivot Table

» Double-click the table.

This activates the Pivot Table Editor.

To Edit Two or More Pivot Tables at a Time
» Right-click the pivot table.

» From the context menu choose:

SPSS Pivot Table Object
Open

307
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» Repeat the process for each pivot table that you want to edit.

Each pivot table is ready to edit in its own separate window.

To Pivot a Table by Using Icons
» Activate the pivot table.

» From the Pivot Table menus choose:

Pivot
Pivoting Trays

» Place the pointer over each icon to see a ToolTip that tells you which table dimension
the icon represents.
» Drag an icon from one tray to another tray.

Figure 12-1
Pivoting trays
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This changes the arrangement of the table. For example, suppose that the icon
represents a variable with categories Yes and No. If you drag the icon from the Row
tray to the Column tray, Yes and No become column labels. Before the move, Yes

and No were row labels.

To Identify Pivot Table Dimensions

» Activate the pivot table.
» If pivoting trays are not on, from the Pivot Table menus choose:

Pivot
Pivoting Trays
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» Click and hold down the mouse button on an icon.

This highlights the dimension labels in the pivot table.

To Transpose Rows and Columns
» From the Pivot Table menus choose:

Pivot
Transpose Rows and Columns

This has the same effect as dragging all of the row icons into the Column tray and
dragging all of the column icons into the Row tray.

To Change Display Order

The order of pivot icons in a dimension tray reflects the display order of elements in
the pivot table. To change the display order of elements in a dimension:

» Activate the pivot table.
» If pivoting trays are not already on, from the Pivot Table menus choose:
Pivot

Pivoting Trays

» Drag the icons in each tray to the order that you want (left to right or top to bottom).

To Move Rows and Columns in a Pivot Table
» Activate the pivot table.
» Click the label for the row or column you want to move.
» Drag the label to the new position.

» From the context menu choose Insert Before or Swap.

Note: Make sure that Drag to Copy on the Edit menu is not enabled (checked). If Drag
to Copy is enabled, deselect it.
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To Group Rows or Columns and Insert Group Labels

» Activate the pivot table.

» Select the labels for the rows or columns that you want to group together (click and

drag or Shift-click to select multiple labels).

From the menus choose:
Edit
Group

A group label is automatically inserted. Double-click the group label to edit the label
text.

Figure 12-2
Row and column groups and labels

Column Group Label
Female Male Total
Row Clerical 206 157 363
Group Custodial 27 27
Label Manager 10 74 84

Note: To add rows or columns to an existing group, you must first ungroup the items
that are currently in the group; then you can create a new group that includes the
additional items.

To Ungroup Rows or Columns and Remove Group Labels

>

>

Activate the pivot table.
Click anywhere in the group label for the rows or columns that you want to ungroup.
From the menus choose:

Edit
Ungroup

Ungrouping automatically deletes the group label.

To Rotate Pivot Table Labels

» Activate the pivot table.
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» From the menus choose:
Format

Rotate InnerColumn Labels

or
Rotate OuterRow Labels

Pivot Tables

Figure 12-3
Rotated column labels
Valid Cumulative
EFrequency | Percent | Percent Percent
Clerical 363 76.6 76.6 76.6
Custodial 27 5.7 5.7 82.3
Manager =
Total § € 8 g k=
[0} o DO
[} [ a =l
> 8 =
g | o = | E@
i e g | O
Clerical 363 76.6 76.6 76.6
Custodial 27 57 5.7 82.3
Manager 84 17.7 17.7 | 100.0
Total 474 | 100.0 | 100.0

Only the innermost column labels and the outermost row labels can be rotated.

To Reset Pivots to Defaults

After performing one or more pivoting operations, you can return to the original
arrangement of the pivot table.

» From the Pivot menu choose Reset Pivots to Defaults.

This resets only changes that are the result of pivoting row, column, and layer
elements between dimensions. The action does not affect changes such as grouping or
ungrouping or moving rows and columns.

To Find a Definition of a Pivot Table Label

You can obtain context-sensitive Help on cell labels in pivot tables. For example, if
Mean appears as a label, you can obtain a definition of the mean.
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» Right-click a label cell.

» From the context menu choose What's This?.

You must click your right mouse button on the label cell itself, rather than on the data
cells in the row or column. Context-sensitive Help is not available for user-defined

labels, such as variable names or value labels.

Working with Layers

You can display a separate two-dimensional table for each category or combination
of categories. The table can be thought of as stacked in layers, with only the top

layer visible.

To Create and Display Layers

» Activate the pivot table.

» From the Pivot menu choose Pivoting Trays (if it is not already selected).

Drag an icon from the Row tray or the Column tray into the Layer tray.

Figure 12-4
Moving categories into layers

Minority pivoted from row
to layer dimension &) Pivoting Trays | ]|
[ 41
x Layers =
) Columnsg E
g .
File Edit “iew Inzert Pivot Fomat Help
A
an s
Employment category * Gender inority classification Crosstabulation
Minority classification: Mo
Gender
=» Female hale Total
Employrment category  Clerical 166 110 276
Custodial 14 14
Manager 10 70 20
Total 176 194 370
4] | oz
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Each layer icon has left and right arrows. The visible table is the table for the top layer.

Figure 12-5
Categories in separate layers

| Minority classification: Yes

Minority classification: No

To Change Layers

» Click one of the layer icon arrows.

or

» Choose a category from the drop-down list of layers.

Figure 12-6
Selecting layers from drop-down lists
Layered Reports
Region Total =]
% of % of
Total Total
sum Wean ] ]
619 | $425152 | 211 | 541
Cansumer
Praducts $55,331,100 | 381 | $308,112 (179 | 459
Total $145038,350 | 100.0 | $371,893 | 330 | 100.0
Go to Layer Category

Go to Layer Category allows you to change layers in a pivot table. This dialog box is
particularly useful when there are a large number of layers or if one layer has many

categories.
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To Go to a Table Layer

» From the Pivot Table menus choose:

Pivot
Go to Layer...

Figure 12-7
Go to Layer Category dialog box

Vigible Category for Each Dimenszion in Layer: LCategones for Minonity clazsification:

Apply | ak. | Cancel | Help |

» In the Visible Category list, select a layer dimension. The Categories list will display
all categories for the selected dimension.

» In the Categories list, select the category that you want, and then click OK. This
changes the layer and closes the dialog box.

To view another layer without closing the dialog box:

» Select the category and click Apply.

To Move Layers to Rows or Columns

If the table that you are viewing is stacked in layers, with only the top layer showing,
you can display all of the layers at once, either down the rows or across the columns.
There must be at least one icon in the Layer tray.
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» From the Pivot menu choose Move Layers to Rows.
or

» From the Pivot menu choose Move Layers to Columns.

You can also move layers to rows or columns by dragging their icons between the
Layer, Row, and Column pivoting trays.

Bookmarks

Bookmarks allow you to save different views of a pivot table. Bookmarks save:
m  Placement of elements in row, column, and layer dimensions
® Display order of elements in each dimension

m  Currently displayed layer for each layer element

To Bookmark Pivot Table Views
» Activate the pivot table.
» Pivot the table to the view that you want to bookmark.
» From the menus choose:
Pivot
Bookmarks...

» Enter a name for the bookmark. (Bookmark names are not case sensitive.)

» Click Add.
Each pivot table has its own set of bookmarks. Within a pivot table, each bookmark

name must be unique, but you can use duplicate bookmark names in different pivot
tables.

To Display a Bookmarked Pivot Table View

» Activate the pivot table.
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» From the menus choose:
Pivot
Bookmarks...

» Click the name of the bookmark in the list.

» Click Go To.

To Rename a Pivot Table Bookmark
» Activate the pivot table.
» From the menus choose:
Pivot
Bookmarks...
» Click the name of the bookmark in the list.
» Click Rename.

» Enter the new bookmark name.

» Click OK.

Showing and Hiding Cells

Many types of cells can be hidden, including:

B Dimension labels

m Categories, including the label cell and data cells in a row or column
m  Category labels (without hiding the data cells)

m  Footnotes, titles, and captions

To Hide Rows and Columns in a Table

» Ctrl-Alt-click the category label of the row or column to be hidden.
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From the Pivot Table menus choose:
View

Hide
or

Right-click the row or column.

From the context menu choose Hide Category.

To Show Hidden Rows and Columns in a Table

» Select another label that is in the same dimension as the hidden row or column.

For example, if the Female category of the Gender dimension is hidden, click the
Male category.

From the Pivot Table menus choose:
View
Show All Categories in dimension name

For example, choose Show All Categories in Gender.

or

From the Pivot Table menus choose:
View
Show All

This displays all hidden cells in the table. (If Hide empty rows and columns is selected
in Table Properties for this table, a completely empty row or column remains hidden.)

To Hide or Show a Dimension Label

» Activate the pivot table.

» Select the dimension label or any category label within the dimension.

» From the menus choose:

View
Hide (or Show) Dimension Label
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To Hide or Show a Footnote in a Table
» Select a footnote.

» From the menus choose:
View
Hide (or Show)

To Hide or Show a Caption or Title in a Table
» Select a caption or title.

» From the menus choose:
View
Hide (or Show)

Editing Results

The appearance and contents of each table or text output item can be edited. You can:
Apply a TableLook.

Change the properties of the current table.

Change the properties of cells in the table.

Modify text.

Add footnotes and captions to tables.

Add items to the Viewer.

Copy and paste results into other applications.

Modify data cell widths.

Changing the Appearance of Tables

You can change the appearance of a table either by editing table properties or by
applying a TableLook. Each TableLook consists of a collection of table properties,
including general appearance, footnote properties, cell properties, and borders. You can
select one of the preset TableLooks, or you can create and save a custom TableLook.
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TableLooks

A TableLook is a set of properties that define the appearance of a table. You can select
a previously defined TableLook or create your own TableLook.

Before or after a TableLook is applied, you can change cell formats for individual
cells or groups of cells by using cell properties. The edited cell formats will remain
intact, even when you apply a new TableLook.

For example, you might start by applying TableLook 9POINT, then select a data
column, and from the Cell Formats dialog box, change to a bold font for that column.
Later, you change the TableLook to BOXED. The previously selected column retains
the bold font while the rest of the characteristics are applied from the BOXED
TableLook.

Optionally, you can reset all cells to the cell formats that are defined by the current
TableLook. This resets any cells that have been edited. If As Displayed is selected in
the TableLook Files list, any edited cells are reset to the current table properties.

To Apply or Save a TableLook
» Activate a pivot table.
» From the menus choose:

Format
TableLooks...
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Figure 12-8
TableLooks dialog box
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» Select a TableLook from the list of files. To select a file from another directory,
click Browse.

» Click OK to apply the TableLook to the selected pivot table.

To Edit or Create a TableLook

» In the TableLooks dialog box, select a TableLook from the list of files.

» Click Edit Look.

» Adjust the table properties for the attributes that you want, and then click OK.

» Click Save Look to save the edited TableLook, or click Save As to save it as a new
TableLook.

Editing a TableLook affects only the selected pivot table. An edited TableLook is not
applied to any other tables that use that TableLook unless you select those tables and
reapply the TableLook.
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Table Properties

The Table Properties dialog box allows you to set general properties of a table, set cell
styles for various parts of a table, and save a set of those properties as a TableLook.
Using the tabs on this dialog box, you can:

m  Control general properties, such as hiding empty rows or columns and adjusting
printing properties.

m  Control the format and position of footnote markers.

m  Determine specific formats for cells in the data area, for row and column labels,
and for other areas of the table.

m  Control the width and color of the lines that form the borders of each area of the
table.

To Change Pivot Table Properties

>

>

Double-click anywhere in the pivot table to activate it.
From the Pivot Table menus choose:
Format
Table Properties...
Select a tab (General, Footnotes, Cell Formats, Borders, or Printing).

Select the options that you want.

Click OK or Apply.

The new properties are applied to the selected pivot table. To apply new table
properties to a TableLook instead of just the selected table, edit the TableLook (Format
menu, TableLooks).

Table Properties: General

Several properties apply to the table as a whole. You can:

®  Show or hide empty rows and columns. (An empty row or column has nothing in
any of the data cells.)
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m  Control the placement of row labels, which can be in the upper left corner or nested.

®  Control maximum and minimum column width (expressed in points).

Figure 12-9
Table Properties dialog box, General tab
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To Change General Table Properties
» Click the General tab.
» Select the options that you want.

» Click OK or Apply.

Table Properties: Footnotes

The properties of footnote markers include style and position in relation to text.
B The style of footnote markers is either numbers (1, 2, 3, ...) or letters (a, b, c, ...).

m  The footnote markers can be attached to text as superscripts or subscripts.
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Figure 12-10
Table Properties dialog box, Footnotes tab
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To Change Footnote Marker Properties
» Click the Footnotes tab.
» Select a footnote number format.
» Select a marker position.

» Click OK or Apply.

Table Properties: Cell Formats

For formatting, a table is divided into areas: title, layers, corner labels, row labels,
column labels, data, caption, and footnotes. For each area of a table, you can modify
the associated cell formats. Cell formats include text characteristics (such as font,
size, color, and style), horizontal and vertical alignment, cell shading, foreground and
background colors, and inner cell margins.
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Figure 12-11
Areas of a table
Title

Layers

Corner labels Column labels

Row labels Data

Caption
Footnotes

Cell formats are applied to areas (categories of information). They are not
characteristics of individual cells. This distinction is an important consideration
when pivoting a table.

For example,

m  [f you specify a bold font as a cell format of column labels, the column labels
will appear bold no matter what information is currently displayed in the column
dimension—and if you move an item from the column dimension to another
dimension, it does not retain the bold characteristic of the column labels.

m  [f you make column labels bold simply by highlighting the cells in an activated
pivot table and clicking the Bold button on the toolbar, the contents of those cells
will remain bold no matter what dimension you move them to, and the column
labels will not retain the bold characteristic for other items moved into the column
dimension.
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Figure 12-12
Table Properties dialog box, Cell Formats tab
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To Change Cell Formats
» Select the Cell Formats tab.
» Select an area from the drop-down list or click an area of the sample.
» Select characteristics for the area. Your selections are reflected in the sample.

» Click OK or Apply.

Table Properties: Borders

For each border location in a table, you can select a line style and a color. If you select
None as the style, there will be no line at the selected location.
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Figure 12-13
Table Properties dialog box, Borders tab
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To Change Borders in a Table
» Click the Borders tab.

» Select a border location, either by clicking its name in the list or by clicking a line
in the Sample area. (Shift-click to select multiple names, or Ctrl-click to select
noncontiguous names.)

» Select a line style or select None.
» Select a color.

Click OK or Apply.

To Display Hidden Borders in a Pivot Table

For tables without many visible borders, you can display the hidden borders. This
can simplify tasks like changing column widths. The hidden borders (gridlines) are
displayed in the Viewer but are not printed.
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» Double-click anywhere in the pivot table to activate it.

» From the menus choose:
View
Gridlines

Table Properties: Printing

You can control the following properties for printed pivot tables:

m  Print all layers or only the top layer of the table, and print each layer on a separate
page. (This setting affects only printing, not the display of layers in the Viewer.)

®m  Shrink a table horizontally or vertically to fit the page for printing.

m  Control widow/orphan lines by controlling the minimum number of rows and
columns that will be contained in any printed section of a table if the table is too
wide and/or too long for the defined page size. (Note: If a table is too long to fit on
the current page because there is other output above it, but it will fit within the
defined page length, the table is automatically printed on a new page, regardless
of the widow/orphan setting.)

®  Include continuation text for tables that don’t fit on a single page. You can display
continuation text at the bottom of each page and at the top of each page. If neither
option is selected, the continuation text will not be displayed.

To Control Pivot Table Printing

Font

» Click the Printing tab.
» Select the printing options that you want.

» Click OK or Apply.

A TableLook allows you to specify font characteristics for different areas of the table.
You can also change the font for any individual cell. Options for the font in a cell
include the font face, style, size, and color. You can also hide the text or underline it.

If you specify font properties in a cell, they apply in all of the table layers that
have the same cell.
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Figure 12-14
Font dialog box
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To Change the Font in a Cell
» Activate the pivot table and select the text that you want to change.

» From the Pivot Table menus choose:

Format
Font...

Optionally, you can select a font, font style, and point size, and you can choose a color
and a script style, as well as whether you want the text to be hidden or underlined.

Data Cell Widths

Set Data Cell Width is used to set all data cells to the same width.
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Figure 12-15
Set Data Cell Width dialog box
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To Change Data Cell Widths

» Activate the pivot table.

» From the menus choose:
Format

Set Data Cell Widths...

» Enter a value for the cell width.

To Change the Width of a Pivot Table Column

» Double-click anywhere in the table to activate it.

» Move the pointer through the category labels until it is on the right border of the column
that you want to change. (The pointer changes to an arrow with points on both ends.)

» Hold down the mouse button while you drag the border to its new position.
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Figure 12-16
Changing the width of a column
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You can change vertical category and dimension borders in the row labels area,
regardless of whether they are showing.

» Move the mouse pointer through the row labels until you see the double-pointed arrow.

» Drag the border to the new width.

Cell Properties

Cell properties are applied to a selected cell. You can change the value format,
alignment, margins, and shading. Cell properties override table properties; therefore, if
you change table properties, you do not change any individually applied cell properties.

To Change Cell Properties
» Activate a table and select a cell in the table.

» From the menus choose:

Format
Cell Properties...

Cell Properties: Value

This dialog box tab controls the value format for a cell. You can select formats for
number, date, time, or currency, and you can adjust the number of decimal digits
that are displayed.
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Cell Properties dialog box, Value tab
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To Change Value Formats in a Cell

» Click the Value tab.

» Select a category and a format.

» Select the number of decimal places.

To Change Value Formats for a Column

>

>

Ctrl-Alt-click the column label.

Right-click the highlighted column.

From the context menu choose Cell Properties.

Click the Value tab.

Select the format that you want to apply to the column.

Pivot Tables
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You can use this method to suppress or add percentage signs and dollar signs, change
the number of decimals that are displayed, and switch between scientific notation and
regular numeric display.

Cell Properties: Alignment

This dialog box tab sets horizontal and vertical alignment and text direction for a cell.
If you select Mixed, contents of the cell are aligned according to its type (number,
date, or text).

Figure 12-18
Cell Properties dialog box, Alignment tab

Cell Properties

To Change Alignment in Cells
» Select a cell in the table.

» From the Pivot Table menus choose:

Format
Cell Properties...

» Click the Alignment tab.

As you select the alignment properties for the cell, the properties are illustrated in the
Sample area.
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Cell Properties: Margins

This dialog box tab specifies the inset at each edge of a cell.

Figure 12-19
Cell Properties dialog box, Margins tab
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To Change Margins in Cells
» Click the Margins tab.

» Select the inset for each of the four margins.

Cell Properties: Shading

This dialog box tab specifies the percentage of shading and specifies foreground and
background colors for a selected cell area. This setting does not change the color of
the text.
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Figure 12-20
Cell Properties dialog box, Shading tab
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To Change Shading in Cells
» Click the Shading tab.

» Select the highlights and colors for the cell.

Footnote Marker

Footnote Marker changes the character(s) that can be used to mark a footnote.

Figure 12-21
Footnote Marker dialog box
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To Change Footnote Marker Characters
» Select a footnote.

» From the Pivot Table menus choose:

Format
Footnote Marker...

» Enter one or two characters.

To Renumber Footnotes

When you have pivoted a table by switching rows, columns, and layers, the footnotes
may be out of order. To renumber the footnotes:

» Activate the pivot table.

» From the menus choose:

Format
Renumber Footnotes

Selecting Rows and Columns in Pivot Tables

In pivot tables, there are some constraints on how you select entire rows and
columns, and the visual highlight that indicates the selected row or column may span
noncontiguous areas of the table.

To Select a Row or Column in a Pivot Table
» Double-click anywhere in the pivot table to activate it.
» Click a row or column label.
» From the menus choose:
Edit
Select
Data and Label Cells

or

» Ctrl-Alt-click the row or column label.
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If the table contains more than one dimension in the row or column area, the
highlighted selection may span multiple noncontiguous cells.

Modifying Pivot Table Results

Text appears in the Viewer in many items. You can edit the text or add new text.
Pivot tables can be modified by:

m  Editing text within pivot table cells

®  Adding captions and footnotes

To Modify Text in a Cell
» Activate the pivot table.
» Double-click the cell.
» Edit the text.
» Press Enter to record your changes, or press Esc to revert to the previous contents of
the cell.
To Add Captions to a Table
» From the Pivot Table menus choose:

Insert
Caption

The words Table Caption are displayed at the bottom of the table.

» Double-click the words Table Caption and replace them with your caption text.

To Add a Footnote to a Table

A footnote can be attached to any item in a table.

» Click a title, cell, or caption within an activated pivot table.
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» From the Pivot Table menus choose:

Insert
Footnote...

» Double-click the word Footnote and replace it with the footnote text.

Printing Pivot Tables

Several factors can affect the way that printed pivot tables look, and these factors can
be controlled by changing pivot table attributes.

®  For multidimensional pivot tables (tables with layers), you can either print all
layers or print only the top (visible) layer.

m  For long or wide pivot tables, you can automatically resize the table to fit the page
or control the location of table breaks and page breaks.

Use Print Preview on the File menu to see how printed pivot tables will look.

To Print Hidden Layers of a Pivot Table

» Double-click anywhere in the table to activate it.

» From the menus choose:

Format
Table Properties...

» On the Printing tab, select Print all layers.

You can also print each layer of a pivot table on a separate page.

Controlling Table Breaks for Wide and Long Tables

Pivot tables that are either too wide or too long to print within the defined page size are
automatically split and printed in multiple sections. (For wide tables, multiple sections
will print on the same page if there is room.) You can:

m  Control the row and column locations where large tables are split.
m  Specify rows and columns that should be kept together when tables are split.

m  Rescale large tables to fit the defined page size.
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To Specify Row and Column Breaks for Printed Pivot Tables

» Activate the pivot table.

» Click the column label to the left of where you want to insert the break, or click the
row label above where you want to insert the break.

» From the menus choose:

Format
Break Here

To Specify Rows or Columns to Keep Together

» Activate the pivot table.

» Select the labels of the rows or columns that you want to keep together. (Click and
drag or Shift-click to select multiple row or column labels.)

» From the menus choose:

Format
Keep Together

To Rescale a Pivot Table to Fit the Page Size
» Activate the pivot table.

» From the menus choose:

Format
Table Properties

» Click the Printing tab.
» Seclect Rescale wide table to fit page.

and/or

» Seclect Rescale long table to fit page.

How to Create a Chart from a Pivot Table
» Double-click the pivot table to activate it.

» Select the rows, columns, or cells you want to display in the chart.
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» Right-click anywhere in the selected area.

» Choose Create Graph from the context menu and select a chart type.
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Working with Command Syntax

SPSS provides a powerful command language that allows you to save and automate
many common tasks. It also provides some functionality not found in the menus
and dialog boxes.

Most commands are accessible from the menus and dialog boxes. However, some
commands and options are available only by using the command language. The
command language also allows you to save your jobs in a syntax file so that you can
repeat your analysis at a later date or run it in an automated job with the Production
Facility.

A syntax file is simply a text file that contains commands. While it is possible to
open a syntax window and type in commands, it is often easier if you let the software
help you build your syntax file using one of the following methods:

® Pasting command syntax from dialog boxes

m  Copying syntax from the output log

m  Copying syntax from the journal file

Detailed command syntax reference information is available in two forms: integrated
into the overall Help system and as a separate PDF file, called the SPSS Command
Syntax Reference, also available from the Help menu.

Context-sensitive Help for the current command in a syntax window is available
by pressing the F1 key.

Syntax Rules

When you run commands from a command syntax window during an SPSS session,
you are running commands in interactive mode.

340
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The following rules apply to command specifications in interactive mode:

m  FEach command must start on a new line. Commands can begin in any column
of a command line and continue for as many lines as needed. The exception is
the END DATA command, which must begin in the first column of the first line
after the end of data.

m  Each command should end with a period as a command terminator. It is best to
omit the terminator on BEGIN DATA, however, so that inline data are treated as
one continuous specification.

® The command terminator must be the last nonblank character in a command.

®m In the absence of a period as the command terminator, a blank line is interpreted as
a command terminator.

Note: For compatibility with other modes of command execution (including command
files run with INSERT or INCLUDE commands in an interactive session), each line of
command syntax should not exceed 256 bytes.

®  Most subcommands are separated by slashes (/). The slash before the first
subcommand on a command is usually optional.

B Variable names must be spelled out fully.

m  Text included within apostrophes or quotation marks must be contained on a single
line.

B A period (.) must be used to indicate decimals, regardless of your regional or
locale settings.

B Variable names ending in a period can cause errors in commands created by the
dialog boxes. You cannot create such variable names in the dialog boxes, and you
should generally avoid them.

Command syntax is case insensitive, and three- or four-letter abbreviations can be used
for many command specifications. You can use as many lines as you want to specify
a single command. You can add space or break lines at almost any point where a
single blank is allowed, such as around slashes, parentheses, arithmetic operators, or
between variable names. For example,

FREQUENCIES
VARIABLES=JOBCAT GENDER
/PERCENTILES=25 50 75
/BARCHART.
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and

freq var=jobcat gender /percent=25 50 75 /bar.

are both acceptable alternatives that generate the same results.

INCLUDE Files
For command files run via the INCLUDE command, batch mode syntax rules apply.

The following rules apply to command specifications in batch or production mode:

®  All commands in the command file must begin in column 1. You can use plus
(+) or minus (—) signs in the first column if you want to indent the command
specification to make the command file more readable.

®m  [f multiple lines are used for a command, column 1 of each continuation line must
be blank.

®  Command terminators are optional.

B A line cannot exceed 256 bytes; any additional characters are truncated.

Unless you have existing command files that already use the INCLUDE command,
you should probably use the INSERT command instead, since it can accommodate
command files that conform to either set of rules. If you generate command syntax
by pasting dialog box choices into a syntax window, the format of the commands
is suitable for any mode of operation. See the SPSS Command Syntax Reference
(available in PDF format from the Help menu) for more information.

Pasting Syntax from Dialog Boxes

To Paste

The easiest way to build a command syntax file is to make selections in dialog boxes
and paste the syntax for the selections into a syntax window. By pasting the syntax at
each step of a lengthy analysis, you can build a job file that allows you to repeat the
analysis at a later date or run an automated job with the Production Facility.

In the syntax window, you can run the pasted syntax, edit it, and save it in a syntax
file.

Syntax from Dialog Boxes

» Open the dialog box and make the selections that you want.
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» Click Paste.

The command syntax is pasted to the designated syntax window. If you do not have
an open syntax window, a new syntax window opens automatically, and the syntax is
pasted there.

Figure 13-1
Command syntax pasted from a dialog box
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Note: If you open a dialog box from the menus in a script window, code for running
syntax from a script is pasted into the script window.

Copying Syntax from the Output Log

You can build a syntax file by copying command syntax from the log that appears in
the Viewer. To use this method, you must select Display commands in the log in the
Viewer settings (Edit menu, Options, Viewer tab) before running the analysis. Each
command will then appear in the Viewer along with the output from the analysis.

In the syntax window, you can run the pasted syntax, edit it, and save it in a syntax
file.
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Figure 13-2
Command syntax in the log
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To Copy Syntax from the Output Log

» Before running the analysis, from the menus choose:

Edit
Options...

» On the Viewer tab, select Display commands in the log.

As you run analyses, the commands for your dialog box selections are recorded

in the log.

» Open a previously saved syntax file or create a new one. To create a new syntax file,

from the menus choose:
File
New
Syntax
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» In the Viewer, double-click a log item to activate it.
» Click and drag the mouse to highlight the syntax that you want to copy.

» From the Viewer menus choose:
Edit
Copy

» In a syntax window, from the menus choose:
Edit
Paste

Editing Syntax in a Journal File

By default, all commands executed during a session are recorded in a journal file
named spss.jnl (specified using the Edit menu, Options, General tab). You can edit
the journal file and save it as a syntax file that you can use to repeat a previously run
analysis, or you can run it in an automated job with the Production Facility.

The journal file is a text file that can be edited like any other text file. Because error
messages and warnings are also recorded in the journal file along with command
syntax, you must edit out any error and warning messages that appear before saving
the syntax file. Note, however, that errors must be resolved or the job will not run
successfully.

Save the edited journal file with a different filename. Because the journal file is
automatically appended or overwritten for each session, attempting to use the same
filename for a syntax file and the journal file may yield unexpected results.

Figure 13-3
Editing the journal file
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To Edit Syntax in a Journal File

» To open the journal file, from the menus choose:
File
Open
Other...

» Locate and open the journal file (by default, spss.jn/ is located in the femp directory).

Select All files (*.*) for Files of Type or enter *.jnl in the File Name text box to display
journal files in the file list. If you have difficulty locating the file, use Options on the
Edit menu to see where the journal is saved in your system.

» Edit the file to remove any error messages or warnings, indicated by the > sign.

» Save the edited journal file using a different filename. (We recommend that you use a
filename with the extension .sps, the default extension for syntax files.)

To Run Command Syntax

» Highlight the commands that you want to run in the syntax window.

» Click the Run button (the right-pointing triangle) on the Syntax Editor toolbar.

or

» Select one of the choices from the Run menu.
m  All. Runs all commands in the syntax window.

m  Selection. Runs the currently selected commands. This includes any commands
partially highlighted.

Current. Runs the command where the cursor is currently located.

To End. Runs all commands from the current cursor location to the end of the
command syntax file.

The Run button on the Syntax Editor toolbar runs the selected commands or the
command where the cursor is located if there is no selection.



347

Working with Command Syntax

Figure 13-4
Syntax Editor toolbar
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Multiple Execute Commands

Syntax pasted from dialog boxes or copied from the log or the journal may contain
EXECUTE commands. When you run commands from a syntax window, EXECUTE
commands are generally unnecessary and may slow performance, particularly with
larger data files, because each EXECUTE command reads the entire data file. For more
information, see the EXECUTE command in the SPSS Command Syntax Reference
(available from the Help menu in any SPSS window).

Lag Functions

One notable exception is transformation commands that contain lag functions. In a
series of transformation commands without any intervening EXECUTE commands
or other commands that read the data, lag functions are calculated after all other
transformations, regardless of command order. For example,

COMPUTE lagvar=LAG(varl) .
COMPUTE varl=varl*2.

and

COMPUTE lagvar=LAG(varl) .
EXECUTE.
COMPUTE varl=varl*2.

yield very different results for the value of lagvar, since the former uses the
transformed value of var/ while the latter uses the original value.
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Frequencies

The Frequencies procedure provides statistics and graphical displays that are useful
for describing many types of variables. The Frequencies procedure is a good place to
start looking at your data.

For a frequency report and bar chart, you can arrange the distinct values in
ascending or descending order, or you can order the categories by their frequencies.
The frequencies report can be suppressed when a variable has many distinct values.
You can label charts with frequencies (the default) or percentages.

Example. What is the distribution of a company’s customers by industry type? From
the output, you might learn that 37.5% of your customers are in government agencies,
24.9% are in corporations, 28.1% are in academic institutions, and 9.4% are in the
healthcare industry. For continuous, quantitative data, such as sales revenue, you might
learn that the average product sale is $3,576, with a standard deviation of $1,078.

Statistics and plots. Frequency counts, percentages, cumulative percentages, mean,
median, mode, sum, standard deviation, variance, range, minimum and maximum
values, standard error of the mean, skewness and kurtosis (both with standard errors),
quartiles, user-specified percentiles, bar charts, pie charts, and histograms.

Data. Use numeric codes or short strings to code categorical variables (nominal or
ordinal level measurements).

Assumptions. The tabulations and percentages provide a useful description for data
from any distribution, especially for variables with ordered or unordered categories.
Most of the optional summary statistics, such as the mean and standard deviation, are
based on normal theory and are appropriate for quantitative variables with symmetric
distributions. Robust statistics, such as the median, quartiles, and percentiles, are
appropriate for quantitative variables that may or may not meet the assumption of
normality.
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Figure 14-1
Frequencies output
Industry
Valid Cumulative
Frequency | Percent | Percent Percent
Valid | Government 331 37.5 37.5 37.5
Corporate 220 24.9 24.9 62.5
Academic 248 28.1 28.1 90.6
Healthcare 83 9.4 9.4 100.0
Total 882 100.0 100.0
Statistics
Mean Median | Std. Deviation
Amount of Product Sale| $3,576.52 | $3,417.50 | $1,077.836
400 300
300
g = 200
[ c
2 200 z
L o
ic o
[
100 100
0
Govemment Academic [ o T T 1 T T
Corporate Healthcare §1,000 %2000 %$3,000 4000 5,000
Inclustry Amourt of Product Sale

To Obtain Frequency Tables

» From the menus choose:

Analyze
Descriptive Statistics
Frequencies...

Frequencies
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Figure 14-2
Frequencies dialog box

1 Frequencies

B. check

B. co_size
B. cosizel
B cust_exp
B cust_num

E, cust_urs
B. emp_dgre

Emp_eX|
P

» Select one or more categorical or quantitative variables.
Optionally, you can:
m  Click Statistics for descriptive statistics for quantitative variables.
m  Click Charts for bar charts, pie charts, and histograms.

m  Click Format for the order in which results are displayed.

Frequencies Statistics

Figure 14-3
Frequencies Statistics dialog box

Frequencies: Stahishics

LINC NN
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Percentile Values. Values of a quantitative variable that divide the ordered data into
groups so that a certain percentage is above and another percentage is below. Quartiles
(the 25th, 50th, and 75th percentiles) divide the observations into four groups of equal
size. If you want an equal number of groups other than four, select Cut points for n equal
groups. You can also specify individual percentiles (for example, the 95th percentile,
the value below which 95% of the observations fall).

Central Tendency. Statistics that describe the location of the distribution include the
mean, median, mode, and sum of all the values.

Mean. A measure of central tendency. The arithmetic average, the sum divided
by the number of cases.

Median. The value above and below which half of the cases fall, the 50th
percentile. If there is an even number of cases, the median is the average of the
two middle cases when they are sorted in ascending or descending order. The
median is a measure of central tendency not sensitive to outlying values (unlike
the mean, which can be affected by a few extremely high or low values).

Mode. The most frequently occurring value. If several values share the greatest
frequency of occurrence, each of them is a mode. The Frequencies procedure
reports only the smallest of such multiple modes.

Sum. The sum or total of the values, across all cases with nonmissing values.

Dispersion. Statistics that measure the amount of variation or spread in the data include
the standard deviation, variance, range, minimum, maximum, and standard error of
the mean.

Std. deviation. A measure of dispersion around the mean. In a normal distribution,
68% of cases fall within one standard deviation of the mean and 95% of cases
fall within two standard deviations. For example, if the mean age is 45, with

a standard deviation of 10, 95% of the cases would be between 25 and 65 in

a normal distribution.

Variance. A measure of dispersion around the mean, equal to the sum of squared
deviations from the mean divided by one less than the number of cases. The
variance is measured in units that are the square of those of the variable itself.

Range. The difference between the largest and smallest values of a numeric
variable, the maximum minus the minimum.

Minimum. The smallest value of a numeric variable.
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®  Maximum. The largest value of a numeric variable.

m  S. E. mean. A measure of how much the value of the mean may vary from sample
to sample taken from the same distribution. It can be used to roughly compare the
observed mean to a hypothesized value (that is, you can conclude the two values
are different if the ratio of the difference to the standard error is less than -2 or
greater than +2).

Distribution. Skewness and kurtosis are statistics that describe the shape and symmetry
of the distribution. These statistics are displayed with their standard errors.

m  Skewness. A measure of the asymmetry of a distribution. The normal distribution
is symmetric and has a skewness value of 0. A distribution with a significant
positive skewness has a long right tail. A distribution with a significant negative
skewness has a long left tail. As a guideline, a skewness value more than twice its
standard error is taken to indicate a departure from symmetry.

m  Kurtosis. A measure of the extent to which observations cluster around a central
point. For a normal distribution, the value of the kurtosis statistic is zero.
Positive kurtosis indicates that the observations cluster more and have longer
tails than those in the normal distribution, and negative kurtosis indicates that the
observations cluster less and have shorter tails.

Values are group midpoints. If the values in your data are midpoints of groups (for
example, ages of all people in their thirties are coded as 35), select this option to
estimate the median and percentiles for the original, ungrouped data.

Frequencies Charts

Figure 14-4
Frequencies Charts dialog box

Frequencies: Charts
-~ Chart Type Continue |
' Mone
Cancel |
" Bar charts
" Pie charts ﬂl
" Histograms
= it rammal sl

= Bz

& EreniiEnciEs O EErEertanes
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Chart Type. A pie chart displays the contribution of parts to a whole. Each slice of a pie
chart corresponds to a group that is defined by a single grouping variable. A bar chart
displays the count for each distinct value or category as a separate bar, allowing you
to compare categories visually. A histogram also has bars, but they are plotted along
an equal interval scale. The height of each bar is the count of values of a quantitative
variable falling within the interval. A histogram shows the shape, center, and spread
of the distribution. A normal curve superimposed on a histogram helps you judge
whether the data are normally distributed.

Chart Values. For bar charts, the scale axis can be labeled by frequency counts or
percentages.

Frequencies Format

Figure 14-5
Frequencies Format dialog box

Frequencies: Format

Order bp——————— ~Multiole Yariables———— Corti
. 'ols iahl ahtinug
' pzcending values LieliifptElis wielikldlse

" Organize output by variables Cancel |

" Descending values

" Azcending counts [ Suppress tables with more Help |

" Descending counts

thar |10 categaonies

Order by. The frequency table can be arranged according to the actual values in the
data or according to the count (frequency of occurrence) of those values, and the table
can be arranged in either ascending or descending order. However, if you request a
histogram or percentiles, Frequencies assumes that the variable is quantitative and
displays its values in ascending order.

Multiple Variables. If you produce statistics tables for multiple variables, you can either
display all variables in a single table (Compare variables) or display a separate statistics
table for each variable (Organize output by variables).

Suppress tables with more than n categories. This option prevents the display of tables
with more than the specified number of values.
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The Descriptives procedure displays univariate summary statistics for several variables
in a single table and calculates standardized values (z scores). Variables can be ordered
by the size of their means (in ascending or descending order), alphabetically, or by
the order in which you select the variables (the default).

When z scores are saved, they are added to the data in the Data Editor and are
available for charts, data listings, and analyses. When variables are recorded in
different units (for example, gross domestic product per capita and percentage
literate), a z-score transformation places variables on a common scale for easier
visual comparison.

Example. If each case in your data contains the daily sales totals for each member of
the sales staff (for example, one entry for Bob, one entry for Kim, and one entry for
Brian) collected each day for several months, the Descriptives procedure can compute
the average daily sales for each staff member and can order the results from highest
average sales to lowest average sales.

Statistics. Sample size, mean, minimum, maximum, standard deviation, variance,
range, sum, standard error of the mean, and kurtosis and skewness with their standard
€rTors.

Data. Use numeric variables after you have screened them graphically for recording
errors, outliers, and distributional anomalies. The Descriptives procedure is very
efficient for large files (thousands of cases).

Assumptions. Most of the available statistics (including z scores) are based on
normal theory and are appropriate for quantitative variables (interval- or ratio-level
measurements) with symmetric distributions. Avoid variables with unordered
categories or skewed distributions. The distribution of z scores has the same shape as
that of the original data; therefore, calculating z scores is not a remedy for problem data.
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To Obtain Descriptive Statistics

» From the menus choose:

Analyze
Descriptive Statistics
Descriptives...

Figure 15-1
Descriptives dialog box

+ Descriptives

» Select one or more variables.
Optionally, you can:
B Select Save standardized values as variables to save z scores as new variables.

m  Click Options for optional statistics and display order.
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Descriptives Options

Figure 15-2
Descriptives Options dialog box

Descriptives: Options

Mean and Sum. The mean, or arithmetic average, is displayed by default.

Dispersion. Statistics that measure the spread or variation in the data include the
standard deviation, variance, range, minimum, maximum, and standard error of the
mean.

m  Std. deviation. A measure of dispersion around the mean. In a normal distribution,
68% of cases fall within one standard deviation of the mean and 95% of cases
fall within two standard deviations. For example, if the mean age is 45, with
a standard deviation of 10, 95% of the cases would be between 25 and 65 in
a normal distribution.

m Variance. A measure of dispersion around the mean, equal to the sum of squared
deviations from the mean divided by one less than the number of cases. The
variance is measured in units that are the square of those of the variable itself.

® Range. The difference between the largest and smallest values of a numeric
variable, the maximum minus the minimum.

B Minimum. The smallest value of a numeric variable.
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®  Maximum. The largest value of a numeric variable.

m  S.E. mean. A measure of how much the value of the mean may vary from sample to

sample taken from the same distribution. It can be used to roughly compare the
observed mean to a hypothesized value (that is, you can conclude the two values
are different if the ratio of the difference to the standard error is less than -2 or
greater than +2).

Distribution. Kurtosis and skewness are statistics that characterize the shape and
symmetry of the distribution. These statistics are displayed with their standard errors.

Kurtosis. A measure of the extent to which observations cluster around a central
point. For a normal distribution, the value of the kurtosis statistic is zero.
Positive kurtosis indicates that the observations cluster more and have longer
tails than those in the normal distribution, and negative kurtosis indicates that the
observations cluster less and have shorter tails.

Skewness. A measure of the asymmetry of a distribution. The normal distribution
is symmetric and has a skewness value of 0. A distribution with a significant
positive skewness has a long right tail. A distribution with a significant negative
skewness has a long left tail. As a guideline, a skewness value more than twice its
standard error is taken to indicate a departure from symmetry.

Display Order. By default, the variables are displayed in the order in which you selected

them. Optionally, you can display variables alphabetically, by ascending means, or by
descending means.

DESCRIPTIVES Command Additional Features

The SPSS command language also allows you to:

Save standardized scores (z scores) for some but not all variables (with the
VARIABLES subcommand).

Specify names for new variables that contain standardized scores (with the
VARIABLES subcommand).

Exclude from the analysis cases with missing values for any variable (with the
MISSING subcommand).

Sort the variables in the display by the value of any statistic, not just the mean
(with the SORT subcommand).

See the SPSS Command Syntax Reference for complete syntax information.
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The Explore procedure produces summary statistics and graphical displays, either for
all of your cases or separately for groups of cases. There are many reasons for using
the Explore procedure—data screening, outlier identification, description, assumption
checking, and characterizing differences among subpopulations (groups of cases).
Data screening may show that you have unusual values, extreme values, gaps in the
data, or other peculiarities. Exploring the data can help to determine whether the
statistical techniques that you are considering for data analysis are appropriate. The
exploration may indicate that you need to transform the data if the technique requires a
normal distribution. Or, you may decide that you need nonparametric tests.

Example. Look at the distribution of maze-learning times for rats under four different
reinforcement schedules. For each of the four groups, you can see if the distribution
of times is approximately normal and whether the four variances are equal. You can
also identify the cases with the five largest and five smallest times. The boxplots
and stem-and-leaf plots graphically summarize the distribution of learning times for
each of the groups.

Statistics and plots. Mean, median, 5% trimmed mean, standard error, variance,
standard deviation, minimum, maximum, range, interquartile range, skewness and
kurtosis and their standard errors, confidence interval for the mean (and specified
confidence level), percentiles, Huber’s M-estimator, Andrews’ wave estimator,
Hampel’s redescending M-estimator, Tukey’s biweight estimator, the five largest and
five smallest values, the Kolmogorov-Smirnov statistic with a Lilliefors significance
level for testing normality, and the Shapiro-Wilk statistic. Boxplots, stem-and-leaf
plots, histograms, normality plots, and spread-versus-level plots with Levene tests
and transformations.

Data. The Explore procedure can be used for quantitative variables (interval- or
ratio-level measurements). A factor variable (used to break the data into groups of
cases) should have a reasonable number of distinct values (categories). These values
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may be short string or numeric. The case label variable, used to label outliers in
boxplots, can be short string, long string (first 15 characters), or numeric.

Assumptions. The distribution of your data does not have to be symmetric or normal.

Figure 16-1
Explore output

Descriptives

Time
Schedule
1 2 3 4
Mean Statistic 2760 4.850 £.900 9.010
Std. Error BS A2 A5 289
95.0% Confidence Interval | Lower Bound | Statistic 2,387 3.895 5.893 8.357
for Mean Upper Bound | Statistic 3133 £.805 7.907 9.663
5% Trimmed Mean Statistic 2761 4889 B.911 8.994
Median Statistic 2.850 4.900 7.050 5.000
“ariance Statistic 272 1.783 1.93% B34
Std. Deviation Statistic A2 1.335 1.408 913
Minimurn Statistic 20 23 45 7.8
Maxirmum Statistic 35 G7 9.1 10.5
Range Statistic 1.5 4.4 4.6 2.7
Interguartile Range Statistic 925 2.250 2.400 1.650
Skewness Statistic - 116 -559 - 197 218
Std. Error BE7 Ba7 BE7 BE7
Kurtosis Statistic -1.210 =104 -.606 -1.350
Std. Error 1.334 1.334 1.334 1.334
Extreme Values
Case

Number {Schedule | Value

Time | Highest | 1 31 |4 10.5

2 33 |4 9.9

3 39 |4 9.8

4 32 |4 9.5

5 36 |4 9.3

Lowest |1 21 2.0

2 71 21

3 111 2.3

4 1" |2 23

5 3|1 2.5
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Time Stem-and-Leaf Plot

Frequency Stem & Leaf

7.00 2. 0133589
6.00 3. 014577
3.00 4. 568
5.00 5. 05779
4.00 6. 1379
3.00 7. 268
6.00 8. 012237
5.00 9. 13589
1.00 10. 5

Stem width: 1.0
Each leaf: 1 case(s)

To Explore Your Data

» From the menus choose:

Analyze
Descriptive Statistics
Explore...

Figure 16-2
Explore dialog box

+ Explore

» Select one or more dependent variables.
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Optionally, you can:

B  Sclect one or more factor variables, whose values will define groups of cases.
m  Seclect an identification variable to label cases.

m  Click Statistics for robust estimators, outliers, percentiles, and frequency tables.
|

Click Plots for histograms, normal probability plots and tests, and
spread-versus-level plots with Levene’s statistics.

m  Click Options for the treatment of missing values.

Explore Statistics

Figure 16-3
Explore Statistics dialog box

Explore: Statistics | ¢ |

Confidence Interval for Mean: |95 %
[ M-estimators
[~ Qutliers

[ Percentiles

Continue I Cancel Help

Descriptives. These measures of central tendency and dispersion are displayed by
default. Measures of central tendency indicate the location of the distribution; they
include the mean, median, and 5% trimmed mean. Measures of dispersion show the
dissimilarity of the values; these include standard error, variance, standard deviation,
minimum, maximum, range, and interquartile range. The descriptive statistics also
include measures of the shape of the distribution; skewness and kurtosis are displayed
with their standard errors. The 95% level confidence interval for the mean is also
displayed; you can specify a different confidence level.

M-estimators. Robust alternatives to the sample mean and median for estimating the
location. The estimators calculated differ in the weights they apply to cases. Huber’s
M-estimator, Andrews’ wave estimator, Hampel’s redescending M-estimator, and
Tukey’s biweight estimator are displayed.

Outliers. Displays the five largest and five smallest values, with case labels.
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Percentiles. Displays the values for the 5th, 10th, 25th, 50th, 75th, 90th, and 95th
percentiles.

Explore Plots

Figure 16-4
Explore Plots dialog box

Explore: Plots [ |

~Boxplots Descriptive

Continue

& Factor levels together | ¥ Stem-and-leaf

c |
" Dependents together [" Histogram ance

" None Help

dil]

[ Normality plots with tests
—Spread vs. Level with Levene Test
= None

" Power estimation

" Transformed Puwer:INaturallug vl

" Untransformed

Boxplots. These alternatives control the display of boxplots when you have more
than one dependent variable. Factor levels together generates a separate display for
each dependent variable. Within a display, boxplots are shown for each of the groups
defined by a factor variable. Dependents together generates a separate display for each
group defined by a factor variable. Within a display, boxplots are shown side by side
for each dependent variable. This display is particularly useful when the different
variables represent a single characteristic measured at different times.

Descriptive. The Descriptive group allows you to choose stem-and-leaf plots and
histograms.

Normality plots with tests. Displays normal probability and detrended normal
probability plots. The Kolmogorov-Smirnov statistic, with a Lilliefors significance
level for testing normality, is displayed. If non-integer weights are specified, the
Shapiro-Wilk statistic is calculated when the weighted sample size lies between 3 and
50. For no weights or integer weights, the statistic is calculated when the weighted
sample size lies between 3 and 5000.
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Spread vs. Level with Levene Test. Controls data transformation for spread-versus-level
plots. For all spread-versus-level plots, the slope of the regression line and Levene’s
robust tests for homogeneity of variance are displayed. If you select a transformation,
Levene’s tests are based on the transformed data. If no factor variable is selected,
spread-versus-level plots are not produced. Power estimation produces a plot of

the natural logs of the interquartile ranges against the natural logs of the medians

for all cells, as well as an estimate of the power transformation for achieving

equal variances in the cells. A spread-versus-level plot helps to determine the

power for a transformation to stabilize (make more equal) variances across groups.
Transformed allows you to select one of the power alternatives, perhaps following the
recommendation from power estimation, and produces plots of transformed data. The
interquartile range and median of the transformed data are plotted. Untransformed
produces plots of the raw data. This is equivalent to a transformation with a power of 1.

Explore Power Transformations

These are the power transformations for spread-versus-level plots. To transform data,
you must select a power for the transformation. You can choose one of the following
alternatives:

Natural log. Natural log transformation. This is the default.

1/square root. For each data value, the reciprocal of the square root is calculated.
Reciprocal. The reciprocal of each data value is calculated.

Square root. The square root of each data value is calculated.

Square. Each data value is squared.

Cube. Each data value is cubed.
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Explore Options

Figure 16-5
Explore Options dialog box

Explore: Options

' Exclude cases listwise

" Exclude cases pairwise

Missing Values Continue

Cancel

il

" Beport values Help

Missing Values. Controls the treatment of missing values.

m  Exclude cases listwise. Cases with missing values for any dependent or factor

variable are excluded from all analyses. This is the default.

Exclude cases pairwise. Cases with no missing values for variables in a group
(cell) are included in the analysis of that group. The case may have missing values
for variables used in other groups.

Report values. Missing values for factor variables are treated as a separate category.
All output is produced for this additional category. Frequency tables include
categories for missing values. Missing values for a factor variable are included
but labeled as missing.

EXAMINE Command Additional Features

The Explore procedure uses EXAMINE command syntax. The SPSS command language
also allows you to:

Request total output and plots in addition to output and plots for groups defined by
the factor variables (with the TOTAL subcommand).

Specify a common scale for a group of boxplots (with the SCALE subcommand).
Specify interactions of the factor variables (with the VARIABLES subcommand).
Specify percentiles other than the defaults (with the PERCENTILES subcommand).

Calculate percentiles according to any of five methods (with the PERCENTILES
subcommand).

Specify any power transformation for spread-versus-level plots (with the PLOT
subcommand).
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m  Specify the number of extreme values to be displayed (with the STATISTICS
subcommand).

m  Specify parameters for the M-estimators, robust estimators of location (with the
MESTIMATORS subcommand).

See the SPSS Command Syntax Reference for complete syntax information.
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Crosstabs

The Crosstabs procedure forms two-way and multiway tables and provides a variety of
tests and measures of association for two-way tables. The structure of the table and
whether categories are ordered determine what test or measure to use.

Crosstabs’ statistics and measures of association are computed for two-way tables
only. If you specify a row, a column, and a layer factor (control variable), the Crosstabs
procedure forms one panel of associated statistics and measures for each value of
the layer factor (or a combination of values for two or more control variables). For
example, if gender is a layer factor for a table of married (yes, no) against /ife (is life
exciting, routine, or dull), the results for a two-way table for the females are computed
separately from those for the males and printed as panels following one another.

Example. Are customers from small companies more likely to be profitable in sales
of services (for example, training and consulting) than those from larger companies?
From a crosstabulation, you might learn that the majority of small companies (fewer
than 500 employees) yield high service profits, while the majority of large companies
(more than 2,500 employees) yield low service profits.

Statistics and measures of association. Pearson chi-square, likelihood-ratio chi-square,
linear-by-linear association test, Fisher’s exact test, Yates’ corrected chi-square,
Pearson’s r, Spearman’s rho, contingency coefficient, phi, Cramér’s V, symmetric and
asymmetric lambdas, Goodman and Kruskal’s tau, uncertainty coefficient, gamma,
Somers’ d, Kendall’s tau-b, Kendall’s tau-c, eta coefficient, Cohen’s kappa, relative
risk estimate, odds ratio, McNemar test, and Cochran’s and Mantel-Haenszel statistics.

Data. To define the categories of each table variable, use values of a numeric or short
string (eight or fewer characters) variable. For example, for gender, you could code
the data as 1 and 2 or as male and female.

Assumptions. Some statistics and measures assume ordered categories (ordinal data)
or quantitative values (interval or ratio data), as discussed in the section on statistics.
Others are valid when the table variables have unordered categories (nominal data).
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For the chi-square-based statistics (phi, Cramér’s V, and contingency coefficient), the
data should be a random sample from a multinomial distribution.

Note: Ordinal variables can be either numeric codes that represent categories (for
example, 1 = low, 2 = medium, 3 = high) or string values. However, the alphabetic
order of string values is assumed to reflect the true order of the categories. For
example, for a string variable with the values of low, medium, high, the order of the
categories is interpreted as high, low, medium—which is not the correct order. In
general, it is more reliable to use numeric codes to represent ordinal data.

Figure 17-1
Crosstabs output

Service Profitability * Company Size Crosstabulation

Service Company Size
Profitability 1-500 501-2,500 | >2,500 Total
Low 200 85 135 420
High 251 106 105 462
Total 451 191 240 882
Chi-Square Tests
Asymp.
Sig.
Value df (2-sided)
Pearson
Chi-Square 9.848 2 .007
Likelihood Ratio 9.852 2 .007
Linear-by-Linear
Association 7.869 1 005
N of Valid
Cases 882

To Obtain Crosstabulations

» From the menus choose:

Analyze
Descriptive Statistics
Crosstabs...
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Figure 17-2
Crosstabs dialog box

: Crosstabs

E. check

B. co_size
B cust_exp
E,, cust_num
E,, cust_vre
E. emp_daore
B. emp_exp

Row(z]:
B. cosizel

Column(z]:
B. servprof

K
Baste
Beset
Cancel

Help

E. emp_id
E. industy
E.. orderrum

Eresinie

Layper 1 of 1

[Hest

B p1
B. p10
B. p2 d|

H\_I Ll

[~ Display clustersd bar charts

[~ Suppress tables

Exact...

Statiztics..

Cells...

| Format. ..

e

» Select one or more row variables and one or more column variables.

Optionally, you can:
|

n
subtables.

Select one or more control variables.

Click Statistics for tests and measures of association for two-way tables or

Click Cells for observed and expected values, percentages, and residuals.

Click Format for controlling the order of categories.

Crosstabs Layers

If you select one or more layer variables, a separate crosstabulation is produced for each
category of each layer variable (control variable). For example, if you have one row
variable, one column variable, and one layer variable with two categories, you get a
two-way table for each category of the layer variable. To make another layer of control
variables, click Next. Subtables are produced for each combination of categories for
each first-layer variable with each second-layer variable and so on. If statistics and
measures of association are requested, they apply to two-way subtables only.
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Crosstabs Clustered Bar Charts

Display clustered bar charts. A clustered bar chart helps summarize your data for
groups of cases. There is one cluster of bars for each value of the variable you specified
under Rows. The variable that defines the bars within each cluster is the variable you
specified under Columns. There is one set of differently colored or patterned bars for
each value of this variable. If you specify more than one variable under Columns or
Rows, a clustered bar chart is produced for each combination of two variables.

Crosstabs Statistics

Figure 17-3
Crosstabs Statistics dialog box

Crosstabs: Statistics E2
™ Conelations
—Mominal———— Ordinal———— Cancel |

[~ Contingency coefficient [T Gamma
Hel

r Phi and Crameér's W r Somers' d =B
[~ Lambda [ Kendall's tau-b
[~ Uncertainty cosfficient [ Kendall's tauc
r— Mominal by Interval [~ Kappa
[ Eta [ Risk

I tcMemar

[~ Cochran's and Mantel-Haenszel statistics

Test common odds ratio equals: I'I

Chi-square. For tables with two rows and two columns, select Chi-square to calculate
the Pearson chi-square, the likelihood-ratio chi-square, Fisher’s exact test, and Yates’
corrected chi-square (continuity correction). For 2 x 2 tables, Fisher’s exact test

is computed when a table that does not result from missing rows or columns in a
larger table has a cell with an expected frequency of less than 5. Yates’ corrected
chi-square is computed for all other 2 x 2 tables. For tables with any number of
rows and columns, select Chi-square to calculate the Pearson chi-square and the
likelihood-ratio chi-square. When both table variables are quantitative, Chi-square
yields the linear-by-linear association test.
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Correlations. For tables in which both rows and columns contain ordered values,
Correlations yields Spearman’s correlation coefficient, rho (numeric data only).
Spearman’s rtho is a measure of association between rank orders. When both table
variables (factors) are quantitative, Correlations yields the Pearson correlation
coefficient, r, a measure of linear association between the variables.

Nominal. For nominal data (no intrinsic order, such as Catholic, Protestant, and
Jewish), you can select Phi (coefficient) and Cramér’s V, Contingency coefficient,
Lambda (symmetric and asymmetric lambdas and Goodman and Kruskal’s tau), and
Uncertainty coefficient.

m Contingency coefficient. A measure of association based on chi-square. The value
ranges between 0 and 1, with 0 indicating no association between the row and
column variables and values close to 1 indicating a high degree of association
between the variables. The maximum value possible depends on the number of
rows and columns in a table.

®  Phi and Cramer's V. Phi is a chi-square-based measure of association that involves
dividing the chi-square statistic by the sample size and taking the square root of
the result. Cramer’s V is a measure of association based on chi-square.

m lambda. A measure of association that reflects the proportional reduction in
error when values of the independent variable are used to predict values of the
dependent variable. A value of 1 means that the independent variable perfectly
predicts the dependent variable. A value of 0 means that the independent variable
is no help in predicting the dependent variable.

m  Uncertainty coefficient. A measure of association that indicates the proportional
reduction in error when values of one variable are used to predict values of the
other variable. For example, a value of 0.83 indicates that knowledge of one
variable reduces error in predicting values of the other variable by 83%. The
program calculates both symmetric and asymmetric versions of the uncertainty
coefficient.

Ordinal. For tables in which both rows and columns contain ordered values, select
Gamma (zero-order for 2-way tables and conditional for 3-way to 10-way tables),
Kendall’s tau-b, and Kendall’s tau-c. For predicting column categories from row
categories, select Somers’ d.

®  Gamma. A symmetric measure of association between two ordinal variables that
ranges between -1 and 1. Values close to an absolute value of 1 indicate a strong
relationship between the two variables. Values close to 0 indicate little or no
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relationship. For 2-way tables, zero-order gammas are displayed. For 3-way to
n-way tables, conditional gammas are displayed.

m  Somers’ d. A measure of association between two ordinal variables that ranges
from -1 to 1. Values close to an absolute value of 1 indicate a strong relationship
between the two variables, and values close to 0 indicate little or no relationship
between the variables. Somers’ d is an asymmetric extension of gamma that differs
only in the inclusion of the number of pairs not tied on the independent variable. A
symmetric version of this statistic is also calculated.

m  Kendall's tau-b. A nonparametric measure of correlation for ordinal or ranked
variables that take ties into account. The sign of the coefficient indicates the
direction of the relationship, and its absolute value indicates the strength, with
larger absolute values indicating stronger relationships. Possible values range
from -1 to 1, but a value of -1 or +1 can be obtained only from square tables.

m  Kendall's tau-c. A nonparametric measure of association for ordinal variables that
ignores ties. The sign of the coefficient indicates the direction of the relationship,
and its absolute value indicates the strength, with larger absolute values indicating
stronger relationships. Possible values range from -1 to 1, but a value of -1 or +1
can be obtained only from square tables.

Nominal by Interval. When one variable is categorical and the other is quantitative,
select Eta. The categorical variable must be coded numerically.

m  Eta. A measure of association that ranges from 0 to 1, with 0 indicating no
association between the row and column variables and values close to 1 indicating
a high degree of association. Eta is appropriate for a dependent variable measured
on an interval scale (for example, income) and an independent variable with a
limited number of categories (for example, gender). Two eta values are computed:
one treats the row variable as the interval variable, and the other treats the column
variable as the interval variable.

Kappa. Cohen’s kappa measures the agreement between the evaluations of two raters
when both are rating the same object. A value of 1 indicates perfect agreement. A
value of 0 indicates that agreement is no better than chance. Kappa is available only
for tables in which both variables use the same category values and both variables have
the same number of categories.

Risk. For 2 x 2 tables, a measure of the strength of the association between the presence
of a factor and the occurrence of an event. If the confidence interval for the statistic
includes a value of 1, you cannot assume that the factor is associated with the event.
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The odds ratio can be used as an estimate or relative risk when the occurrence of
the factor is rare.

McNemar. A nonparametric test for two related dichotomous variables. Tests for
changes in responses using the chi-square distribution. Useful for detecting changes in
responses due to experimental intervention in "before-and-after" designs. For larger
square tables, the McNemar-Bowker test of symmetry is reported.

Cochran’s and Mantel-Haenszel statistics. Cochran’s and Mantel-Haenszel statistics
can be used to test for independence between a dichotomous factor variable and a
dichotomous response variable, conditional upon covariate patterns defined by one or
more layer (control) variables. Note that while other statistics are computed layer by
layer, the Cochran’s and Mantel-Haenszel statistics are computed once for all layers.

Crosstabs Cell Display

Figure 17-4
Crosstabs Cell Display dialog box
Crosstabs: Cell Display E3
e Cancel |
[” Expected
Help |
— Percentages Fiesiduals
[ Bow [ Unstandardized
™ Colurn [ Standardized
[ Total [T Adjusted standardized
— Moninteger Weight:
& Round cell counts " Round case weights
" Truncate cell counts © Truncate case weights
Mo adjustments

To help you uncover patterns in the data that contribute to a significant chi-square test,
the Crosstabs procedure displays expected frequencies and three types of residuals
(deviates) that measure the difference between observed and expected frequencies.
Each cell of the table can contain any combination of counts, percentages, and
residuals selected.
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Counts. The number of cases actually observed and the number of cases expected if the
row and column variables are independent of each other.

Percentages. The percentages can add up across the rows or down the columns. The
percentages of the total number of cases represented in the table (one layer) are also
available.

Residuals. Raw unstandardized residuals give the difference between the observed and
expected values. Standardized and adjusted standardized residuals are also available.

m  Unstandardized. The difference between an observed value and the expected value.
The expected value is the number of cases you would expect in the cell if there
were no relationship between the two variables. A positive residual indicates
that there are more cases in the cell than there would be if the row and column
variables were independent.

m Standardized. The residual divided by an estimate of its standard deviation.
Standardized residuals, which are also known as Pearson residuals, have a mean of
0 and a standard deviation of 1.

m  Adjusted standardized. The residual for a cell (observed minus expected value)
divided by an estimate of its standard error. The resulting standardized residual is
expressed in standard deviation units above or below the mean.

Noninteger Weights. Cell counts are normally integer values, since they represent the
number of cases in each cell. But if the data file is currently weighted by a weight
variable with fractional values (for example, 1.25), cell counts can also be fractional
values. You can truncate or round either before or after calculating the cell counts or
use fractional cell counts for both table display and statistical calculations.

®  Round cell counts. Case weights are used as is but the accumulated weights in the
cells are rounded before computing any statistics.

®  Truncate cell counts. Case weights are used as is but the accumulated weights in
the cells are truncated before computing any statistics.

®  Round case weights. Case weights are rounded before use.
® Truncate case weights. Case weights are truncated before use.

m  No adjustments. Case weights are used as is and fractional cell counts are used.
However, when Exact Statistics (available only with the Exact Tests option) are
requested, the accumulated weights in the cells are either truncated or rounded
before computing the Exact test statistics.
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Crosstabs Table Format

Figure 17-5
Crosstabs Table Format dialog box

Crosstabs: Table Format

You can arrange rows in ascending or descending order of the values of the row
variable.
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The Summarize procedure calculates subgroup statistics for variables within
categories of one or more grouping variables. All levels of the grouping variable
are crosstabulated. You can choose the order in which the statistics are displayed.
Summary statistics for each variable across all categories are also displayed. Data
values in each category can be listed or suppressed. With large datasets, you can
choose to list only the first # cases.

Example. What is the average product sales amount by region and customer industry?
You might discover that the average sales amount is slightly higher in the western
region than in other regions, with corporate customers in the western region yielding
the highest average sales amount.

Statistics. Sum, number of cases, mean, median, grouped median, standard error of
the mean, minimum, maximum, range, variable value of the first category of the
grouping variable, variable value of the last category of the grouping variable, standard
deviation, variance, kurtosis, standard error of kurtosis, skewness, standard error

of skewness, percentage of total sum, percentage of total N, percentage of sum in,
percentage of N in, geometric mean, and harmonic mean.

Data. Grouping variables are categorical variables whose values can be numeric or
short string. The number of categories should be reasonably small. The other variables
should be able to be ranked.

Assumptions. Some of the optional subgroup statistics, such as the mean and standard
deviation, are based on normal theory and are appropriate for quantitative variables
with symmetric distributions. Robust statistics, such as the median and the range,
are appropriate for quantitative variables that may or may not meet the assumption
of normality.
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Figure 18-1

Summarize output

Case Summaries
Average Product Sale by Region and Industry

Industry
Region Government | Corporate | Academic | Healthcare Total
East $3,594.65 | $3,953.76 | $3,764.91 | $3,722.32 | $3,735.45
Central $3,370.12 | $3,268.47 | $3,317.81 | $3,165.11 | $3,305.03
West $3,552.50 | $4,649.00 | $4,276.25 | $4,027.00 | $4,079.46
Total $3,503.75 | $3,727.50 | $3,579.76 | $3,456.93 | $3,576.52

To Obtain Case Summaries

» From the menus choose:

Analyze
Reports

Case Summaries...

Figure 18-2

Summarize Cases dialog box

* Summanze Cases

E. check
B. co_size
BE. cosized
E, cust_exp
E.. cust_num
B. cust_wrs
E. emp_dare
B. emp_exp
E. emp_id
E.. ordernum
B. p1
B. p10

2

B. sale_prd

2]

B.. region?

||_ B industy
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» Select one or more variables.

Optionally, you can:
m  Select one or more grouping variables to divide your data into subgroups.

m  Click Options to change the output title, add a caption below the output, or exclude
cases with missing values.

m  Click Statistics for optional statistics.

m  Seclect Display cases to list the cases in each subgroup. By default, the system lists
only the first 100 cases in your file. You can raise or lower the value for Limit cases
to first n or deselect that item to list all cases.

Summarize Options

Figure 18-3
Summarize Cases Options dialog box
Title: Cantinue |
Caze Summaries
Cancel |
LCaption: Help |

¥ Subheadings for bokals

[T Ezxclude cases with missing values listwise

Missing statiztics appear as: I

Summarize allows you to change the title of your output or add a caption that will
appear below the output table. You can control line wrapping in titles and captions by
typing \n wherever you want to insert a line break in the text.

You can also choose to display or suppress subheadings for totals and to include or
exclude cases with missing values for any of the variables used in any of the analyses.
Often it is desirable to denote missing cases in output with a period or an asterisk.
Enter a character, phrase, or code that you would like to have appear when a value is
missing; otherwise, no special treatment is applied to missing cases in the output.
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Summarize Statistics

Figure 18-4
Summarize Cases Statistics dialog box

Summary Report: Statistics E

Statistics: LCell Statistics:

Mean - MNurnber of Cases
Median I—
Grouped Median
Std. Emror of Mean
Sum

b inirmumm
bl airnum

Range

First

Last

Standard Deviation
Wariance

Kurtasis 1=
Std. Error of Kurtasis
Skewness hd

Continuel Cancel | Help |

You can choose one or more of the following subgroup statistics for the variables
within each category of each grouping variable: sum, number of cases, mean, median,
grouped median, standard error of the mean, minimum, maximum, range, variable
value of the first category of the grouping variable, variable value of the last category
of the grouping variable, standard deviation, variance, kurtosis, standard error of
kurtosis, skewness, standard error of skewness, percentage of total sum, percentage of
total N, percentage of sum in, percentage of N in, geometric mean, harmonic mean.
The order in which the statistics appear in the Cell Statistics list is the order in which
they will be displayed in the output. Summary statistics are also displayed for each
variable across all categories.

First. Displays the first data value encountered in the data file.

Geometric Mean. The nth root of the product of the data values, where n represents
the number of cases.

Grouped Median. Median that is calculated for data that is coded into groups. For
example, with age data, if each value in the 30s is coded 35, each value in the 40s is
coded 45, and so on, the grouped median is the median calculated from the coded data.

Harmonic Mean. Used to estimate an average group size when the sample sizes in the
groups are not equal. The harmonic mean is the total number of samples divided by
the sum of the reciprocals of the sample sizes.
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Kurtosis. A measure of the extent to which observations cluster around a central point.
For a normal distribution, the value of the kurtosis statistic is zero. Positive kurtosis
indicates that the observations cluster more and have longer tails than those in the
normal distribution, and negative kurtosis indicates that the observations cluster less
and have shorter tails.

Last. Displays the last data value encountered in the data file.
Maximum. The largest value of a numeric variable.

Mean. A measure of central tendency. The arithmetic average, the sum divided by
the number of cases.

Median. The value above and below which half of the cases fall, the 50th percentile. If
there is an even number of cases, the median is the average of the two middle cases
when they are sorted in ascending or descending order. The median is a measure

of central tendency not sensitive to outlying values (unlike the mean, which can be
affected by a few extremely high or low values).

Minimum. The smallest value of a numeric variable.

N. The number of cases (observations or records).

Percent of Total N. Percentage of the total number of cases in each category.
Percent of Total Sum. Percentage of the total sum in each category.

Range. The difference between the largest and smallest values of a numeric variable,
the maximum minus the minimum.

Skewness. A measure of the asymmetry of a distribution. The normal distribution is
symmetric and has a skewness value of 0. A distribution with a significant positive
skewness has a long right tail. A distribution with a significant negative skewness has
a long left tail. As a guideline, a skewness value more than twice its standard error is
taken to indicate a departure from symmetry.

Standard Error of Kurtosis. The ratio of kurtosis to its standard error can be used as a
test of normality (that is, you can reject normality if the ratio is less than -2 or greater
than +2). A large positive value for kurtosis indicates that the tails of the distribution
are longer than those of a normal distribution; a negative value for kurtosis indicates
shorter tails (becoming like those of a box-shaped uniform distribution).
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Standard Error of Skewness. The ratio of skewness to its standard error can be used as a
test of normality (that is, you can reject normality if the ratio is less than -2 or greater
than +2). A large positive value for skewness indicates a long right tail; an extreme
negative value indicates a long left tail.

Sum. The sum or total of the values, across all cases with nonmissing values.

Variance. A measure of dispersion around the mean, equal to the sum of squared
deviations from the mean divided by one less than the number of cases. The variance
is measured in units that are the square of those of the variable itself.
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The Means procedure calculates subgroup means and related univariate statistics
for dependent variables within categories of one or more independent variables.
Optionally, you can obtain a one-way analysis of variance, eta, and tests for linearity.

Example. Measure the average amount of fat absorbed by three different types of
cooking oil, and perform a one-way analysis of variance to see whether the means
differ.

Statistics. Sum, number of cases, mean, median, grouped median, standard error of
the mean, minimum, maximum, range, variable value of the first category of th